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Preface

The new ArcGIS is a web GIS

By any measure, it is an exciting time to be working and engaged in the GIS field. Web GIS is emerging, and it is extending the reach of GIS.

ArcGIS has grown to become a web GIS platform that you can use to deliver authoritative maps, analytics, and geographic information to a wider audience, using lightweight clients and custom applications on the web and smart devices.

[image: image]

Virtually anyone can use web GIS to find, use, create, and share maps, perform GIS analysis, collaborate with others in groups and communities, and deploy easy-to-configure map-based applications for many extra users.

[image: image]

A living atlas of beautiful basemaps, imagery, and enabling geographic information is built into this platform. It is available for anyone to use, along with thousands of datasets and map services that have been shared and registered in ArcGIS by users like you from around the world.

The new ArcGIS provides an online infrastructure for making maps and geographic information available throughout an organization, across a community, and openly on the web. This new vision for web GIS fully complements, integrates, and extends the existing professional GIS workflows with which you are already familiar.

[image: image]

This book will begin your journey to begin to learn about, understand, and apply web GIS.

What this book covers

Getting to Know Web GIS is a workbook, with detailed, step-by-step exercises, that teaches readers how to share resources online and build web GIS applications easily and quickly. It is a practical manual for classroom lab work and on-the-job training for GIS students, instructors, GIS analysts, managers, web developers, and a broad range of GIS professionals. It covers the Esri suite of web GIS technologies, including ArcGIS Online, Portal for ArcGIS, ArcGIS for Server, web app templates, Web AppBuilder for ArcGIS, ArcGIS API for JavaScript, the Collector for ArcGIS mobile app, ArcGIS Runtime SDKs for Mobile, Esri CityEngine, and 3D web scenes.

The sample data for this book and a 60-day trial of ArcGIS for Desktop software are available on the Esri Press book resource page at esripress.esri.com/bookresources.

Web GIS is a promising field with great applicability to e-government, e-business, e-science, and daily life. The societal need for both the web and GIS has generated a strong and increasing demand for good web GIS professionals. Professors need a lab book to teach this course, and on-the-job professionals need a guide to teach themselves. This book fits the need. In writing this book, I have tried to keep these provisions in mind and make it

• easy to apply. Web GIS is quite a technical field, but you do not have to be a developer to build web apps. This book facilitates immediate productivity. It teaches you how to build engaging web apps without a single line of programming. Even the two chapters involving programming are designed to be easy to follow and do not require a strong programming background.

• current. Web GIS technologies advance rapidly. The book teaches state-of-the-art technical skills for building applications and managing projects.

• holistic. Unlike books that focus on individual products, this book teaches web GIS technologies as a holistic platform, from the server side to the browser, mobile, and desktop client side. This book also addresses the pros and cons of the available development options and helps you make the best choices based on your requirements and resources.

Each of the 10 chapters provides

• a conceptual discussion that gives readers the big picture and the underlying principles,

• system requirements that help instructors set up the lab,

• a detailed tutorial with abundant screen captures that confirm progress along the way,

• common questions and answers,

• an assignment that allows readers to practice what they have learned, and

• a resource section.

The book is the result of my extensive working experience at Esri and teaching experience at Harvard University Extension, Henan University, and the University of Redlands. This course and the set of labs have been well recognized by these universities and students. Professors can use this book as the lab book for their web GIS courses, and professionals at work can use this book for on-the-job training.

I welcome your feedback at esripress@esri.com and hope this book sparks your imagination and encourages creative uses of web GIS.
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System requirements

The sample data for this entire book and a 60-day trial of ArcGIS for Desktop software is available on the Esri Press book resource page at esripress.esri.com/bookresources. Answers to the tutorial exercises are available in the GTKWebGIS\Answers data folder for pertinent chapters.

This list of system requirements is to help instructors set up the labs for teaching this book.

[image: images]    Note: If you are not teaching the whole book, you do not need the whole list. Refer to the system requirements for the chapters you would like to teach.

• ArcGIS Online service or Portal for ArcGIS software

• ArcGIS for Server software

• Desktop computers for students

• ArcGIS for Desktop software: Many universities have campuswide ArcGIS site licenses, which already include free ArcGIS for Desktop for students. If not, there is the 60-day trial available with this book or ArcGIS for Home Use.

• Web browser: Google Chrome, Firefox, Microsoft Internet Explorer, or Safari.

• Suggested configuration: check for newer versions of stored pages each time you visit the webpage.

• Microsoft Excel or other tools that can edit CSV files: for chapters 1, 2, 5, and 9.

• Microsoft IIS (Internet Information Services) or other web application servers: for chapters 6 and 8.

• Notepad++ or other tools that can edit JavaScript: for chapter 8.

• ADT (Android Development Toolkit): for chapter 9.

• Esri CityEngine (30-day trial available): for chapter 10.

• Smart mobile devices

• iPhone, iPad, or Android phone or tablet: for chapter 9.

• Collector for ArcGIS software (on iOS or Android): for chapter 9.




Chapter 1

Start with the cloud: Build web apps using ArcGIS Online

This chapter introduces the ArcGIS Online service, a main component of today’s web GIS technologies. It begins with a short overview of web GIS and the various ways to build web GIS applications and then demonstrates a quick and easy way to build web GIS apps using the Story Map Tour template. As this chapter familiarizes you with ArcGIS Online basic operations and workflows, it prepares you for the more flexible ways to use ArcGIS Online that you will learn in other chapters.

Learning objectives

• Grasp the basics of web GIS.

• Understand the different approaches of building web GIS apps.

• Learn the ArcGIS Online workflow for creating web apps.

• Work with GIS data in comma-separated values (CSV).

• Create and share web maps.

• Create and configure web apps.

• Use the Story Map Tour template.

What is web GIS?

Web GIS uses web technologies, including, but not limited to, HTTP (Hypertext Transfer Protocol), HTML (Hyper Text Markup Language), URL (uniform resource locator), JavaScript, WebSocket, and more. Since its conception in 1993, web GIS has demonstrated immense value to government, business, science, and daily life.

[image: images]

The basic architecture of web GIS.

Web GIS architecture can be complex because it can connect multiple systems. At its most basic, it has a three-tiered architecture (as illustrated in the figure):

• Web GIS clients, which are the face of the presentation tier, typically appear in the form of online maps or the results of advanced analyses, as seen in web browsers, smartphones, tablets, and desktop apps. In this book, you will learn how to build various web browser (particularly JavaScript based) and mobile clients.

• Web GIS servers, the most important components of web GIS, occupy the middle tier. Here, the content, functionality, and capability of web GIS apps is determined. Without the middle tier’s support, the presentation tier would lose its foundation. In this book, you will learn how to use ArcGIS for Server software, ArcGIS Online, and Portal for ArcGIS software.

• GIS database servers, representing the data tier, hold the data needed to support web GIS servers and their web clients. In this book, you will use CSVs, shapefiles, file geodatabases, and the enterprise geodatabase hosted in ArcGIS Online.

Why web GIS?

The Internet and the World Wide Web remove the constraint of distance in cyberspace. This allows people the freedom to access information globally and almost instantly. Building on these advantages, web GIS offers many advantages over traditional desktop applications, including:

• Global reach: you can share your geographic information easily within your organization and with people all over the world if you wish.

• Large number of users: you can share your app with dozens, or even millions, of users.

• Low cost per user: the cost of building one web GIS app is often cheaper than building a stand-alone desktop solution and installing it for every user.

• Better cross-platform capabilities: web apps, especially those built with JavaScript, can run on desktop and mobile platforms running a wide range of operating systems, from Windows, Mac OS, and Linux to iOS, Android, and Windows Phone.

• Easy to use: Web GIS apps typically incorporate simplicity, intuition, and convenience into their design. Therefore, public users can use these apps without having prior knowledge.

• Easy to maintain: Web clients can benefit from the latest program and data updates each time they access a web app. The web administrator does not have to update all the clients separately.

• Diverse applications: Web GIS has made building apps easier, so its applications have grown diverse. Unlocking the power of geospatial intelligence, it now reaches millions of homes, offices, and laboratories and billions of individuals.

• For government, web GIS offers an ideal channel for delivering public information services, an engaging medium for encouraging public participation, and a powerful framework for supporting decision making.

• For business, web GIS helps create novel business models and reshape existing ones. It enhances the power of location-based advertising, business analysis, and volunteered geographic information, generating tremendous revenue, both directly and indirectly.

• For science, web GIS creates new research areas and renews existing avenues of research.

• In daily life, web GIS helps people decide where to eat, stay, and shop and how to get from here to there.

Paths to building web GIS applications

This book teaches readers how to build web GIS apps. The ArcGIS suite of web GIS products offers many paths to this goal.

[image: images]

ArcGIS offers many ways to build web applications. The thick red line in the figure highlights the technology chapter 1 teaches.

• The data tier (on the left side of the figure) contains formats that range from simple CSVs managed with Microsoft Excel to sophisticated geodatabases managed with enterprise databases. This allows you to create a map, toolbox, and 3D resources in ArcGIS for Desktop software, including ArcGIS Pro.

• In the middle tier (in the middle of the figure), you can publish desktop resources to ArcGIS Online or ArcGIS for Server as various types of web services that you can add to ArcGIS Online to create web maps. Organizations that do not want to place their resources in the public cloud can use Portal for ArcGIS, a form of ArcGIS Online used in a private cloud.

• Options for the presentation, or the client, tier (on the right side of the figure) range from ready-to-use apps that are configured without programming to custom apps that use various web APIs (application programming interfaces) or SDKs (software development kits) to meet special requirements.

Start with ArcGIS Online, a cloud GIS

Today, cloud computing is rapidly emerging as an important research area and technology trend. It is based on the idea that many of the computing tasks that individual computers handle locally could operate more efficiently using multiple computer centers connected through the Internet. Cloud GIS uses this new cloud computing technology to enhance GIS capabilities that help users lower costs, reduce complexity, and quicken scalability.

ArcGIS Online offers users a collaborative, cloud-based platform for creating, managing, sharing, and accessing maps, applications, and data. It provides the following:

• Infrastructure as a Service (IaaS): you can upload your data and publish web services to ArcGIS Online, and host them on the ArcGIS Online infrastructure, which sits on top of Amazon EC2 (Elastic Compute Cloud).

• Platform as a Service (PaaS): you can build web GIS apps without programming by using ArcGIS Online templates or with programming by using ArcGIS Web APIs and ArcGIS Runtime SDKs for Mobile.

• Software as a Service (SaaS): you can use the rich basemap and thematic map services, analytical services, and applications hosted in ArcGIS Online and published by Esri and its user communities.

Types of ArcGIS Online user accounts

You must have an account with ArcGIS Online to save your work and create web apps. There are two main types of user accounts:

• Public accounts: The ArcGIS Online Public Account service is not associated with any organization and offers limited functionality. To create an account, navigate to arcgis.com. A public user can add simple data, create web maps and web apps, and access public data, services, maps, and apps shared by others. However, public account users cannot publish hosted services nor access many ArcGIS analytical functions.

• Organizational accounts: To become a member of an ArcGIS Online organization, you or your organization’s administrator must create an ArcGIS Online for Organizations account. An organizational user can assume one of the following roles:

• User: In addition to the functions available to public users, organizational users can access the data, services, maps, and apps shared within his or her organization.

• Publisher: In addition to user-level functions, publishers can publish hosted geospatial web services to ArcGIS Online and perform spatial analyses.

• Administrator: In addition to publishing functions, administrators can configure their organization’s ArcGIS Online website (such as its featured content gallery) and manage its users and groups.

• Custom role: The ArcGIS Online administrator can define a custom role with specialized permissions (e.g., view-only).

Main types of content in ArcGIS Online

Five main types of content in ArcGIS Online relate closely to this book’s main goal—learning how to build web GIS apps.

[image: images]

The main types of content in ArcGIS Online and Portal for ArcGIS.

Typically, a web app comprises one or more web maps, which in turn include or reference one or more layers. A layer can take the form of a CSV, a shapefile, or a web service.

• Data: ArcGIS Online supports data in a variety of formats, including CSV, TXT, CSV, GPX (GPS Exchange Format), and geodatabase.

• Layers: ArcGIS Online can host layers including the aforementioned data and can reference layers, including GeoRSS, map services, feature services, image services, KML (Keyhole Markup Language), and WMS (Web Map Service standard defined by OGC—Open Geospatial Consortium).

• Web maps: These maps interactively display geographic information that you can use to answer questions. A web map comprises or references multiple layers.

• Tools: these application tools perform analytical functions, such as geocoding, routing, generating PDFs, summarizing data, finding hot spots, and analyzing proximity.

• Web apps: A website generally created for a targeted audience and purpose. Developers can program with ArcGIS Web APIs to build web apps. However, you do not have to be a developer to create a web app. ArcGIS Online provides many templates that you can use to create impressive web apps without any programming. In ArcGIS Online, a web app sometimes comprises a single web map and sometimes multiple web maps (such as web apps developed from the side-by-side and swipe templates).

Steps to creating web GIS apps

Here is the typical workflow used to create web apps using ArcGIS Online:

1. Define your objectives.

2. Research and/or prepare your data.

3. Add your data to ArcGIS Online, or publish it as services to ArcGIS Online.

For simple forms and small sizes, add data directly through the map viewer (see chapter 1, section 1.3, and chapter 2, section 2.1). Otherwise, publish data, maps, and toolboxes as web services, and add them to your web map (see chapters 3, 4, 5, and 7).

4. Create and share your web map using the ArcGIS Online map viewer.

• Add your service or layer, or other available types of layers, to your web map.

• Symbolize your layer (for some types of layers only) and configure pop-up windows.

• Save and share your web map.

5. Create and share your web app.

Browse through the ArcGIS Online web app templates to find a template that best suits your needs and then use it to transform your web map into a web app. If no templates meet your requirements, use ArcGIS Web APIs, Mobile APIs, and Runtime SDKs to create your own app.

This tutorial

In this tutorial, you will create a web GIS app that introduces the main points of interest (POIs) in the City of Redlands, California.

Data: A CSV file contains data for the main POIs in Redlands, including longitude, latitude, names, descriptions, photo or video URLs, and thumbnail URLs. The sample data for this entire book is available at esripress.esri.com/bookresources. To get the data, navigate to the webpage, find the Getting to Know Web GIS title, download the sample data, and extract the files to C:\EsriPress, or follow your instructor’s instructions to download the data.

Requirements:

• Your web app should display a basemap (a street map or satellite imagery) of the city and POI locations, along with their descriptions and photos or videos.

• It should be engaging and easy to use.

• It should work on desktops, tablets, and smartphones.

Solution: To build this web app, select the Map Tour template, one of the most popular ArcGIS Online templates. See two screen captures of it in the figure and a live sample at http://storymaps.esri.com/stories/maptour-palmsprings.

[image: images]

The Map Tour web app template working in a desktop browser, left, and on a smartphone.

The Map Tour template produces attractive, easy-to-use web apps that help you present geographic information with compelling photographic and video story elements. The template layout automatically rearranges itself to adapt to various screen sizes and can display a set of places on a map in a numbered sequence made for browsing. It is designed for use in web browsers on the desktop, smartphones, and tablets.

Many scenarios benefit from this template:

• Showing the world the work your government department, organization, or agency is doing or has done

• Showcasing the key attractions of a city or region

• Introducing a park and its features

• Providing a tour of a campus, an outdoor art collection, or a historic district

• Educating people about areas of scientific or geographic interest

• Directing public attention to places you want to improve or protect

• Creating online photo or video journals of a trip or event

System requirements:

• Microsoft Excel or a text editor to create and edit your CSV data

• CSV easily represents points though not complex geometric forms such as lines or polygons.

• Excel automatically maintains correct CSV format (for example, adding correct quotes).

• A web browser

• ArcGIS Online, ArcGIS Online for Organizations software, or Portal for ArcGIS

• If your organization offers ArcGIS Online for Organizations, ask your administrator or instructor to create an account for you. For the work you will do in this chapter, a user-level account will suffice; however, you will need a publisher-level account in chapter 5, so get a publisher account if possible.

• If you do not have access to an organizational account, create a free public account instead. (However, do not create the 60-day free trial subscription account now; wait until you reach chapter 5 and the later chapters when you will need it.)

[image: images]    Note to instructors: you can create a group for your students in which they can share their work with other members.

1.1 Create an ArcGIS Online account

Skip this section if you already have an ArcGIS Online account or if you are using ArcGIS Online for Organizations or Portal for ArcGIS, in which cases you should ask your administrator or instructor to create an account for you.

If you are an instructor, follow step 6 to create a group account for your class.

For those who have not created an ArcGIS Online account yet, please create a public account by following the instructions that follow below. (Wait until chapter 5 to create a 60-day free trial subscription.)

1. Open your web browser, navigate to ArcGIS Online (arcgis.com), and then click the Sign In button located in the upper-right corner of the page.

2. Click Create a Public Account.

[image: images]

3. On the Create a New Account page:

• Input your user name, password, and other requested information.

• Click the Review and Accept the Terms of Use button, and accept the terms of use.

• Click the Create My Account button.

[image: images]

Esri sends you a welcome e-mail that contains a URL link that validates your e-mail address.

4. Click the validation URL link in the welcome e-mail. On the next screen, complete the confirmation by typing your password in the prompt and clicking OK.

5. Open a web browser, navigate to ArcGIS Online, click the Sign In link in the upper-right corner of the browser page, and then input your user name and password to log in.

[image: images]

6. Optionally, for a web GIS class, the instructor can consolidate all student accounts into one group. This will make it easier for the class to review each other’s work. In the process, students will also learn how to secure their content in ArcGIS Online.

For instructors to create a group:

• Log in and click the Groups link on the main menu bar.

• Click the Create a Group link [image: images].

• Follow the instructions to finish creating a group.

• Invite your students to join the new group.

• Click the Membership Requests button [image: images] to approve student requests.

[image: images]

For students to join a group:

• In the Search box, input the group name given by your instructor and click Search for Groups.

• In the search result, select the group your instructor created.

• Click the Join this Group button.

[image: images]

You become a member of the group after the group owner approves your request.

1.2 Prepare your data

ArcGIS Online web app templates require certain kinds of data content. The Map Tour template, for example, requires a list of points (a point layer) and the locations, captions, descriptions, photos or videos, and thumbnails associated with them. Data can be organized in CSV or point shapefile, map service (chapter 3), or feature service (chapter 5) format.

This chapter provides a sample CSV dataset with coordinates for the main POIs in the City of Redlands. Examine the sample data to familiarize yourself with the required fields.

1. If you have not already done so, navigate to esripress.esri.com/bookresources, or follow your instructor’s instructions to download the sample data for this book. Extract the files to C:\EsriPress.

2. In Microsoft Excel, navigate to C:\EsriPress\GTKWebGIS\Chapter1\Locations.csv, and study its data format.

[image: images]

The first row of your spreadsheet provides the header. Below that, each row contains one tour point. For each point, the Map Tour template expects the following fields:

• Name: A short name identifying the point.

• Caption: A description of the point. Keep it short (less than 350 characters is recommended). The caption can include HTML tags to format the text or provide hyperlinks.

• URL: The full web address for the full-size image or video, starting with http://, https://, or //. The recommended image size is 1000 × 750 pixels, but other sizes will also work.

• For videos: The template does not include a generic video player. Instead, use the URL that a video hosting service, such as YouTube, provides for embedding videos via link. Make sure to append #isVideo to the end of the URL (for example, http://www.youtube.com/embed/RM0eMdrPhEA#isVideo).

• To use photos or videos on your computer, you must first upload them to some form of online storage, such as Flickr, Picasa, Facebook, Google Drive, Microsoft SkyDrive, YouTube, or your own web server.

• If you have not yet collected your own images and videos, you can search for media through search engines and then copy their URLs.

• For images: Right-click an image. Select Image Location in Firefox or Copy Image URL in Chrome. For Internet Explorer, select Properties and then copy the image address URL.

• For YouTube videos: right-click the video being played, click Copy Embed Code, paste the code into Notepad, find the URL in the code, and append #isVideo to the end of the URL.

• Thumb_URL: the full web address of the thumbnail image (starting with http://, https://, or //). Images can fit to scale, but the recommended image size is 200 × 133 pixels.

• Geographic Location: specify longitude and latitude as Long and Lat (in decimal degrees); a single Address field containing a complete street address; or multiple fields (such as Address, City, State, and ZIP). This tutorial uses Long and Lat.

• Icon_color (optional): The color of each point. The valid values—R, G, B, and P—indicate red, green, blue, and purple, respectively.

You will often need to find a point’s latitude and longitude. For example, the last POI in the CSV dataset, Market Night, is missing both longitude and latitude. Next, find these coordinates using the ArcGIS Online map viewer.

3. Open a web browser, navigate to ArcGIS Online, and sign in.

Familiarize yourself with the ArcGIS Online main menu bar links:

• Gallery leads to featured maps and apps.

• Map goes to the ArcGIS Online map viewer.

• Groups takes users to the My Groups page where you can create and join groups.

• My Content links to the My Content page, where users can view, add, and delete content items. Look at the upper-right portion of the main page. There, the Search box and button allow you to search for content in the ArcGIS Online catalog.

4. Click the Map button to open the ArcGIS Online map viewer.

[image: images]

If you know where this missing POI is, navigate there directly on the map. Here, you will use geocoding. Redlands Market Night takes place downtown at the intersection of Orange and East State Streets.

5. Type Orange St & E State St., Redlands, CA in the place search text box and then press Enter or click the Search button.

The address appears, and the map zooms there.

[image: images]

6. On the menu bar, click the Measure button [image: images], next click the Location icon [image: images], and then click on the map near the pointer of the callout box.

The location’s longitude and latitude displays under Measurement Result.

[image: images]

7. Copy the longitude and latitude values you retrieved in step 6, and paste them to the Market Night row in the CSV file.

8. In Excel, save the CSV.

Your data is now complete.

1.3 Create a web map

Make sure you sign in before continuing with the remaining steps. Otherwise, you will not be able to save your web map and may lose your work.

1. In a web browser, navigate to ArcGIS Online, the home page of ArcGIS Online for your organization (usually in the format of http://www.organization_name.maps.arcgis.com), or the home page of your Portal for ArcGIS, depending on what you are using.

2. Click the Map button to go to the ArcGIS Online map viewer, and familiarize yourself with the menu bar.

[image: images]

The ArcGIS Online map viewer helps users create, customize, and view web maps. Look at the buttons on the menu bar:

• The Details button [image: images] toggles the panel on the left side of the map canvas.

• This panel can display a map’s metadata, table of contents (TOC), or legend.

• The Add button [image: images] is used to create a variety of layers in the map.

• The Basemap button [image: images] displays a gallery that users can choose from.

• The Save button [image: images] allows you to save your web map.

• The Share button [image: images] lets you select the people who will have access to your web map and choose how you will share it, either by embedding the map in a webpage or by creating a web app from a template.

• The Print button [image: images] creates a hard copy of the current map view.

• The Measure button [image: images] helps determine distances, areas, and a location’s longitude and latitude.

• The Bookmarks button [image: images] allows you to save a list of map extents so that you can quickly select one and zoom to its extent.

• In the Find address or place text box, users can specify an address or place and find its location on the map viewer.

3. Add the CSV file to the map viewer.

If you are using a web browser that supports the drag-and-drop operation (such as Chrome, Firefox, or Internet Explorer 10+), simply drag the CSV file to the map canvas.
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For all browsers, click the Add button [image: images] on the menu bar, click Add Layer from File, locate the CSV file on your computer, and click the Import Layer button.

[image: images]

The map viewer displays your CSV automatically.

4. Zoom the map to an extent that includes all the points.

This provides users with a big picture of all POI locations. Save your web map so that you can use it as the initial extent of your web app.

[image: images]

5. On the menu bar, click the Save button [image: images] and click Save.

6. In the Save Map dialog box, enter the title, tags, and summary of your web map. Now click the Save Map button.

[image: images] Tip:

• For your homework, include your name in the title so that you and your instructor can easily find your web map.
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Congratulations! You have created a simple web map.

Typically, users need to configure pop-up windows, and sometimes change symbols, on map layers. You will learn these skills in chapter 2. For now, in this tutorial, the Map Tour template automatically handles the symbols of your layer, so do not make any of these changes.

1.4 Create a web app using a template

This step will transform your web map into a web app using an ArcGIS Online Map Tour template.

1. Keep the tutorial web map open. From the map viewer, click the Share button [image: images] on the menu bar, which opens the Share window.

[image: images]

2. In the Share window, select the check box(es) next to the organization and/or group(s) with which you would like to share your web map or click Everyone (public). Click the Make a Web Application button.

[image: images]

[image: images]    Note: unless you share your web map with everyone, a prompt will ask users to log in whenever they open your web map and any web app that uses this map.

3. Browse the web app templates for the Map Tour template. Once there, click the Publish drop-down arrow and click Publish.
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4. Provide the appropriate title, tags, and summary information and then click the Save & Publish button.
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5. Click the View Item button to go to the app’s item details page.
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6. Familiarize yourself with the item details page.

The item details page displays information about the contents of an ArcGIS Online item (here, your web app): title, summary, thumbnail, description, owner, ratings and comments, last modified date, access and use constraints, size, credits, tags, and extent.

The menu bar on the item details page includes the following buttons:

• Open provides a list of different ways to view these contents for web maps, web apps, and hosted services.

• Share enables control over access to items.

• Edit lets you edit the metadata or properties of this item.

• Delete lets you remove items from ArcGIS Online.

• Move allows you to move an item to a different folder under your content root folder.

• Attach Code allows you to attach code (such as a ZIP File) to your web mapping and mobile applications. This is helpful if you are sharing a sample or a configurable application and want others to have access to your code.

• Configure App enables configuration of the functions, and sometimes the content, of a web app.

Now change the app’s thumbnail into something more meaningful to you.

7. Click the Edit button.
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8. Click the thumbnail, and navigate to C:\EsriPress\GTKWebGIS\Chapter1\map_tour_thumbnail.jpg. Click OK and then click Save.

You are directed to the item details page after the change is saved. Now your thumbnail has a more intuitive look.

[image: images]

9. Click the thumbnail to view your web app.

Alternatively, click the Open arrow and then click View Application.

[image: images]

10. Spend a few minutes exploring your new web app.

Navigate through the app’s tour points by clicking the thumbnails, the arrows next to the photos, or the numeric icons on the map. Click, for example, the thumbnail for the University of Redlands, and a video introducing the university appears.

[image: images]

Now you have created your own informative and easy-to-use web app. Keep your web app open if you are going directly to the next section.

1.5 Configure your web app

Once you have determined that your app’s tour points and their order, captions, and descriptions are correct, your app is complete. Optionally, you can further enhance your application’s features by using the template’s builder mode. In this mode, you can add or import new tour points; update and delete existing images; set or update locations and descriptions; update the app title, subtitle, and logo; and change the app layout.

1. Continuing from section 1.4, click the Switch to builder mode button.

The Switch to builder mode button restricts access to the application owner.

[image: images]

Alternatively, click the Configure App button on the details page of this web app.

2. Familiarize yourself with the builder mode.

[image: images]



• The pencil icon [image: images] means that you can update nearby text, such as titles, subtitles, image captions, and descriptions.

• The Change media and Change thumbnail buttons can be used to change the URLs of media and thumbnail locations.

• The Add, Organize, and Import buttons allow you to interactively add more locations, change the order of points, and import photos from Flickr, Picasa, Facebook, or a CSV file.

Now change the Esri photo into a video.

3. Click the Esri thumbnail image. Click Change media and then click Video. For the URL, enter http://www.youtube.com/embed/RM0eMdrPhEA#isVideo, and click Apply.

[image: images]

The video loads into the picture frame.

Next, change the thumbnail for Esri to a new one that indicates a video.

4. Click the Change thumbnail button. Specify the URL as http://bit.ly/1nvc2PU (short URL equivalent to http://esrimapbook.esri.com/GTKwebgis/chapter1/thumbnails/esri_v.png), and then click Apply.

[image: images]

5. Click Save to save your changes.

[image: images]

In the following steps, save your work regularly to prevent losing your changes.

6. Above the thumbnail carousel, click the Organize button.

[image: images]

The Organize the tour window allows you to delete tour points and drag pictures to change their order.

7. Select the check box for Use the first point as introduction (does not appear in carousel). Click Apply to close the Organize the tour window.

[image: images]

Optionally, import tour points and media from Flickr, Facebook, Picasa, YouTube, or an additional CSV file. Follow steps 8 through 12 in this tutorial to import a photo from Flickr.

8. Click the Import button.
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9. Click the Flickr icon in the Import window.
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10. Type web_GIS as the Flickr user name, click the Look up button, select MapTour from the Select a Photo Set box, and then click Import.

[image: images]

11. Click the Located tab.

The set contains one photo, which is already geotagged in Flickr. Flickr and similar websites can extract location information from the EXIF (exchangeable image file format) metadata in photos taken by GPS-enabled cameras, such as smartphones. These websites also allow users to specify photo locations manually, using maps.

12. Click Import to import this photo.

[image: images]

The City Hall photo is now added to your web app. The photo name and caption are also imported from Flickr.

[image: images]

13. As an alternative, click the Add button to add a point manually.
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14. In the Add a new tour point window, add a new tour point manually; input its media URL, name, and caption; and specify its location on the map interactively.

15. Add a point if necessary. Otherwise, click the Cancel button to close the window.

[image: images]

16. In the page header, click the Settings button.

[image: images]

This brings up the Application settings window. It has several tabs:

• Layout: choose between Three-panel Layout and Integrated Layout.

• Colors: choose from predefined color themes, or define your own theme.

• Header: set the header logo and share links.

• Data: if the CSV data added to your web map does not contain the fields required in chapter 1, section 1.2, select which fields to use for the photo name, caption, and color fields.

• Extent: define the initial map extent that users will see when the app first opens.

• Zoom Level: specify a scale to which the map will automatically zoom whenever the app user goes from one tour point to another (but if users manually zoom in or out, the map tour app respects their choice and no longer applies your auto zoom level).

17. Click the Zoom Level tab, and set the Scale/level as illustrated.

This scale allows users to see the selected POI and its adjacent area.
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18. Click the Header tab, change the text if needed, and then click Apply.

For example, add your name to the header so that your instructor can easily tell who created your application. Optionally, you can also exchange the logo for your organization’s logo.

[image: images]

Examine the application to see if there is anything else you would like to configure. If so, make further changes.

19. In the page header, click the Save button to save your work.

Keep your web app open if you are going directly to the next section.

1.6 Share your web app

You have created a web app, but you are the only one who can see it. Share it with others so that they can see your web app, too.

1. Continuing from section 1.5, click the Share button in the page header and then click the Share publicly button.
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2. Click the Open button to preview your web app.

3. Share the tour URL with your audience, and submit it to your instructor.
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If you do not want to share your tour publicly, share it only with your organization or group(s).

To do this, go to the web app’s details page, click the Share button, select your organization and/or group(s), and then click OK.

4. Test your web app on smart mobile devices.

Type your app’s web address into a mobile browser. To do this easily, send the URL in an e-mail to your e-mail address and then click the message link in your inbox.

[image: images]

ArcGIS Online templates use responsive web design technologies and can change their layouts to best fit various screen sizes. They work well on iOS, Android, and Windows Phone tablets and phones.

In this tutorial, you have created a user-friendly, informative, and cross-platform web app. It meets all the requirements listed early in this chapter—it displays a basemap and POI locations, their descriptions, and any photos or videos; it is engaging and easy to use; it works on desktops, tablets, and smartphones, using the ArcGIS Online cloud platform; and it did not require a single line of programming.

QUESTIONS AND ANSWERS

1. After I uploaded my CSV to the ArcGIS Online map viewer, I updated my CSV. Will the changes to my CSV automatically update in my web map and web app?

Answer: No.

Once CSV data has been added to the map viewer and saved with your web map, it uploads to the Amazon EC2 cloud, the cloud-computing platform for ArcGIS Online. Your web map and web app will use this copy of the data, rather than your local data.

To use your new CSV data, remove the previous CSV data layer from your web map and replace it with the new CSV. Then save your web map.

As an alternative, use a feature service (see chapter 5) as the data layer instead of a CSV. When someone edits the data, the updates will automatically appear in your map tour app during the editing process.

2. In my map tour application, I would like to add a line layer to show the path of my tour. How do I do this?

Answer: There are a few ways to do this.

• If you hold the data in a shapefile, add it to your web map and configure its symbol using the ArcGIS Online map viewer (see chapter 2).

• If the data is in a geodatabase, create a map document file (MXD), publish it as a web service, and then add it to your web map (see chapter 3).

• If you do not have the tour path data, simply create it using a Map Notes layer. To do this, open your web map in the ArcGIS Online map viewer, click the Add button, click Add Map Notes, give your layer a name—such as “Tour Path”—choose a template, and click the Create button. Choose a line symbol you like from the template on the left and then apply your cursor on the map to draw your tour path.
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3. What is the maximum number of tour points I can have?

Answer: Ninety-nine points for the hosted version.

Most map tours will contain far fewer than the maximum 99 points per tour in the template. However, you can download the template source code, change the configuration to overwrite this limit, and host the web app on your own web server.

4. I found it slow work to locate longitudes and latitudes manually, one by one. Is there a more efficient way to define the locations of my points?

Answer: Use addresses or feature classes if you have them.

In your CSV, specify the addresses of your points in one or multiple address fields (such as Address, City, State, and ZIP). When you add this to the ArcGIS Online map viewer, ArcGIS Online will geocode these addresses and find their locations automatically (see chapter 2).

If you have your map points in a shapefile, a map, or a feature service, you do not need to create a dataset in CSV format. Add the shapefile or service to your web map directly. The next few chapters will show how to do this.

ASSIGNMENTS

Assignment 1: Choose from the following topics, and create a map tour web app to showcase.

• Your personal story (where you were born, where you moved, where you went to school or worked, etc.)

• Your city’s key attractions

• Your campus’s landmarks, buildings, and departments

• Places you have visited, in the past or during a recent vacation

• Branches of a bank or supermarket in your city or region

• Projects that your organization has accomplished or is working on

• Other interests

What to submit: e-mail your web app URL to your instructor, with the subject line Web GIS Assignment 1: Your name.

Resources

ArcGIS Online Help document site

Short videos, http://resources.arcgis.com/en/help/arcgisonline/index.html#/Videos/010q00000003000000.

Esri blogs

“Using GPS Data in ArcGIS Online Web Maps,” by Bern Szukalski, http://blogs.esri.com/esri/arcgis/2013/08/13/using-gps-data-in-arcgis-online-web-maps.

“Using Flickr Photos in the Hosted Map Tour Story Map,” by Bern Szukalski, http://blogs.esri.com/esri/arcgis/2013/07/26/using-flickr-photos-in-map-tour-story-maps.

“Adding Websites to Your Story Map Map Tours,” by Bern Szukalski, http://blogs.esri.com/esri/arcgis/2014/01/21/adding-websites-to-your-story-map-map-tours.

ArcNews and ArcWatch

Intelligent Web Maps and ArcGIS Online, www.esri.com/news/arcnews/summer11articles/intelligent-web-maps-and-arcgis-online.html.

“Make a Map Tour Story Map,” by Rupert Essinger, www.esri.com/esri-news/arcwatch/0513/make-a-map-tour-story-map.

Esri videos

“Every Map Tells a Story: How GIS Brings Maps to Life,” by Allen Carroll, Bern Szukalski, and Rupert Essinger, http://video.esri.com/watch/2427/every-map-tells-a-story-how-gis-brings-maps-to-life.


Chapter 2

More on ArcGIS Online layers, maps, and apps

This chapter introduces the best practices of web GIS app design and applies them to the creation of a web app. You will learn how to add data from CSV files using geocoding, search for layers from the ArcGIS Online catalog, edit data in the map viewer, and configure pop-ups and change layer symbols.

Learning objectives

• Learn best practices of web GIS app design.

• Map a CSV file using geocoding.

• Search for layers in ArcGIS Online.

• Edit data in the map viewer.

• Symbolize feature layers.

• Configure pop-ups with multimedia.

Thin/thick clients and best practices

When beginning a web GIS app design, consider first how to partition the workload between client and server. Should you adopt thin or thick client architecture? In extremely thin client architecture, the server performs most GIS functions, whereas in extremely thick client architecture, the client assumes most functions (see table 2.1).

Today, best practices suggest a mix of thin and thick client architectures. In such cases, basemaps, operational layers, and tools make up web GIS application functions:

Web GIS application = basemaps + operational layers + tools.

• Basemaps display an application’s location context. They are developed mostly from the server side. Basemaps tend to be relatively static, so they should be cached (see chapter 4). In special situations, they can also be dynamic map services (see chapter 3).

• Operational layers, which are drawn on top of a basemap, contain the themes that end users view and work with. These layers typically contain your business data. The tour points in the map tour app created in chapter 1 exemplify this. Operational layers are often added as feature layers or dynamic map service layers (see chapter 3).

• Tools perform tasks beyond mapping, such as geocoding, routing, querying, generating heat maps, and more specialized functions that implement specific business logic for an enterprise. Tools can be executed:

• on the client side, if the processes work smoothly and the necessary data is downloaded easily to the client side (e.g., generating a heat map of a few thousand points or less), and

• on the server side, if the processes are relatively complex and the necessary data is too large to send to the client side (e.g., routing and calculating stream flows).

Applying best practices in ArcGIS Online

ArcGIS Online supports the following best practices, which simplify web app creation (see table 2.1):

• Basemaps: ArcGIS Online provides ready-to-use imagery, topography, Light Gray Canvas, streets, oceans, National Geographic maps, and OpenStreetMap data. These basemaps, which tile at multiple scales and have global coverage, provide nice cartographic settings for operational layers. ArcGIS Online also allows you to use your own map services as basemaps (open the ArcGIS Online map viewer, click Add > Add Layer from Web, and select the Use as Basemap check box).

• Operational layers: ArcGIS Online can use operational layers from a variety of formats, including CSV, TXT, GPX (GPS exchange), shapefiles, map services, WMS (Web Mapping Service), WMTS (Web Map Tile Service), KML (Keyhole Markup Language), and GeoRSS. You can also use Map Notes layers to create layers directly.

• Configure pop-ups on operational layers, and use images and charts to enhance the user experience.

• If your operational layers are feature layers—layers with coordinates downloaded to the client side—configure their symbols on the client side to make them more meaningful and interactive.

• Tools: ArcGIS Online provides geocoding, routing, query (filters), and hot spot analysis, as well as a rich set of spatial analytic functions, such as geoenrichment ([image: images]    Note: some of these functions require organizational accounts). These tools are available in some of the ArcGIS Online application templates. You can also integrate these tools in your apps using ArcGIS Web APIs and Runtime SDKs.



Table 2.1 Web GIS app components and their support in ArcGIS Online

[image: images]

User experience design principles

User experience is important to consider in web GIS app design and implementation. A web GIS app should enhance necessary functionality with a pleasant user experience that makes it fast, easy, and fun to use.

• Fast: “Don’t make me wait,” say today’s users. Web GIS apps should use caching, database tuning, appropriate client/server task partitioning, and load balancing to achieve optimal performance, scalability, and availability.

• Easy: Today’s users also say, “Don’t make me think about which button to click!” and “If I don’t know how to use your site, it’s your problem.” Web GIS apps should focus on a specific purpose. Do not overwhelm users with unnecessary buttons and data layers. Make the user interface intuitive. It should provide feedback, such as visual cues, that lead users through a well-defined workflow and assure them that they are on the right track.

• Fun: Integrate photos, charts, videos, and animation into your web apps. When used properly, these media can better engage users, convey the key information you want to deliver, and improve user satisfaction.

Search for content in ArcGIS Online

In addition to a cloud GIS platform, ArcGIS Online is also a geoportal, which links to websites that are rich in geospatial data, web services, and other geospatial-related resources. ArcGIS Online is a map-centric content management system, which is helpful in creating web apps. You can search from its abundant ready-to-use layers to find layers you can use as operational layers.

Often, you are both a consumer and a provider of ArcGIS Online resources. The hosted services you publish (see chapter 5), the web maps you create, and the other content you add are automatically registered in ArcGIS Online. The metadata that makes up resource titles, keywords, and descriptions is indexed for users to discover and use in resources for web maps and apps.

Beyond individual applications and projects, geoportals such as ArcGIS Online facilitate sharing and collaboration. This sharing of geospatial information makes ArcGIS Online an important and highly visible component of National Spatial Data Infrastructure (NSDI), which refers to the technology, policies, criteria, standards, and people necessary to promote geospatial data sharing across a nation.

Create and edit data in ArcGIS Online

Data preparation is an important step in creating web GIS apps. You can create and edit data using desktop software such as ArcGIS for Desktop and Microsoft Excel. You can also perform some data editing in ArcGIS Online.

You can create point, line, and polygon layers in the ArcGIS Online map viewer using Map Notes (see chapter 1, “Questions and Answers” section). Only the web map owner can modify these layers (unless another copy is saved).

In the map viewer, you can also edit some feature layers, such as CSV, TXT, GPX, and shapefiles. This helps if you lack access to ArcGIS for Desktop or have already created part of a web map configuration and do not want to start all over again.

You can also edit the feature layers from feature services. Such layers can be edited by both you and your web app users (see chapter 5).

This tutorial

In this tutorial, you will learn how to create a web GIS application that presents the spatial patterns of population growth in the United States and major cities.

In the process, you will learn to map these cities using geocoding, edit the data in ArcGIS Online, configure the pop-ups and symbols of the layer you create, and understand the web app design principles discussed earlier.

Data: For the operational layers, you are provided with a CSV file, C:\EsriPress\GTKWebGIS\Chapter2\CSV\Top_50_US_Cities.csv, which contains the 2010 to 2012 population growth of the 50 most-populated cities in the United States.

• There are no latitude and longitude fields in the CSV.

• After inputting data into ArcGIS Online, you will find some data missing. Edit the data manually.

The population growth data for the US states, counties, tracts, and block groups is not provided. Find this layer in the ArcGIS Online catalog.

Requirements:

• The map should display the population change patterns in major US cities, states, counties, tracts, and block groups.

• The map symbols should be easy to understand.

• If a city or a region is clicked on the map, the map should display corresponding details.

System requirements:

• ArcGIS Online, either a public user account or an organizational user account

• A web browser

• Microsoft Excel or a text editor

2.1 Map CSV data using geocoding

ArcGIS Online provides a variety of basemaps, so most of the time you do not have to worry about creating them. Focus instead on operational layers. In this tutorial, the first of these layers comes from a CSV file.

1. In Microsoft Excel, navigate to C:\EsriPress\GTKWebGIS\Chapter2\CSV\Top_50_US_Cities.csv, and study the data fields.

[image: images]

[image: images]    Note: There are no fields for latitude and longitude in the CSV file. Instead, it contains the following fields:

• Rank_2012: a city’s 2012 rank by population

• City: city name

• State: name of the state in which the city lies

• Census_2010: city population as of 2010

• Estimate_2012: city population as of 2012

• Growth_Rate: population growth rate from 2010 to 2012

• Pop_Density_2010: population density as of 2010, in residents per square miles

• Wikipedia_URL: URL to the city’s Wikipedia page

• Picture_URL: URL to the image of the city’s seal or flag

[image: images]    Note: In the ArcGIS Online map viewer, there is a limit of one thousand points per CSV if you use latitude and longitude and a limit of 250 points per CSV if you use geocoding. See the “Questions and Answers” section at the end of this chapter for more information.

2. Open a web browser, navigate to ArcGIS Online (arcgis.com or your organization’s ArcGIS Online address) or your Portal for ArcGIS, and sign in.

3. On the main menu bar, click the Map button.

This opens the ArcGIS Online map viewer and starts a new map.

4. On the map viewer menu bar, click the Basemap button [image: images], and select the Light Gray Canvas basemap.

This basemap provides a neutral background with minimal colors, labels, and features. This allows operational data to come to the foreground.

5. Click the Add button [image: images], then click Add Layer from File, locate the Top_50_US_Cities.csv file on your computer, and click Import Layer.
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Otherwise, simply drag the CSV file to the ArcGIS Online map viewer if your browser supports the drag-and-drop operation.

6. In the Add CSV Layer dialog box, review the geocoding settings for Country and the location fields.

ArcGIS Online does not find latitude/longitude fields in the CSV and will geocode these points in order to map them. Geocoding converts addresses and other identifiers (such as place-names and postal codes) into x, y coordinates of latitude and longitude. ArcGIS Online geocoding services cover more than one hundred countries. (To view service coverage and support levels, go to http://resources.arcgis.com/en/help/arcgis-rest-api/index.html#//02r300000018000000.)

If your data contains addresses for a single country, select its name from the Country drop-down list. If the addresses refer to multiple countries, or to a country not on the Country list, select World. Then review the location fields. To correct a field, click its cell.
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7. In the Add CSV Layer dialog box, click Add Layer. Notice that the cities are geocoded and displayed on the map.
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8. On the map viewer menu bar, click the Save button and then click Save.

9. In the Save Map dialog box, enter the title, tags, and summary of your web map and then click the Save Map button.

The information specified here constitutes your web map’s metadata, which is saved to the ArcGIS Online catalog. Others can use this to discover your web map.

[image: images]

You have completed a basic web map. You will edit the data and enhance the map in the following sections of this chapter.

2.2 Edit data in the map viewer

You may encounter problems with your CSV or shapefile after you have created a web map and done some configuration. You do not always have to go back to the source data and redo your work. Knowing how to edit your data directly in the ArcGIS Online map viewer can save time.

In this section, create a missing city (Arlington, Texas) and a missing value (for Los Angeles).

1. In the map viewer place search text box, type Arlington, Texas, and then press Enter or click the Search button [image: images].

The Search function finds the city and zooms there. A location callbox appears, indicating the location.

[image: images]

2. In the map viewer table of contents (TOC), click the downward arrow [image: images] to the right of the layer Top_50_US_Cities and then click Enable Editing.

[image: images]

3. On the map viewer menu bar, click the Edit button. Then click the New Feature symbol.

[image: images]

4. On the map, point your mouse to a location in the City of Arlington.

In other words, choose a location close to the origin point of the place search results callout box. This city location then adds to your layer automatically, and an attribute editor appears.

5. In the attribute editor, specify the attribute values listed as follows:

• Rank_2012: 50

• City: Arlington

• State: Texas

• Census_2010: 365,438

• Estimate_2012: 375,600

• Growth_Rate: 0.028

• Pop_Density_2010: 3,811

• Wikipedia_URL: http://www.en.wikipedia.org/wiki/Arlington,_Texas

• Picture_URL: http://upload.wikimedia.org/wikipedia/en/d/d1/Arlingtontx.png

6. After you have finished, click Close.
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7. Navigate the map to Los Angeles.

If you do not know where Los Angeles is, locate the place search text box and type Los Angeles. As you type, the name Los Angeles, California, United States, appears as a candidate in the drop-down menu. Select it. The map viewer zooms there.

8. Click the point symbol of Los Angeles so the attribute editor appears. Fill in the missing value for Growth_Rate as 0.017, and then click Close.

[image: images]

Your data has now been edited. Exit the editing mode to prevent unintended data changes.

9. On the map viewer menu bar, click the Details button [image: images] to open the TOC. Click the down arrow to the right of the layer Top_50_US_Cities and then click Disable Editing.

[image: images]

ArcGIS Online automatically saves your edits to the web map.

2.3 Change layer symbols

A CSV layer in a web map is a type of feature layer. It’s drawn on the client side, and you can change its symbols in the map viewer.

1. With the map on your ArcGIS Online map viewer open, look for the TOC, click the Top 50 US Cities arrow, and then click Change Symbols.

The Change Symbols dialog box appears.

[image: images]

The Change Symbols dialog box provides several options for symbolizing your data. For example:

• Single Symbol: displays all features using the same symbol.

• Unique Symbols: displays features using the particular characteristics that identify them (e.g., using different icons to represent different types of incidents).

• Color: displays features within a single color gradient to highlight differences between them.

• Size: displays features based on a single symbol that varies in size to highlight differences.

This exercise classifies cities by a population growth rate attribute field and then displays each class break with a custom icon.

2. In the Change Symbols dialog box, click Color to show the Growth_Rate field by Equal Interval with 4 classes. Click Apply.

The layer is displayed in default colors on the map.
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3. Click the Symbols arrow and click Change All Symbols. In the Change Symbol window, set the Transparency value as 0. Click the Done button.

The transparency of all the class breaks is changed.
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4. Click the value of the first break to bring up the Change Label and Symbol window.

5. To make the label easier to understand, enter –2% - 0 in the Label field.

6. Click the Change Symbol button to open the Change Symbol window.

[image: images]

The Change Symbol window lists a number of symbol sets. You can choose a symbol set and select the symbol you want to use. For this tutorial, however, you will create a custom symbol.

7. In the Change Symbol window, click the Add an Image link. The Add an Image window appears.

• In the Add an Image window, specify the image URL, http://esrimapbook.esri.com/GTKwebgis/chapter2/blue_down.gif, or the short equivalent, http://bit.ly/1A2gdXp. Click Done.

• Set the symbol size to 16.

• Click Done to close the Change Symbol window.
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Check to see that the symbol for this class has been updated on the map.

8. Click OK to close the Change Label and Symbol window.

9. Repeat steps 4 through 8. Change the labels, symbol images, and sizes for the rest of the class breaks as follows:

• 0% - 2%, http://esrimapbook.esri.com/GTKwebgis/chapter2/yellow_up.gif (or http://bit.ly/1ryHfTU), 16

• 2% - 4%, http://esrimapbook.esri.com/GTKwebgis/chapter2/orange_up.gif (or http://bit.ly/1roReJL), 20

• 4% - 7%, http://esrimapbook.esri.com/GTKwebgis/chapter2/red_up.gif (or http://bit.ly/1sLQBvY), 24

The updates to the symbols of all class breaks appear on your map.

10. Click the Done Changing Symbols button to close the Change Symbols panel.
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11. To save changes, click Save on the map viewer menu bar. Keep your web map open if you are going directly to the next section.

Using the Light Gray Canvas basemap, the operational layer stands out clearly. The new symbols help users quickly distinguish among cities whose populations are rising and falling and how quickly.

2.4 Configure layer pop-up windows

Pop-up windows are considered windows to geographic information. End users rely on them most when interacting with your operational layers. In this section, you will configure what information to display and how you will show it in pop-up windows.

1. While you have our web map open in the ArcGIS Online map viewer, click one of the city names you added.

A default pop-up window appears showing the attributes of the city you clicked.
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If a pop-up window does not appear, it may be disabled for this layer. However, you can enable it.

2. In the TOC, click the Top 50 US Cities arrow and click Enable Pop-up.

This default pop-up window is useful, but it can be enhanced for easier understanding.

3. In the TOC panel, click the Top 50 US Cities arrow and click Configure Pop-up.
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The Pop-up Properties window appears. Now you can configure the pop-up window’s three sections: title, contents, and media.

The pop-up title can be static text, a set of attribute field values, or a combination of the two. Here, use the city name and state name as the title.

4. Click the Plus button [image: images] under Pop-up Title to select the City field. Type a comma, and click the Plus button again to select the State field.
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The pop-up contents can include a list of field attributes or a custom description based on attribute values. Here, use the list of attributes.

5. In the Display drop-down menu, click A list of field attributes and then click the Configure Attributes link.

[image: images]

In the Configure Attributes dialog box, you can choose which fields to show or hide and define their aliases, order, and formats.
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6. In the Configure Attributes dialog box, perform the following:

• Select {Rank_2012}, and set its alias as 2012 Rank.

• Clear the check boxes for {City} and {State}. They already appear in the title, so do not repeat them.

• Select {Census_2010}, and set its alias as 2010 Population.

• Select {Estimate_2012}, and change its alias to 2012 Population.

• Select {Growth_Rate}, and set its alias as Growth Rate.

• Clear the check boxes for the rest of the fields.

• Click OK to close the Configure Attributes dialog box.

7. In the TOC panel, click the Save pop-up button to apply your pop-up configuration.
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8. Click on a city to review the map’s new pop-up window.

Notice that the pop-up window is simpler and easier to read.

[image: images]

9. On the map viewer menu bar, click Save > Save to save your changes.

2.5 Add images and charts to pop-up windows

Media, such as images and charts, can more effectively engage users and improve their understanding of data.

• The tutorial CSV contains two URL fields, Picture_URL and Wikipedia_URL. Use the first URL to add a picture to the city layer’s pop-up window and the second URL to link the picture with the city’s Wikipedia page so that users can gather supplementary information about the city’s population changes.

• Charts require numeric attribute fields. The US cities layer contains several of these fields. Display them in appropriate charts in the pop-up window.

1. Click the Top 50 US Cities arrow and click Configure Pop-up.

2. In the Pop-up Media section, click Add and then click Image.
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3. In the Configure Image dialog box, perform the following:

• Enter City Seal or Flag as the title.

• Enter Click to see more info about the city as the caption.

• For the picture URL, click the Plus button and click the Picture_URL field.

• For the link URL, click the Plus button and click the Wikipedia_URL field.

• Click OK to close the Configure Image dialog box.

[image: images]

The image title, caption, image URL, and link URL can all take the form of static text, attribute field values, or a combination of the two. If you lack image and link URL fields, specify a static URL instead. For an example of an image URL, navigate to http://www.census.gov/history/img/Census_Logo.jpg; for a link URL, navigate to http://www.census.gov. This way, the pop-up windows for all cities display the same image and link to the same source.

You can add more than one image to your pop-up window simply by repeating steps 1 through 3.

4. In the TOC panel, click the Save Pop-up button to apply your pop-up configuration.

5. Click a city on the map to observe the new pop-up window.

The pop-up window displays the city’s seal or an image of its flag. Click on the image, and the city’s Wikipedia page appears.
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6. On the menu bar, click Save to save your work.

7. Click the Top 50 US Cities arrow and click Configure Pop-up.

8. In the Pop-up Media section, click Add and then click Column Chart. The Configure Column Chart dialog box opens.
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9. In the Configure Column Chart dialog box, perform the following:

• For Title, specify 2010 vs. 2012 Population.

• For Chart Fields, select 2012 Population and 2010 Population.

• Click OK to close the Configure Column Chart dialog box.
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10. In the TOC panel, apply the pop-up configuration by clicking the Save Pop-up button.

11. Click a city on the map to see the new pop-up window. To the right of the city seal or flag image, click the right arrow [image: images], and the newly configured chart appears.
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12. On the menu bar, click Save to save your work.

This new pop-up window does more than display raw attribute values. It leverages the URLs stored in the attributes to display a picture and link it to a website that provides details. It also leverages the values of two numeric fields to display in a chart to provide a visual interpretation of reported population changes.

2.6 Add a layer by search

In addition to the population change of the major cities, you need an additional operational layer to show the population change of US states and counties. You are not provided with the data, but you can search for such a layer in the ArcGIS Online catalog.

1. On the map viewer menu bar, click the Add button [image: images], and click Search for Layers in the drop-down menu.
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2. In the Search for Layers panel, perform the following:

• For the Find text box, type USA population change.

• For the In drop-down box, click ArcGIS Online.

• Select the Within map area check box.

• Click Go.
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3. In the results list, find an appropriate layer (e.g., USA Population Change 2010-2012 [Mature Support] by Esri or another appropriate layer), and click it to see its pop-up summary.

Optionally, click the layer name, and read its details to evaluate whether it provides what you need.
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This layer is a map service hosted in ArcGIS Online. You will learn how to publish your own map services using ArcGIS for Server software or ArcGIS Online in the following chapters.

4. In the summary window, click the Add to map link.

Alternatively, close the summary window and then click the Add link under this layer in the search results list.

The layer is added to the map.

5. Click the Done Adding Layers button to close the Search for Layers panel.

6. On the toolbar above the layer list, click the Show Map Legend button [image: images].

The legend helps users understand the population change rate at the state, county, tract, and block group levels.
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7. On the US map, click on any state or county. This layer’s preconfigured pop-up window appears.

A pop-up window is already configured in the layer just added. If a layer you added does not have a preconfigured pop-up window, or you want to change its pop-up window, click the layer in the TOC, expand its sublayers, click the down arrow next to a sublayer, and click Configure Pop-up on the menu.
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8. Click Save to save your web map.

You have discovered a layer for use as an additional operational layer using the ArcGIS Online catalog. This additional layer shows the pattern of population change in major cities and that of every state, county, tract, and block group as you zoom in.

[image: images]    Note: You cannot change the symbols of this map service layer as you did for the CSV layer. This service layer is drawn on the server side. What you see is actually a PNG or JPEG image that is visually overlaid on the basemap.

2.7 Create and configure your web app

1. On the map viewer menu bar, click the Share button [image: images]. The Share window opens.

2. In the Share window, choose to share your web map with everyone (public) or with only your organization or certain groups.

You have the option of embedding your web maps in your existing website, such as a blog. This typically works for simple mapping applications. Here, choose Make a Web Application to create a more complete web app.

3. Click the Make a Web Application button.

4. In the template gallery, find the Basic Viewer template. Click the Publish drop-down arrow and click Publish.

Alternatively, click Preview to preview the template to see if it meets your requirements before publishing it.
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5. Fill in the appropriate title, tags, and summary information of your application. Click the Save & Publish button and then click Close to close the Share window.

The information specified here is actually the web app’s metadata. This will be saved to the ArcGIS Online catalog so that other users can discover your web app.
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You have successfully published your web application. You must share it, and sometimes configure it, before other people can use it.

6. Click the View Item button, or the Go to the item now link, to get to the details page of the new web app.
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7. On the main menu bar of the details page, click the Edit button [image: images].

As the owner of this item, you can change its metadata, including the title, summary, description, access and use constraints, and tags of your web app. Here, change the app’s thumbnail.



• Click on the thumbnail image.

• In the Upload Thumbnail window, click Choose File and click C:\EsriPress\GTKWebGIS\Chapter2\images\thumbnail.jpg.

• Click OK.

• Click Save.
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The new thumbnail helps those who find your web app to quickly get a sense of what it does before they open it.

8. On the menu bar, click the Configure App button [image: images].
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This opens a new window or tab displaying your web app in configuration mode. The configurable properties appear on a panel on the right side of the page.

9. In the General Settings section, change the Color Scheme (to Blue, for example), and keep the Show Title check box checked. Optionally, specify a web address for your organization’s logo.
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10. Study the options in the Menu Items section.

Some functional options, marked with an asterisk (*), as in Editor* and Time Slider*, require certain types of layers in your web map. For example, the Time Slider option requires a time-enabled map service (see chapter 3), while the Editor function demands a feature service layer (see chapter 5).
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11. In the lower-right corner of the page, in the Print Settings section, select the Display Legend on Printout and Layout check boxes.

Once you have selected Layout, all available print layout templates—such as A3, A4, Letter, and Portrait/Landscape—that are supported by the ArcGIS Online printing service will be displayed in the drop-down list.
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12. Click Save.

With the settings saved, the print preview immediately appears on the browser’s left side.

13. Go back to the web app’s item details page by clicking the back button of your web browser.

14. On the item details menu bar, click the Share button [image: images] to share your web app.

In general, share your web app with the same people with whom you shared your web map.

15. On the item details page, click the thumbnail image or click the Open button and click View Application.
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Your web app appears in a new window or tab. You can also open this application on tablets and smartphones.

16. Explore your web app.

Navigate through the map, check the pop-up windows, turn layers on and off, create PDFs using the printing function, examine the legend, and study the patterns of US population change.
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17. To let your instructor and others see your web app, e-mail them the app URL.

The basic viewer template comes with several options for sharing your web app. On the toolbar of your web app, click the Share drop-down arrow and then click Email, Facebook, or Twitter to send your app’s URL to others.

In this tutorial, you created a web app with basemaps, operational layers, and a few tools (e.g., the print tool). You also

• added your first operational layer from a CSV file using geocoding;

• edited this layer in the ArcGIS Online map viewer;

• made this layer easier to understand by configuring intuitive symbols and pop-up windows, including images and charts;

• discovered the second operational layer by searching in the ArcGIS Online catalog; and

• created a web app using the ArcGIS Online basic viewer template, with the print tool added.

QUESTIONS AND ANSWERS

1. After I created my web app using my web map, I updated the symbols and pop-ups of my web map. Will the changes be reflected automatically in my web app?

Answer: Yes.

A web app maintains a link with its web map(s) and depends on it as its source. Changes made to web map content, such as adding or removing layers, changing symbology, or configuring pop-up windows, will reflect automatically in the app.

2. CSV files can only hold point features. How can I add line or polygon features to my web map?

Answer: You have several options:

• Use shapefiles. A shapefile bears an Esri vector data storage format. It is not just one file, but contains .shp, .shx, .dbf, and .prj files. Just zip these files in one ZIP File. Then, in the ArcGIS Online map viewer, click Add > Add Layer from File, find the ZIP File, and add it to your map.
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[image: images]    Note: Your line and polygon features may be generalized for better performance. Read the details at http://resources.arcgis.com/en/help/main/10.1/index.html#//01w10000006z000000.

• Use the Esri geodatabase and a map service or feature service and then add the service to your web map (see chapter 3).

• Use a Map Notes layer.

3. When I went to upload my own city’s tree inventory (over 30,000 features), I was disappointed to learn that you can upload CSV files and shapefiles with only one thousand features or less. How can I work around this limit?

Answer: This is a rational limit.

If you have more than one thousand points in a CSV file or shapefile, you can split it into smaller parts, with each file containing no more than one thousand features, which can then be added to the web map.

Be cautious when doing this. Layers from CSVs and shapefiles will be drawn by the browser side. Web browsers cannot handle large quantities of geometries and attribute data. In particular, some of your end users may still be using older computers that cannot efficiently draw a few thousand points. Thus, the performance of your web app will be slow, or perhaps even unusable, for some of your users.

Try a better solution. Publish your data as a map service using ArcGIS for Server (see chapters 3 and 4) or ArcGIS Online (see chapter 5) and then add the service to your web map. This will enable you to handle large datasets and still provide web apps with fast performance.

ASSIGNMENTS

Assignment 2: Create a web app to display.

Data: Choose one of the following:

1. The real estate for sale in your city, along with pictures and a chart of price histories in the pop-up window

2. The recent crime sites in your city

3. The recent earthquakes in the world

4. Other data you have or can collect

Configure appropriate symbols and pop-up windows for your layer. Include at least one chart or image with a link in the pop-up window. Choose an appropriate template to transform your web map into a web app. Share your web map and app.

For #1, #2, and #4, you will need to collect your own data, using Microsoft Excel or some other spreadsheet tool. Whenever possible, add images, links, and charts to make your app interesting.

For #3, the data can be obtained from the United States Geological Survey (USGS) website. USGS provides an earthquake feed in CSV and other formats. The CSV feed containing last week’s earthquakes with magnitudes greater than 2.5 is located at http://earthquake.usgs.gov/earthquakes/feed/v0.1/summary/2.5_week.csv.

[image: images] Tip:

• You can download the CSV and add it to your web map, or you can add it to the map viewer directly. (In the map viewer, click Add > Add Layer from Web, select a CSV file, and then paste the preceding URL).

Requirements:

• Classify the earthquakes by magnitude, showing earthquakes of greater magnitude in larger point symbols.

• The earthquakes should offer easy-to-understand pop-up windows.

• Add a link to the earthquake layer pop-up window that includes the following:

• An image: displaying the USGS logo.

• A link: clicking the image should open the USGS web page that offers details about the earthquake.

[image: images] Tip:

• The URL pattern is http://earthquake.usgs.gov/earthquakes/eventpage/{EventID} (e.g., http://earthquake.usgs.gov/earthquakes/eventpage/ak10796120).

• A chart: There are numeric fields, such as Depth and Magnitude. Use them to create a column chart.

What to submit: E-mail your instructor with the subject line Web GIS Assignment 2: Your name, and include the following:

• The URL of your web app

Resources

ArcGIS Online Help document site

Short videos, http://resources.arcgis.com/en/help/arcgisonline/index.html#/Videos/010q00000003000000.

Esri blogs

“Adding Geotagged Photos to Your Web Map,” by Bern Szukalski, http://blogs.esri.com/esri/arcgis/2013/08/14/adding-geotagged-photos-to-your-web-map.

“Crafting Custom Attribute Displays in Pop-ups,” by Bern Szukalski, http://blogs.esri.com/esri/arcgis/2013/07/25/custom-attribute-display-pop-ups.

Esri Training website

“Creating Web Applications Using ArcGIS Online,” http://training.esri.com/gateway/index.cfm?fa=catalog.webCourseDetail&courseid=2652.

“Authoring Web Maps Using ArcGIS Online,” http://training.esri.com/gateway/index.cfm?fa=catalog.webCourseDetail&courseid=2519.

“More Training on ArcGIS Online,” http://training.esri.com/gateway/index.cfm?fa=search.results&searchterm=arcgis+online.




Chapter 3

Map services and time animation

In the first two chapters, you learned how to create web apps using CSV files, shapefiles, and the ArcGIS Online service. This is a quick and simple way to create web apps using a small amount of data (no more than a couple thousand points or a few hundred lines and polygons). This chapter teaches you how to publish map services and use them to create web apps using both small and large amounts of data. This chapter also teaches you how to enable time on your map service and create web apps with time animation.

Learning objectives

• Understand web services.

• Connect to the ArcGIS for Server service.

• Enable time on data layers.

• Analyze a map document.

• Publish a map service.

• Test a service in the Services Directory.

• Add a map service to a web map.

• Create a web app with time animation.

This chapter in the big picture
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ArcGIS offers many ways to build web applications. The thick red line in the figure highlights the technology chapter 3 teaches.

Geospatial web services

Web services are software components that can be accessed or integrated by other applications through the web. Combining the power of GIS, programming components, and the World Wide Web, geospatial web services technology is profoundly important to web GIS—both now and in the future.

• At the applications and projects level, web services provide building blocks. The map layer in ArcGIS Online showing US population change in chapter 2, for example, is actually a map service. You used it to build a web app, just as anyone else could do.

• At an organizational level, web services provide a useful means of data sharing and collaboration. An organization can share its data as a map service, as in the case of the US population change map layer. Data and maps can be used on demand, without local copies being made. This architecture fosters collaboration among organizations and can serve as the supporting framework for spatial data infrastructure (SDI).

There are many types of geospatial web services. The ones commonly used include those shown in table 3.1.

Table 3.1 Common types of geospatial web services







	Service type
	Capabilities



	Map service
	The most common type of geospatial web services. Map services allow clients to request maps for a specific geographic extent and return the maps in an image format, such as JPEG, PNG, or GIF. ArcGIS map services provide additional functions, such as attribute query, field statistics, spatial identify, and dynamic projection. Map services can be dynamic (in which maps are generated on demand, see this chapter) or tiled (in which maps are generated in advance, see chapter 4).



	Feature service
	Allows web clients to update the GIS database on the server (see chapter 5).



	Image service
	Web clients can access raw raster data to generate maps. ArcGIS image service additionally supports rapid map algebra calculation.



	Locator or geocode service
	Can convert addresses and place-names into x, y locations (see chapter 2).



	Geoprocessing service (GP service)
	Shares the server’s workflow and analysis functions with web clients (see chapter 7).



	Network analysis service
	Provides routing, tracing, and allocating functions based on undirected flow networks, such as streets.



	ArcGIS GeoEvent Extension for Server
	Provided with ArcGIS Server by default. It supports geometric calculations such as buffering, simplifying, calculating areas and lengths, and projecting.



	Esri Geotrigger Service
	A type of ArcGIS Online service optimized for use in conjunction with location-aware consumer devices, such as smartphones and tablets. Bundled with a unique technology that allows Geotrigger SDKs to operate without draining your battery.



	ArcGIS GeoEvent Extension for Server
	Similar to a geotrigger service, it can apply filtering and processing to GeoEvents as they flow from input to output within a GeoEvent processor. GeoEvent Processor is an extension of ArcGIS for Server.



	3D scene services
	Allows web clients to request maps in 3D.




Dynamic map service layers versus feature layers

How can map services handle larger amounts of data than adding CSVs or shapefiles directly into the ArcGIS Online map viewer?

The answer involves two important concepts: map service layers and feature layers. When you add a map service to a web map, you are using the map service layer approach. When you add CSVs and shapefiles to your ArcGIS Online map viewer, you are using the feature layer approach. The following figure and table 3.2 compare these two approaches.
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Comparison of a map service layer and a feature layer.

Table 3.2 Dynamic map service layers versus feature layers
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[image: images]    Note: map services can also return geometries and attributes and thus support feature layers.

Choose a GIS server

Several ArcGIS products support web service publication. Table 3.3 describes their functionality.

Table 3.3 ArcGIS products for publishing web services







	Server
	Characteristics



	ArcGIS for Server
	Able to publish a variety of GIS resources
Supports all capabilities
Able to register data stores with the server



	ArcGIS for Server in the Cloud
	Maintained within Amazon, Microsoft, VCE, Terremark, and the IBM cloud infrastructure, or your organization’s private cloud
Able to publish a variety of GIS resources
Supports all capabilities
Able to register data stores with the server



	ArcGIS Online for Organizations
	No server to install or maintain
Scales automatically as user base increases
Only allows users to publish tiled map and feature services



	Portal for ArcGIS
	Supports hosted feature services
Supports other service types when coupled with and powered by ArcGIS for Server




This chapter uses ArcGIS for Server software. ArcGIS for Server has three editions and two capacity levels. The three editions are Basic, Standard, and Advanced, which provide different levels of functionality. The two levels are ArcGIS for Server Workgroup and ArcGIS for Server Enterprise, which differ in their supported data storage capacity and simultaneous database connections. The Standard or Advanced edition is required to publish services.

Workflow to publish map services

The following figure illustrates the typical workflow to publish map services.
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Workflow to publish map services using ArcGIS for Desktop.

• Prepare data using ArcGIS for Desktop software. Following are some best practices used to increase map service performance:

• For most situations, project your data into Web Mercator so that your map overlays the popular basemaps without having to be projected on the fly.

• Create indexes on the attribute fields that will be queried in your app.

• Turn off or delete attribute fields that are irrelevant to the objectives of your app.

• Author the map document in ArcMap software. Add data layers to the map. Configure their symbols and other properties.

• Remove basemaps and unused layers before sharing your document as a service.

• Do not use complex symbols, such as 3D symbols, that are not supported in map services or that will slow down your map service performance.

• Share your map as a service.

• Use the Service Editor in ArcGIS to analyze your map document and review for any errors, warnings, and messages that may result. Once these errors are fixed, you can publish your map service. The publishing process will generate a service definition (SD) file from your map document and upload it to the server to create the map service.

• Verify your map service.

• After you have published the service, use ArcGIS Services Directory or ArcGIS Server Manager to verify whether it works correctly. The Services Directory allows you to browse and discover the web services that ArcGIS for Server makes available, preview or test the services in various clients, and obtain information, such as service metadata.

Data stores

ArcGIS for Server needs access to your data in order to provide service. You can access the data on your computer, of course, but this does not mean that ArcGIS for Server can also access your data. There are two reasons for this:

• Your user account is different from the ArcGIS for Server user account. The two accounts may have different data access privileges as a consequence.

• Your ArcGIS for Desktop and ArcGIS for Server software may be installed and running on two different computers.

A data store gives your ArcGIS Server a list of data locations for which ArcGIS for Server has verified access without having to make copies of the data. (You will learn more about data stores in chapter 4.)

You will not register data stores in this chapter. Without data stores, ArcGIS for Server automatically creates a copy of relevant data on the server so that it always has access to service-related data. This works if your data size is not too large or if you need to keep your internal datasets separate from the data you export to the server.
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If no data stores are registered, the publishing process will automatically copy the map document’s data to the server, thus ensuring that the server has the data it needs to host your service.

Time-enabled map services and time series animation

Time is an important dimension of geospatial data. Time-enabled web apps allow you to step through periods of time, revealing the temporal patterns and trends hidden in your data. For example, you can

• track moving objects, such as airplanes, vehicles, and hurricanes;

• display discrete events, such as crimes, accidents, and diseases over time;

• visualize value change in stationary objects, such as air quality sensors and weather stations; and

• map the progression of a wildfire or flood.

Use time-enabled map services to animate the geographic features in your web apps. It is a simple process. To meet the data requirement for time-enabled services, each feature must have a single date attribute field or a beginning and an ending field. If the attributes contain no date fields, use fields of other data types, as long as their values are expressed in “sortable” formats, such as a YYYYMMDD string or number format.

[image: images]

Examples of temporal data.

This tutorial

In this tutorial, you will create a web app to display the spatial and temporal patterns of historic hurricanes and earthquakes in the US region using map animation.

Data: a file geodatabase containing the following two layers covering the US region between 2000 and 2008:

• Major earthquakes with magnitudes greater than 3.6.

• Major hurricanes: There are 4,419 lines—too many for the CSV/shapefile upload approach that you learned in chapter 2.

Requirements: your web app should be able to display:

• All the hurricanes and earthquakes on one map.

• Earthquakes and hurricanes by time (e.g., by units of months).

• Meaningful pop-up windows whenever a user clicks on an earthquake or hurricane.

System requirements:

• ArcGIS for Desktop

• ArcGIS for Server

• You need to know the user name and password for an administrator or publisher account.

• ArcGIS Online

• Either a public or an organizational account.

3.1 Connect to your GIS server

[image: images]    Notes:

• Before you continue, your system administrator or instructor should have provided you with information about your ArcGIS for Server connection, including the correct URL and an administrator- or publisher-level user name and password. If not, ask them for it.

• If your ArcGIS for Server site has not been created, you will need to create it before you can start this tutorial. An ArcGIS for Server site contains everything that is needed for ArcGIS for Server to function (e.g., the server directories, configuration store, and more). In addition, during site creation, important accounts and administrative applications are created, without which ArcGIS for Server is not able to function. Follow the link in the ArcGIS Help files to create a new site, http://resources.arcgis.com/en/help/main/10.2/index.html#//0154000002p4000000, and perform the following:

• Open ArcGIS Server Manager, either using the installed shortcut or navigate to its URL, such as http://gisserver_name:6080/arcgis/manager.

• Click Create new site.

• Define a user name and password as the primary site administrator (i.e., keep both user name and password as siteadmin).

• Keep the defaults for the server directory and configuration store.

• The site will take a couple of minutes to create. Once it is created, please log in to ArcGIS Server Manager (siteadmin/siteadmin)—you should see the Sample World Cities map service running.

• Now that the site has been created, you can proceed with connecting to your GIS server.

1. In ArcMap, click the catalog icon [image: images] to open the Catalog window.

For your convenience, click the Pin button [image: images] to turn off the Auto Hide mode so that the Catalog window stays open.
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2. In the Catalog tree, expand the GIS Servers node and double-click Add ArcGIS Server.

[image: images]

3. In the Add ArcGIS Server window, select Administer GIS Server or Publish GIS Services, depending on the type of account provided to you, and then click Next.

[image: images]

A publisher can publish, delete, start, and stop services. An administrator can additionally edit server properties, such as configuring data stores and server clusters.

4. In the General window, specify your server connection information as follows:

• For Server URL, type the URL for ArcGIS Server, which is usually http://computer_name:6080/arcgis or http://computer_name/arcgis.

• For Server Type, open the drop-down box and click ArcGIS Server.

• For Staging Folder, leave it as is. It is used to store temporary files, such as SD files.

• Enter the user name and password of an ArcGIS for Server administrator or publisher. The default user name and password are siteadmin/siteadmin.
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5. Click Finish.
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Notice that your connection appears in the GIS Servers node in the Catalog tree. Now you have made a connection to ArcGIS for Server that you will use to publish services.

3.2 Author your map document

In this section, create a map document and use it to publish a map service.

[image: images]    Notes:

• If you have not downloaded the sample data, navigate to http://esripress.esri.com/bookresources, find the Getting to Know Web GIS title, download the sample data, and extract the files to C:\EsriPress, or follow your instructor’s directions to download the data.

• This book does not address map design or cartography, so, in this section, you will learn to quickly design a simple map that will work for the tutorial. You may already know how to author maps. If so, and you would like to skip these map design steps, follow steps 1 through 3, open the natural_disasters_key.mxd file in the Answers folder, and proceed to section 3.3.

1. On the ArcMap main menu bar, click File and then click New.

This creates a new blank map. By default, the coordinate system of your map document, and that of your map service, is the same as the first layer that you added to the map. Starting with a blank map prevents you from being affected by previous work.

2. In the ArcMap Catalog window, click the Connect to Folder button and then click Computer > Local Disk C: > EsriPress. Select the GTKWebGIS folder and click OK.
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A folder connection to this book’s sample data is created, which allows you quick access.

3. In the Catalog window, look for Folder Connections. Click the folder C:\EsriPress\GTKWebGIS, find Chapter3\Data.gdb, and expand the Data.gdb file. Two feature classes appear.

[image: images]

4. Drag the two layers (Earthquakes and Hurricanes) to your map. They display with the default symbols.

These two data layers are in the Web Mercator coordinate system. Because they are the first layers added to your map, the coordinate system of your map document is also Web Mercator.

5. Click Save. Save your map document as C:\EsriPress\GTKWebGIS\Chapter3\natural_disasters.mxd. Click Save to close the Save As window.
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You have now created your map document, and you can publish it as a service. You can enhance the layers’ symbols by following steps 6 through 13 to make your map service more intuitive.

6. In the table of contents (TOC), double-click the earthquakes layer to open the Layer Properties dialog box.

Alternatively, you can right-click the earthquakes layer and click Properties to open the Layer Properties dialog box.
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7. In the Layer Properties dialog box, perform the following:

• Click the Symbology tab and then click Quantities > Graduated symbols.

• In the Fields group, for Value, click OTHER_MAG1, the earthquake magnitude field.

• Classify using 3 classes.

• Set the symbol size from 4 to 12.

• Click the Template button to choose an appropriate symbol, such as a black circle filled with red.
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8. Click the range of the first class break and enter 6. Click the label, and set that as 3.6–6.
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This makes the class breaks and labels more readable.

9. Click on the range of the second break, and set it as 7. Click on the labels of the second and third breaks, and set them as 6–7 and 7–7.9.
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10. Click OK to close the Layer Properties dialog box.

This changes the symbols of the earthquakes layer. The new symbols appear on the map. Next, change the symbols of the hurricanes.

11. In the TOC, double-click the hurricanes layer.

12. In the Layer Properties dialog box, perform the following:

• Click the Symbology tab and click Quantities > Graduated colors.

• In the Fields group, for Value, click wmo_wind, the hurricane wind-speed field.

• Classify it as 3 classes.

• Use Natural Breaks (Jenks).

• Use the green to red color ramp.

• Change the label of the first class to 10–45.

• Change the label of the second class to 45–80.

• Change the label of the third class to 80–160.

• Click OK to close the Layer Properties dialog box.
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The symbols of the hurricanes layer are updated on the map.
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13. On the ArcMap Standard toolbar, click Save [image: images] to save your map document.

Now you have created a map document with simple but meaningful symbols.

3.3 Enable time on your map layers

You do not have to time enable your map services. However, if you have date fields or appropriate integer or string fields, enabling time can provide an appealing way to visualize data.

1. In the TOC, double-click the earthquakes layer.

The Layer Properties dialog box appears.

2. In the Layer Properties dialog box, perform the following:

• Click the Time tab.

• Select the check box for Enable time on this layer.

• For Layer Time, leave it as Each feature has a single time field.

• For Time Field, click EQ_DATE, a date field that stores the time when each earthquake occurred.

• Leave Field Format as <Date/Time>.

• Click Calculate, which finds the layer time extent (i.e., the minimum and maximum values of EQ_DATE).

• Click OK to close the Layer Properties dialog box.
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Do not worry about the time step interval because you can configure it later in your web map. Not all data layers have a date field. Other fields, such as the YEAR integer field in the earthquakes layer, can be used to enable time on this layer, too.

You have now enabled time on the earthquakes layer. Next, enable time on the hurricanes layer.

3. In the TOC, double-click the hurricanes layer to open the Layer Properties dialog box.

4. In the Layer Properties dialog box, perform the following:

• Click the Time tab.

• Select the check box for Enable time on this layer.

• Leave Layer Time as Each feature has a single time field.

• For Time Field, click H_DATE, which is a date field that stores the date of each section of hurricane paths.

• Leave Field Format as <Date/Time>.

• Click Calculate to find the layer time extent.

• Click OK to close the Layer Properties dialog box.
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5. On the ArcMap toolbar, click the Time Slider button [image: images].

Play back the animation effects in ArcMap. At the beginning of or during the animation, your data layers may disappear from the map. This is because there are no features in these particular time intervals.



• In the Time Slider window, click the Options button [image: images].

• In the Time Slider Options dialog box, specify the time window as 2 months, and leave the time window options as Display data for entire time window. Click OK to close the Time Slider Options dialog box.

• Click the Play button [image: images] to play back the animation.
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If the playback speed seems too fast, change it using the Playback tab. Do not worry about the Time Slider settings. Configure them later in your web map.

6. Click Save to save your map document.

Your map’s two layers are now time enabled. This map document can be used to publish not only an ordinary map service, but a time-enabled map service.

Keep your map open if you are going directly to the next section.

3.4 Publish your map as a service

1. While you are in ArcMap and have your map document open, from the main menu bar, click File > Share As > Service.
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Alternatively, in the Catalog window, you can browse to your MXD, right-click it, and click Share As Service.
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2. In the Share as Service dialog box, select Publish a service (or overwrite an existing service if you want to overwrite a service you published before) and then click Next.
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3. From the Choose a connection drop-down list, choose the ArcGIS Server connection you created in section 3.1. Specify a service name and click Next.
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[image: images]    Notes:

• Service names and their folders (see step 4) should be unique to a server. In a classroom where many students share one server, either add your name as a suffix to your service name or place the service in your own folder.

• A service name must contain only alphanumeric characters and underscores.

4. Select Create new folder, specify a folder name (e.g., your name or your project name), and click Continue.

By default, ArcGIS for Server publishes services to its root folder. Services can be organized into subfolders. You can name your subfolder after your project name, your organization name, or your own name.

[image: images]

5. At the top of the Service Editor window, click the Analyze button [image: images].

Your map document is analyzed to identify errors or warnings.
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[image: images] Tip:

• To create a larger viewing area when configuring your map service, click the Collapse button [image: images] next to the Publish button at the top of the Service Editor window.

6. The results of your analysis appear in the Prepare window.

Three types of results are possible. You can right-click a result to get help on how to address an issue.

• Errors ([image: images]): these are issues that must be fixed before you can publish your map document as a service.

• Warnings ([image: images]): these are issues that may affect performance, appearance, and data access.

• Messages ([image: images]): these suggest methods and best practices to optimize your GIS resource for deployment on the server.

[image: images]

In the Prepare window, there are no errors and a few warnings and messages. The following warning messages are common:

• Data source is not registered with the server and data will be copied to the server: See the “Data stores” section discussed earlier in this chapter. It is OK to ignore this warning. You will learn how to configure data stores in chapter 4.

• Map is being published with data copied to the server using data frame full extent: All data within the full extent of the data frame will copy to the server. You want this, so ignore this warning.

• Missing Tags in Item Description: Double-click the message in the Prepare window and then fill in Tags on the Item Description page, as illustrated in the following figure.

• Missing Summary in Item Description: Double-click the message in the Prepare window, and fill in Summary on the Item Description page, as illustrated in the following figure.
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You can set other properties in the Service Editor window. For example, you can turn on additional capabilities, such as the following:

• KML (Keyhole Markup Language) so that KML clients can use your service

• OGC WMS (Open Geospatial Consortium Web Map Service) so that WMS clients can use your service

7. In the upper-right corner of the Service Editor window, click the Publish button [image: images].
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8. In the Copying Data to Server dialog box, click OK.
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ArcMap creates an SD file and copies it with the data to your ArcGIS Server. The size of your data and your network bandwidth will affect the time it takes to publish.

9. You see the Service Publishing Result message window that says your map service has been published successfully. Click OK to close the message window.
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3.5 Explore your service using Services Directory

“Where is my service? What does it look like? Is it working correctly?” You may be asking such questions after publishing your map service.

You can answer these questions using ArcGIS for Server Services Directory, ArcGIS Server Manager, or ArcCatalog. Here, you will use Services Directory.

1. Determine your Services Directory web address.

It is helpful to remember this URL pattern: http://<server name>:<port_number>/<instance name>/rest/services. You will use this to open the Services Directory for a given GIS server. The <instance name> in the typical ArcGIS for Server installation is arcgis.

If your server is myserver.myorg.com, the URL typically is http://myserver.myorg.com/arcgis/rest/services or http://myserver.esri.com:6080/arcgis/rest/services. Contact your instructor or system administrator if you are uncertain about the URL. Write the URL to your Services Directory here:



2. Start a web browser, and type the preceding URL to go to your Services Directory.

Alternatively, if you are on your server machine, go to Start > All Programs > ArcGIS > ArcGIS for Server > Services Directory.

The home page of your Services Directory appears, listing all the folders and services in the root directory.

3. If you specified a folder name when publishing your service, click the folder.
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The name of the service you published should appear, along with the MapServer service type. This confirms that your service has been published.

4. Click your map service.

[image: images]

5. The metadata page of your map service appears, displaying the following links and information:



• View In: Use these links to preview your map service and test whether your service works. You will try them in steps 6 through 8.

• Layers: names of the layers in the map service.

• Spatial Reference: 102100 confirms that your map service is in Web Mercator. Another often-used spatial reference is 4326, which is Geographic Coordinate System in WGS1984.

• Time Info: this confirms that your map service has been time enabled.

• Supported Operations, including Export Map, Identify, and Find: these are what your web clients can ask your map service to perform.
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[image: images]    Note: The URL of this page—http://esrimapbook.esri.com/arcgis/rest/services/GTKWebGIS/natural_disasters/MapServer—is the REST (Representational State Transfer), a popular type of web service interface, endpoint of your map service. This is the URL you use in various web clients to call this service. It is important to remember this URL pattern. Write the address for your map service REST endpoint here:



6. In the View In links, click the ArcGIS JavaScript link. Your map service is displayed in a new window or tab. Zoom in and out of your map.
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This confirms that your map service is not only published but also working.
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7. Go back to your map service page, look for the View In links, and click the ArcGIS.com Map link.

Your map service displays in the ArcGIS Online map viewer. If the service overlays correctly on the ArcGIS Online basemap, it means the coordinate system of your data and map service is correct.

If your map service is time enabled, a time slider should appear below the map. Click the Play button to see the temporal patterns of the earthquakes and hurricanes. You will learn how to configure the time slider in section 3.6.
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8. Go back to the map service page. Among the View In links, click the ArcMap, Google Earth, and ArcGIS Explorer links to view your map service in ArcMap, Google Earth, and ArcGIS Explorer (if you have them installed on your computer), respectively.

9. On your map service page, click the earthquakes layer.
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The metadata page of this layer appears. This page lists the following information:

• Geometry Type tells you it is a point layer.

• Time Info confirms whether the layer has been time enabled.

• Drawing Info lists the layer’s symbology.

• Fields is the attributes exposed from this layer and the types of fields.

• Supported Operations, including Query, tells what operations web clients can ask your layer to do.
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[image: images]    Note: The URL of this page (e.g., http://myserver.esri.com/arcgis/rest/services/pinde/natural_disasters/MapServer/0) is the layer’s REST endpoint. It essentially appends a number to the end of your map service URL. This number starts with 0 for the first layer, 1 for the second layer, and so on.

Use this URL when using this layer with various web clients. Remember this pattern. Write the URL for this layer in your map service here:



10. Click your web browser’s back button to go back to your map service page.

Alternatively, in the navigation links at the top of the page, click your map server’s name.
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11. On your map service page, click the hurricanes layer. Review the layer’s metadata page (similar to step 9).

In this section, you explored your map service using ArcGIS Services Directory and confirmed that your map service is published, running, in the correct coordinate system, and time enabled.

You can do more with the Services Directory. Later, you will learn how it can help you understand and explore the REST API (application programming interface) for use with your JavaScript and mobile clients.

3.6 Add a map service to a web map and configure time

1. In a web browser, navigate to ArcGIS Online (arcgis.com or your organization’s URL) or your Portal for ArcGIS, log in, and go to the map viewer.

2. On the map viewer menu bar, click Add [image: images] and then click Add Layer from Web.
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3. In the Add Layer from Web dialog box, specify the URL of your map service and then click Add Layer.



[image: images] Tip:

• Instead of manually typing the URL, go to your map service page in the Services Directory, copy the URL from the address bar, and then paste it in the URL box.
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Your map service displays in the ArcGIS Online map viewer. This is similar to the view that appeared when you clicked the View In ArcGIS.com Map link in section 3.5.

4. In the TOC list, click the natural disasters layer to expand its sublayers. Click the down arrow [image: images] next to the earthquakes layer and click Enable Pop-up on the menu.
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This enables pop-up windows in the earthquakes layer. If you click an earthquake on the map, the default pop-up window appears.

5. Configure the pop-up window to enhance it using the skills you learned in chapter 2.

6. Repeat steps 4 and 5 to enable and configure the pop-up windows in the hurricanes layer.

7. On the menu bar, click Save > Save.

8. In the Save Map dialog box, enter the title, tags, and summary of your web map and then click Save Map.
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ArcGIS Online recognizes that your map service is time enabled so it displays a time slider bar. This allows you to configure the time animation playback speed, time span, time window, and slider labels.

9. To the right of the slider, click the Time Settings button [image: images].
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10. In the Time Settings dialog box, click Show advanced options.
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11. In the Time Settings dialog box, under Time Display, set display data in 6 Month intervals. Click OK to close the Time Settings dialog box.
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Leave As time passes as only display the data in the current time interval selected. The other option, progressively display all the data, can also be useful in some situations.

12. On the Time Slider, click the Play button to test whether the settings play back correctly.

13. On the menu bar, click Save to save your work.

You have used your map service to create a web map and configure its time properties. Now you are ready to use this map to build a web app.

3.7 Build a time animation web app

You learned how to create a web app using ArcGIS Online templates in chapters 1 and 2. Therefore, this chapter does not contain as much detail. If questions arise, refer to those chapters.

1. While your map viewer and web map are open, on the map viewer menu bar click the Share button [image: images].

2. In the Share dialog box, share your web map with everyone (public) or with only certain groups to which you belong.

3. Click Make a Web Application.

This brings up the ArcGIS Online app templates. You can choose any of the templates to display a web map with map services. However, if you want to show time animation, choose only the templates that support time animation, such as the Basic Viewer and Time Aware templates. This tutorial uses the Basic Viewer template.

4. In the Templates gallery, find the Basic Viewer template. Click Publish > Preview.

The web app looks like the following graphic. It has a Time button that you can use to turn the Display Time Slider on and off.

[image: images]

5. Click the Play button in the Time Slider window to see the animation.

6. Close the Preview window when you are done.

7. In the Templates gallery, find the Basic Viewer template again, click the Publish button, and click Publish.

8. In the Share dialog box, fill in the appropriate Title, Tags, and Summary information of your application, click Save & Publish, and then click Close to close the Share dialog box.
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9. Click View Item to open the details page of your new web app.

10. Optionally, click the Edit button [image: images] to update the item details, or click the Configure App button [image: images] to configure your app.

11. On the Item Details menu, click the Share button [image: images]. Share your application using the same choices you made for your web app.

Open your web app to view it.

12. Open your web app by clicking the thumbnail image, or click Open > View Application.

13. Send the URL of this page to your instructor and others so they can use your application.

By default, your web app displays all the earthquakes and hurricanes in your data, and users will see the overall spatial patterns of these disasters. When they click the Time button on the toolbar, the Display Time Slider window appears. When they click the Play button, the temporal patterns of these disasters unfold. Hurricanes occur mostly in the South and on the East Coast of the United States, for example, and mostly in the second half of the year. Thus, the slider reveals a pattern that you could not otherwise easily see.

QUESTIONS AND ANSWERS

1. Why project my data into Web Mercator? And how do I do it?

Answer: Unless your study area lies in the north or south polar regions, or faces some special requirements, your map service will most likely be displayed on top of other basemaps, such as those in ArcGIS Online. If so, you should project your data to Web Mercator first so that ArcGIS for Server will not have to project your data on the fly. This can improve the performance of both the map service and the web app.

In the ArcGIS Catalog window, expand Toolboxes > System Toolboxes > Data Management Tools.tbx > Projections and Transformations > Feature if you wish to project a vector layer or Raster if you wish to project a raster layer. Then double-click Project to open the Project dialog box.
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In the Project dialog box, specify the input and output feature classes. For Output Coordinate System, click Projected Coordinate Systems > World > WGS 1984 Web Mercator (auxiliary sphere). This is the type of Web Mercator coordinate system that most online maps use. Right-click it, and add it to your favorites to make it easier to find next time.

2. When displayed in the ArcGIS Online map viewer, my map appears on the west coast of Africa. This is not the correct location. What is wrong?

Answer: The coordinate system of the data layer is incorrect.

Your data is almost certainly in latitude, longitude (degrees). Either you are missing coordinate system information, or you have defined (not projected) the coordinate system as Web Mercator by mistake.

To correct this, open the ArcGIS Catalog window, find this data layer, right-click it, and click Properties. In the Properties dialog box that appears, click the XY Coordinate System tab, click Geographic Coordinate Systems > World > WGS 1984, and click OK. You can then correctly project this layer to Web Mercator. Now you can use this layer to create your map document, overwrite the previous service, or publish a new one.
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3. After I published my map service, I updated my map document. Will my map service update automatically?

Answer: No.

During the process of publishing a map service, ArcGIS for Server optimizes your MXD by converting it into an SD and then stores this SD file in its own workspace. From then on, your map service uses this SD file, rather than the MXD, and therefore cannot recognize the changes you made to your MXD file. Publish your MXD again as either a new service or an overwrite of the previous map service.

4. After I published my map service, I updated my GIS data. Will my updates be reflected in my map service automatically?

Answer: It depends.

By default, ArcGIS for Server makes a copy of your data and thus relies on this copy, so it cannot read any updates you have made to the original copy of your data.

If you registered a data store, make ArcGIS for Desktop and ArcGIS for Server share the same database. This way, your map service will be able to read your updates automatically (see chapter 4).

5. I added my map service (as a whole) to my web map. Why can’t I change the symbols in my earthquake and hurricane layers? Is there any way to work around this?

Answer: You can change symbols on feature layers only.

When you add the map service to your web map, you are using the map service approach. In this case, the map is drawn on the server side. Your browser simply receives a map picture from your GIS server and therefore cannot change the symbols.

To work around this, add individual layers of your map service to ArcGIS Online. In the map viewer, click Add > Add Layer from Web, and specify the URL for the layer (e.g., http://myserver.esri.com/arcgis/rest/services/pinde/natural_disasters/MapServer/1). In this case, you are using the feature layer approach, so now you can change the symbols of the layer.

6. One layer of my map service contains over a thousand layers. I tried to add this individual layer to my web map, but not all the features of this layer are displayed. Why?

Answer: You added your layer using the feature layer approach. To avoid loading too many features into your browser, ArcGIS for Server returns up to one thousand features by default. You can modify this limit in the service properties of the service as illustrated in the figure—but be careful, and do not return more features than your end users’ browsers can handle.

[image: images]

7. I created a web app using my own map service. However, I can view this web app only when I am using the computers at my university campus. Why?

Answer: ArcGIS for Server is installed on a private server at your university and is accessible only through the internal network.

If your GIS server is a public server and accessible via HTTP from the external network, your web app will work, whether you are on campus or at home.

8. Can I use my own custom basemaps in ArcGIS Online web maps and web apps?

Answer: Yes.

When you add your map service to ArcGIS Online, select the Use as Basemap check box.

[image: images]

ASSIGNMENTS

Choose one of the following two assignments. The first one provides you with the data to start with; the second one encourages you to use your own data.

Assignment 3A: Create a web app to animate the population change of main US cities.

Data: C:\EsrIPress\GTKWebGIS\Chapter3\US_Cities.gdb, a file geodatabase containing a US_Cities feature class. This layer presents the historic population of the one hundred most populated US cities between 1790 and 2000.

Requirements:

• Publish a time-enabled map service.

• Create a web app to animate population change in these cities.

What to submit: E-mail your instructor with the subject line Web GIS Assignment 3A: Your name, and include the following:

• The URL to your map service REST endpoint

• The URL to your web app



[image: images] Tips:

• There are no date fields in the attributes. However, you can use the YEAR field to enable time in the layer.

• To display the magnitude of population change clearly over time, use proportional symbols in the Population attribute field (illustrated in the following figure). This way, your end users will clearly see the symbol sizes of these cities increase or decrease over time.

[image: images]

Assignment 3B: Publish a map service, and use it in a web app.

This assignment has been left open intentionally. This gives you flexibility to use your own data.

Data: Use your own data (e.g., the data and maps that you used in a real project, in another GIS course, or that you downloaded somewhere).

Requirements:

• Publish a map service (this service does not have to be time enabled if no appropriate attribute field enables time).

• Create a web app based on this map service.

What to submit: E-mail your instructor with the subject line Web GIS Assignment 3B: Your name, and include the following:

• The URL to your map service REST endpoint

• The URL to your web app

Resources

ArcGIS for Server Help document site

“About Map Services,” http://resources.arcgis.com/en/help/main/10.2/index.html#/What_is_a_map_service/0154000002m7000000.

“A Quick Tour of Temporal Data Management and Visualization,”

http://resources.arcgis.com/en/help/main/10.2/index.html#/A_quick_tour_of_temporal_data_management_and_visualization/005z00000021000000.

ArcGIS for Server Functionality Matrix,

www.esri.com/library/brochures/pdfs/arcgis-server-functionality-matrix.pdf.

Esri Training website

“ArcGIS: Sharing Content on the Web (10.2)” (instructor led, fee required), http://training.esri.com/gateway/index.cfm?fa=catalog.courseDetail&CourseID=50130533_10.x.

Esri blogs

“Creating a Time-Enabled WMS with ArcGIS Server 10,” by Yingqi Tang. http://blogs.esri.com/esri/arcgis/2010/12/31/creating-a-time-enabled-wms-with-arcgis-server-10.

Esri videos

“Publishing and Using Map Services with ArcGIS for Server,” by Craig Williams, Tanu Hoque, and Ty Fitzpatrick. Technical workshop at Esri International Developer Summit, Palm Springs, CA, March 25–28, 2013. http://video.esri.com/watch/2378/publishing-and-using-map-services-with-arcgis-for-server.


Chapter 4

Cached map services and comparison web apps

This chapter teaches you how to use cached map services and a new type of ArcGIS Online web app template. Cached map services are displayed more quickly than dynamic map services and can handle huge amounts of data without losing performance speed. ArcGIS Online comparison web app templates—including side-by-side and swipe/spyglass templates—maximize the effectiveness of comparing multiple web maps or map layers. As you study the contents of this chapter, keep in mind that most of what you learn—whether it is data store registration or web service administration—can be applied to other types of ArcGIS web services as well. For example, you can apply the ArcGIS Online comparison templates to other types of map layers in addition to tiled map service layers.

Learning objectives

• Register a data store.

• Author a map for tiling.

• Publish cached map services.

• Use ArcGIS Online comparison web app templates.

• Administer web services.

This chapter in the big picture

[image: images]

ArcGIS offers many ways to build web applications. The thick red line in the figure highlights the technology chapter 4 teaches.

Cached map services: Why and when?

Map caching refers to the creation of a pregenerated series of map tile images at a range of map scales.

[image: images]

With a cache available, the web server can respond to a user’s request quickly by retrieving the preprocessed results from the cache. This reduces the pressure on both the GIS server and the database server.

The main benefits of map caching include:

• Performance: When caches or tiles are readily available, a web server can respond quickly to a client’s map requests by retrieving the corresponding tiles. This provides greater speed and scalability than dynamically generating a map each time a request is made.

• Scalability: Once map tiles have been generated, the load on the GIS and database servers decreases significantly at run time. Servers can accommodate a larger number of simultaneous users as a result.

• Cartographic quality: Caching allows designers to take the time necessary to design and produce high-quality maps in advance.

• User experience: End users will enjoy the faster response time and higher quality maps.

Map caching best fits:

• Basemaps: Basemap data layers do not change frequently. If not cached, these layers require intensive data reading and map rendering because of their large size and frequent use by all users.

• Operational layers that are relatively static and large.

• If your data size is small—say, less than a couple thousand points—use the feature layer approach. This streams the data to the web client side (i.e., web browsers), with the client assuming the map-drawing tasks.

• If data changes too frequently, you may not have enough time to regenerate the tiles with each data modification.

• When your operational layer is relatively static and large (i.e., not in the preceding two categories), use a tiled map service.

[image: images]    Notes:

• A tiled map service is not just a lot of pictures. It can support the same spatial and attribute queries that dynamic map services do—as long as its data and query capabilities have not been disabled and its data source is not deleted.

• Vector tiling offers a different but relevant technique. It extracts vector tiles—tiles of vector data such as geometries and attributes—and sends them to the client side, where maps are drawn and data cached for subsequent uses.

• Raster pyramids involve a technique similar to map caching but for raster datasets. They are a downsampled, or downscaled, version of the original raster dataset and can contain many downsampled layers. Pyramids can speed up the display of raster data by retrieving only the data, at a specified resolution, that is required for the display.

Tiling scheme

Before you create a tiled map service, you must choose its spatial reference, also called coordinate system, and tiling scheme.

• Coordinate system: Most of the time, use Web Mercator. This way, your map tiles will match the popular online maps, such as those available from ArcGIS Online, Google Maps, and Bing Maps. You can also choose other coordinate systems in case your study area lies close to the polar regions or you have other special requirements.

• Tiling scheme: This is defined by a number of properties:

• Levels of detail, the number of scale levels, and the scale of each level

• Tile dimension (e.g., 256 × 256 pixels)

• Tile origin

[image: images]

Map caching (left) generates a set of map tile images in advance at predetermined scale levels. The map caching scheme (right) includes the number of scale levels, the scale at each level, tile dimension, tile origin, tiling area, and image format.

Data store

The ArcGIS Data Store component of ArcGIS for Server applies to many types of web services, including dynamic map services, cached map services, feature services, and geoprocessing services. Chapter 3 briefly mentioned the data store concept. This chapter introduces it in more detail.

Data store registration offers ArcGIS for Server users a list of verified locations where their server can access the data they need to host their web services. Data store registration also helps ArcGIS for Server understand how to adjust the data paths in your map document when publishing it across machines.

Table 4.1 lists the four scenarios for data storage and how to register a data store for each scenario.

[image: images]    Note: ArcSDE, or Spatial Database Engine, is Esri technology for accessing and managing geospatial data within relational databases.

Table 4.1 Data store scenarios

[image: images]

Here are two examples:

• Example 1: (See scenario 1A in table 4.1.) A class of 20 students is studying the tutorial for this chapter. Each student has saved a copy of the tutorial data to his or her computer.

If these students are sharing the same ArcGIS Server, without a data store, when the students publish the tutorial map service ArcGIS for Server will copy the same tutorial data to the server 20 times—and thus store 20 copies.

To avoid this, the instructor can copy the tutorial data to the server (e.g., at D:\EsriPress\GTKWebGIS\Chapter4) and register a data store folder pointing to C:\EsriPress\GTKWebGIS\Chapter4 on the students’ computers and D:\EsriPress\GTKWebGIS\Chapter4 on the server.

Now, when the students publish their services, ArcGIS Server will replace the data reference C:\EsriPress\GTKWebGIS\Chapter4 in the map documents (MXDs) with D:\EsriPress\GTKWebGIS\Chapter4. This way, ArcGIS for Server can find data in D:\EsriPress\GTKWebGIS\Chapter4 on the server without making additional copies of the tutorial data.

• Example 2: (See scenario 2B in table 4.1.) A publisher would like to produce a map service using ArcSDE data layers. She needs to update the data layers when needed, and she would like her updates to be reflected automatically in her map service.

She can register a shared database data store so that her ArcGIS for Desktop and ArcGIS for Server both use the same ArcSDE database.

Planning a map cache

Planning a map cache requires the following considerations:

• Choose the right tiling scheme, especially for the largest scale. The larger the scale, the greater the number of tiles generated. For example, caching the entire continental United States at 1:1000 could take weeks and would require hundreds of gigabytes of storage.

• Design a map document that is both readable and useful at all scales cached. Take time to make your map look good because once you have created the cache, you will not be able to make changes without re-creating or updating the cache. Use group layers and scale dependency to design your map for each scale. Show fewer details and use generalized layers at smaller scales while showing more details and using larger symbols at larger scales. You can start by downloading some well-designed map document templates at ArcGIS Resource Center.

• Anticipate cache creation time. For larger caches, it is best to schedule cache creation for nighttime or over a weekend.

• Think about deployment. For large caches, you may want to first generate the tiles on your development or staging server and then deploy the tiles to your product server. Use the compact storage format rather than the exploded format. A compact format stores many tiles together in a bundle file. An exploded format stores each tile individually, which takes longer to copy to the server.

Comparison of ArcGIS Online app templates

ArcGIS Online provides several templates for comparing multiple maps, detecting changes, and studying relationships. You will be using these templates in this tutorial.

• Swipe template: Allows the user to compare two layers in a web map, or two web maps, using a vertical bar or a spyglass. Following are some examples:

• http://storymaps.esri.com/stories/LandsatCompare

• http://storymaps.esri.com/stories/diabetes

• http://storymaps.esri.com/stories/doctors

[image: images]

Swipe template showing spyglass mode in a desktop browser and swipe mode on a mobile phone.

• Side-by-side template: Can display up to three web maps side by side. For example:

• www.arcgis.com/apps/Compare/Multiviewer/index.html?appid=ee5e2c9efc25477f86efd3a2c7be0ca6
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Side-by-side template used for desktop browsers.

[image: images]

Side-by-side template used for smartphones.

This tutorial

In this tutorial, you will learn to create a web GIS app that compares the spatial patterns of California’s topography with the patterns of forest sampling measurements in the state.

Data: You are provided with a file geodatabase containing:

• A feature class of forest sampling sites in California

• A raster layer showing the volume expansion factor for forest land and timberland in California

• An MXD displaying these two layers

Requirements:

• Your web app should have fast performance.

• Users should be able to compare the topography pattern of California with the pattern of the statewide forest sampling and volume expansion factor.

System requirements:

• ArcGIS for Desktop: to design the map.

• ArcGIS for Server: to publish the tiled map service.

• ArcGIS Online: If you wish to publish the service to ArcGIS for Server, you will need only a public account for creating your web map and web app. If you want to publish the service to ArcGIS Online as a hosted service, you will need a publisher account.

4.1 Configure a data store

The skills learned in this section apply to cached map services but can also be applied to other kinds of ArcGIS for Server web services.

[image: images]    Notes:

• This section is optional. If you do not want to register a data store, you can skip this section.

• In a classroom setting where many students share a single ArcGIS for Server account, the instructor should complete this section and demonstrate this section to the class.

• You can register data stores using either ArcCatalog or ArcGIS for Server Manager (http://servername/arcgis/manager). This tutorial uses ArcCatalog.

1. Start ArcMap. In the Catalog window, navigate to C:\EsriPress\GTKWebGIS\Chapter4. You see a file geodatabase that contains three layers (California_State, Sample_Plots, and Volume_Expansion_Factor) and an MXD (FIA_Samples.mxd).

[image: images]

2. Copy the file folder C:\EsriPress\GTKWebGIS\Chapter4\data.gdb to your ArcGIS for Server (D:\EsriPress\GTKWebGIS\Chapter4\data.gdb).

[image: images]    Note: if your ArcGIS Server and ArcMap are on the same computer, you do not need to copy the data.

3. In the ArcMap Catalog window, click GIS Servers. Look for the connection to your ArcGIS Server, and double-click it to connect. Right-click your server and then click Server Properties.

[image: images]

4. In the ArcGIS Server Properties dialog box, click the Data Store tab. In the Registered Folders section, click the Plus button [image: images].
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Your data is stored in a file geodatabase, so you should use a folder-based store.

5. In the Register Folder dialog box, perform the following:

• For Name, specify Sample Data for Chapter 4.

• For Publisher folder path, specify the path to the data as it appears to your computer, which is C:\EsriPress\GTKWebGIS\Chapter4.

• For Server folder path, specify the folder path as it appears to your server, such as D:\EsrIPress\GTKWebGIS\Chapter4. Alternatively, select the Same as publisher folder path check box if it is also C:\EsriPress\GTKWebGIS\Chapter4 on the server.

• Click OK.
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ArcGIS for Server validates the folders and then closes the Register Folder dialog box. See that the folder name you just registered is listed in the Registered Folders box.

6. Click OK to close the ArcGIS Server Properties dialog box.

[image: images]

With the sample data folder registered, ArcGIS for Server will not recopy the data to the server when you publish the map service in section 4.3 of this chapter.

4.2 Author a map for tiling

This book does not focus on map design, so this section does not offer map design details. Instead, it explains the configurations that are important for map caching.

1. In the ArcMap Catalog window, navigate to C:\EsriPress\GTKWebGIS\Chapter4. Open FIA_Samples.mxd by double-clicking it or dragging it to the map canvas.

2. Right-click the data frame name—Layers, by default—and click Properties.
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Alternatively, double-click the data frame name. The Data Frame Properties dialog box opens.

3. Verify that your map is in Web Mercator.

In the Data Frame Properties dialog box, click the Coordinate System tab. Verify that the current coordinate system of the map is WKID: 3857 Authority: EPSG. Here, EPSG stands for European Petroleum Survey Group. The coordinate system defines the WKIDs (well-known IDs) of a comprehensive set of coordinate systems. There are several Web Mercator coordinate systems. The one with WKID 3857 is Web Mercator auxiliary sphere, which is the one that ArcGIS Online, Google Maps, and Bing Maps use.

[image: images]

If your map is not in Web Mercator, change it by selecting Projected Coordinate Systems > World > WGS 1984 Web Mercator (auxiliary sphere).

4. Click OK to close the Data Frame Properties dialog box.

5. Set up ArcMap to display only at the scales you plan to use. This will make it easier for you to design maps and examine them at these scales.

• On the ArcMap Standard toolbar, click the Map Scale arrow for a drop-down list of scales and click Customize This List.

• In the Scale Settings dialog box, click the Load button and click ArcGIS Online/Bing Maps/Google Maps.

• Select the check box for Only display these scales when zooming.

• Click OK to apply your changes.
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The set of scales listed in the scales drop-down list has been updated. This will make it easier to switch between scales.

Now you can design your map. Because this book does not focus on map design, you will publish the tiled map service using the simple MXD provided.

This MXD uses scale dependency and group layers. For example, the Sample Plots layer has been duplicated for different scale ranges, and different symbols have been defined for different scales (e.g., large scales use larger symbols and labels).

To define a layer’s scale dependency, simply double-click the layer in the ArcMap table of contents to open the Layer Properties dialog box. On the General tab in the Scale Range section, specify both the Out beyond and In beyond scales.
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6. If you made any changes to the MXD, click Save to save your map document.

Keep your map document open if you are going directly to the next section.

4.3 Publish a tiled map service

The first half of publishing a tiled map service is the same as publishing a dynamic map service, which you learned in the last chapter. Therefore, the explanation here will be brief. Refer to chapter 3 if you need detailed instructions.

1. While you have FIA_Samples.mxd open, click File > Share As > Service.

Alternatively, you can browse to the MXD in the Catalog window, right-click the MXD, and click Share as Service.

2. In the Share as Service dialog box, click Publish a service and click Next.

3. From the Choose a connection drop-down list, click the ArcGIS Server connection you previously created, specify a service name (e.g., FIA_Samples_Tile), and click Next.

In a classroom setting where many students share one ArcGIS Server, do not forget to make the service name unique. For example, try appending your name to the service name.

If you are publishing this server to ArcGIS Online for Organizations, be aware of the number of credits it is going to use.

4. Select Use existing folder, click your folder name, and click Continue.

5. At the top of the Service Editor window, click the Analyze button [image: images].

Your Prepare window should look like the figure.
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6. In the Prepare window, note the following:

• There are no error messages.

• You do not see the warning “Data source is not registered with the server and data will be copied to the server”. You saw this warning in chapter 3 because no data store had been registered. In this tutorial, ArcGIS for Server will not need additional copies of your data because you have registered a data store.

• You do not see the warning “Missing Summary in Item Description”. You saw that in the last chapter. The reason is that you have defined a summary in your map document. This summary will carry over to your map service.

7. Double-click the “Missing Tags in Item Description” warning. Then, on the Item Description page, fill in such tags as FIA, Forest Inventory, Getting to Know Web GIS.

• Ignore the “Layer draws at all scale ranges” message in the Prepare window.
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8. In the Service Editor window, click the Parameters link, and set the Anti-Aliasing level to Fastest.

Anti-aliasing can make maps appear smoother and of better quality. As a rule, you should turn it on when publishing cached map services. However, anti-aliasing can also greatly increase the time required to build a service’s cache. Choose the Fastest level so that you can finish the tutorial quickly. Select a better anti-aliasing quality level later, for an actual project.
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9. In the Service Editor window, perform the following:

• Click the Caching link on the left.

• For Draw this map service, select Using tiles from a cache.

• For Tiling Scheme, click ArcGIS Online/Bing Maps/Google Maps. If you wanted to use your own tiling scheme, you could use the ArcGIS Generate Map Server Cache Tiling Scheme tool to make your own tiling scheme file, select A tiling scheme file from this drop-down list, and then choose your scheme file.

• For Levels of Detail, enter 5 to 11. Note the Estimated Cache Size is 38 MB. This will not take long to complete. Optionally, click Calculate Cache Size to check the estimated size of each scale level. If you select too many levels, it may take a long time to generate the tiles.

• Leave the check box checked for Build cache automatically when the service is published. For larger caches, it may help to build the cache manually at night or over the weekend.
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10. Remaining in the Service Editor window, perform the following:

• Under the Caching link, click the Advanced Settings link.

• Note the Cache directory, c:\arcgisserver\directories\arcgiscache, is on the server by default. This is where to find the tiles if you want to see them.

• For Area of interest to cache, click Import from a feature class, and then click the California_State feature class in C:\EsriPress\GTKWebGIS\Chapter4\data.gdb.

This way, you will not have to create tiles for oceans and other areas beyond the landmass of California.



• For Tile Format, click MIXED. The available options are JPEG, PNG, PNG8, PNG24, PNG32, and MIXED.

PNGs support transparent overlay; JPEGs do not. JPEGs are especially suited for basemap services, which typically exhibit a large color variation and therefore do not need transparency. The MIXED format uses JPEG in the middle of the cache area and PNG32 on its periphery to create a transparent overlay.



• Leave the Compression setting at 75.

A setting of 0 indicates the poorest quality and highest compression; a setting of 100 denotes the best quality and lowest compression. Vector maps often need a higher quality setting in order to reduce the fuzziness that may appear along the edges of shapes and labels. Such a setting also affects tiling speed because higher quality maps take more time to create.



• Click the Advanced button to open the Advanced Cache Settings window.
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11. In the Advanced Cache Settings dialog box, notice that Tile Height & Width is set at 256 × 256 and Storage Format at Compact, which is created more quickly than the Exploded format. Click OK to close the dialog box.
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12. Optionally, at the top of the Service Editor window, click the Preview button [image: images] to preview your map.

13. Click the Publish button [image: images] to publish the service.

ArcGIS for Server will now begin to create the tiles. Depending on the cache settings (particularly the largest scales to cache), the server hardware, the workload on the server, and other factors, it can take days, or even longer, to generate all the tiles of a service. For this tutorial, the tiles are small, so the process will not take long.



14. In the ArcMap Catalog window, expand GIS Servers, and expand your ArcGIS Server connection. To see what percentage of the tiles have been completed, right-click the tiled map service you just published and click View Cache Status.
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15. Click Refresh Status to request an updated report from the server. You can also click the Show details button to see the job status and the cache status for each scale level.
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[image: images]    Note: In the summary, where it says 79.5% of the tiles are present, the percentage reported indicates the proportion of the full map extent, not the area of interest. Because a feature class was used to mask the tiling job in this tutorial, the cache ended at about 79.5% instead of 100%.

Pay attention to the Status message. Here, it says, “Tile generation is not in progress.” This means the caching has been completed.

16. Click Close to close the Cache Status window.

4.4 Check the tiles and test your service

In this section, verify the tiled map service by examining the folders that store the tile images and exploring ArcGIS Services Directory.

1. On your ArcGIS Server, start Windows Explorer, and navigate to C:\arcgisserver\directories\arcgiscache, the default ArcGIS Server cache folder.

2. Navigate to your service subfolder.

This folder name follows a pattern such as <your_service folder>_<your_service name> (e.g., pinde_FIA_Samples_Tile).

3. Go down to the Layers\_alllayers folder. Notice the subfolders of all the cache levels.
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4. Navigate to the Layers\_alllayers folder.

[image: images]

Notice the .bundle files. They are there because, in section 4.3, you selected the Compact storage format. One .bundle file contains many tiles. If you had chosen the Exploded storage format, you would see individual tile images instead. (The .bundlx files in the figure are indexes of bundle files.)

5. Open a web browser, and navigate to the Services Directory of your ArcGIS Server.

The URL looks something like http://your_server_name/arcgis/rest/services or http://your_server_name:6080/arcgis/rest/services.

6. On the home page of the Services Directory, click the specified folder, if you specified one when publishing the service.

7. Locate the tiled map service you just published and click it.
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8. On your tiled map service page, note the following:



• Spatial Reference: 102100 (3857) confirms your map service is in Web Mercator.

• Tile Info confirms that your map service is tiled. The Levels of Detail is reported as 20, the same as that of ArcGIS Online.

• Supported operations, including Identify and Find, confirm that your tiled map service can still support spatial and attribute queries and that it does not just consist of tiles.
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The URL of this page marks the REST endpoint of your map service. You will use it in section 4.5.

9. In the View In links, click the ArcGIS JavaScript link or the ArcGIS.com Map link.

Your map service appears. Pan and zoom on the map to see whether the map tiles fill in quickly. This service should perform more quickly than a dynamic map service.

4.5 Create a side-by-side comparison web app

In this section, create two web maps and use them to create a side-by-side web app using an ArcGIS Online template. This app will compare the spatial patterns of California’s topography with that of forest sampling sites and corresponding volume expansion factors.

To keep the tutorial simple, the first web map contains only the topographic basemap.

1. In a web browser, navigate to ArcGIS Online (arcgis.com or your organization’s URL) and log in. Then navigate to the map viewer.

2. Click Basemap and then click Topographic.
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3. Click Save > Save. In the Save Map dialog box, perform the following:

• For Title, specify Topography.

• For Tags, specify Topography, Web GIS tutorial.

• For Summary, specify Topography.

• Click Save Map.
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4. On the map viewer menu bar, click the Share button [image: images] to share your web map with everyone or certain groups or organizations and then close the Share dialog box.

You have created a web map. Now create another one.

5. On the menu bar, click Add > Add Layer from Web.

6. In the Add Layer from Web window, specify the URL of the tiled map service and click Add Layer.
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7. Optionally, you can expand the Sample_Plots group layer and enable and configure pop-up windows for each of the sublayers.
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8. On the menu bar, click Save > Save As (not Save). In the Save Map dialog box, perform the following:

• For Title, specify FIA Samples.

• For Tags, specify FIA, Forest Inventory, Web GIS Tutorial.

• For Summary, specify FIA Samples.

• Click Save Map.

[image: images]

9. On the menu bar, click Share. Share your web map with everyone or just certain groups or organizations and then click Make a Web Application.

10. In the templates gallery, find the Storytelling Compare template, and click Publish > Preview.

A web page appears. It displays three panels, each of which includes your web map. You can synchronize them by scale and location. Changing the map extent in one panel changes the extent in the others.
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Use this template in steps 11 through 21 to create a web app and then configure it to display the two web maps you just created.

11. Go back to the templates gallery. Under the Storytelling Compare template, click Publish > Publish.
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12. For the web app title, specify FIA Samples vs. Topography and then click Save & Publish.

13. Click View Item to open the new app’s details page.

14. On the details page, click Configure App.

15. In the configuration mode, specify the application title as Compare FIA Samples with Topography. Specify the subtitle as Web GIS Tutorial.
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The Add Webmaps section contains a text box in which you can specify up to three web map IDs. It has already obtained the ID of the web map with the tiled map service. Next, find the ID of the topography web map you just created.

16. On a new tab of your web browser, navigate to the ArcGIS Online My Content page, find the Topography web map, and click it to view its details.

[image: images]

17. On the item details page, copy the item ID from the URL in the address bar.

[image: images]

For example, if the URL of an item’s details page is http://www.arcgis.com/home/item.html?id=4282e3e681a74653be9eb6e5409e5cca, the item ID is 4282e3e681a74653be9eb6e5409e5cca.

18. Go back to your web app configuration page. In the Webmap IDs text box, type a comma, paste the ID you just copied, and then click Save.

[image: images]

The two web maps are displayed side by side on the left side of the page.

19. Click the browser’s back button to return to the details page of this web app.

20. Go to the Item Details menu and click Share. Share this web app with everyone or with certain groups or organizations.

21. Open your web app so that you can compare the two web maps.

[image: images]

Notice that the FIA Samples map layer performs quickly when viewed at map zoom and pan. This is a result of using the tiled map service.

Here, the two maps synchronize by both scale and location. As you zoom and pan in one web map, the other map follows. This makes map comparison simple.

By comparing the FIA samples map with the topography map, you can detect more sampling sites in the mountains than in the lower elevations. Still, there are many sampling sites in the Mojave Desert. The volume expansion factor is larger for higher elevations.

To make the tutorial easy to learn and quick to complete, you used a web map containing only a basemap layer in the comparison. Using other, more relevant layers, such as land cover, precipitation, and temperature, you can create a web map to make more meaningful comparisons.

4.6 Administer your web services

This section is not required for you to publish the map service and create your web app, but it is good for you to know how to start, stop, restart, and delete your service and examine the ArcGIS for Server logs. This is especially true when you are debugging or troubleshooting your services. You can stop, start, restart, and delete your map services using either ArcGIS for Desktop or the ArcGIS Server Manager application and examine the ArcGIS for Server logs using the manager.

1. To start, stop, restart, or delete your services in the ArcMap Catalog window:

• Click GIS Servers.

• Click your ArcGIS for Server connection.

• Click your folder (if applicable).

• Find your map service.

• Right-click your service. You see the options to stop, start, restart, or delete your map service.

[image: images]

2. To start, stop, or delete your services in Server Manager:

• Start a web browser, and navigate to your server manager (the URL pattern is http://yourServerName:6080/arcgis/manager, or http://yourServerName/arcgis/manager).

• Log in with an ArcGIS for Server administrator or publisher account.

• At the top, click Services.

• On the main menu bar, click the Manage Services button.

• On the left side of the page, locate your folder and click it (if applicable).

• On the right side of the page, find your service, and click Stop, Start, or Delete to stop, start, or delete the service.
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3. To examine the log files of your ArcGIS Server:

• While you are logged in to ArcGIS Server Manager, near the upper-right corner of the page, click the Logs button.

• Filter the logs by log level and age.

• Click the Query button to retrieve and read the logs in the window below it.

[image: images]

By default, the log level is set at the Warning level. In case you need a detailed log to help you debug your server problems, click the Settings button and set the log level to Fine, Verbose, or Debug. Be aware, these detailed log levels will slow down your server performance. Remember afterward to change the log level back to Warning or another appropriate level.

QUESTIONS AND ANSWERS

1. My ArcGIS Desktop and my ArcGIS Server are on the same computer. Do I still need to register a data store?

Answer: The user account ArcGIS for Server runs on is different from the user account running ArcGIS for Desktop. These two user accounts may have different permissions when accessing data. If you do not register a data store, ArcGIS for Server will still make a copy of your data to ensure its own access, even when your ArcGIS Desktop and ArcGIS Server are on the same computer. If you do not like this, register a data store.

2. Can you tile a time-enabled dynamic map service? I would like to tile the time-enabled map service I published in chapter 3 and hope to see better performance.

Answer: You should not tile time-enabled dynamic map services. If tiled, the time-enabled map services will lose the time animation effect in the web app you built with ArcGIS Online templates.

3. I created my tiles on my development ArcGIS Server. How do I deploy these tiles to my production ArcGIS Server?

Answer: Copy the cache from your development server to your production server. The production server should have a map service with the same name. When the service restarts, it will detect the cache you copied. Make sure you copy the cache to the correct folder on your server. The default folder is c:\arcgisserver\directories\arcgiscache\<map service name> or c:\arcgisserver\directories\arcgiscache\<folder name>_<map service name> on a Windows-based server.

4. My data is updated. How do I update the tiles?

Answer: In the ArcMap Catalog window, click Toolboxes > System Toolboxes > Caching > Manage Map Server Cache Tiles. This tool can update your cache for the set of scale levels you specify or update the cache that falls within the boundaries of a feature class.

If your source data tends to change, you can use a Python script to run the Manage Map Server Cache Tiles geoprocessing tool automatically on a regular basis. See “Automating Cache Creation and Updates with Geoprocessing” in ArcGIS Help for an example of how this works.

5. How do I display a “Data not available” tile for areas or scales that have no tiles?

Answer: You can configure a “Data not available” tile by placing a missing.png, missing.jpg, or blank.png image at the root level of your cache. The server defaults to this image if a tile cannot be found in the cache. Here are the steps:

• Create or download an image of the same dimensions as the tile in your tiling scheme. Name it missing.png or missing.jpg. You can download such images at Esri Knowledge Base, article number 36939.

• Save the image under the _alllayers folder of your map service cache folder—for example, C:\arcgisserver\arcgiscache\MyFolder_MyMapService\Layers\_alllayers\missing.png.

ASSIGNMENTS

Choose one of the following two assignments.



Assignment 4A: Create a web app that compares the spatial patterns of owner-occupied housing units with population density in the United States.

Data: The following data can be found at C:\EsriPress\GTKWebGIS\Chapter4:

• US states and counties with housing, households, race, and age attributes in Assignment.gdb

• Perc_HsUnits_By_Owner.mxd, showing the percentage of housing units that were occupied by their owners in 2010

• Population_Density.mxd, showing the population per square mile in 2010

Requirements:

• Set appropriate scale dependencies for the state layer and the county layer so that the state layer is visible at smaller scales and the county layer is visible at larger scales.

• Publish two map services, at least one of them tiled.

› Do not tile too many scale levels. Keep the estimated cache size under 100M.

› Use the US_Boundaries feature class to mask your tile area.

• Create a web app using the side-by-side or swipe template.

• Use your web app to compare the two web maps. Examine relationships between the spatial patterns of population density and the percentage of owner-occupied housing units.

What to submit: E-mail your instructor with the subject line Web GIS Assignment 4A: Your name, and include the following:

• The URL to your map services

• The URL to your web app

[image: images] Tips:

• As an in-class learning experience, the instructor can ask two students to work as a team but publish their own map services, having each student publish a map service and then have them create a web app that uses both their services.

• The data contains other attribute fields. Create a web map that compares the spatial patterns in other attribute fields.



Assignment 4B: Create a side-by-side web map that compares the performance of a dynamic map service with that of a tiled map service.

Data: use the tutorial data provided for this chapter or for the preceding assignment 4A.

What to submit: E-mail your instructor with the subject line Web GIS Assignment 4B: Your name, and include the following:

• The URL to your tiled map service REST endpoint

• The URL to your web app

[image: images] Tips:

• Publish a dynamic map service, add it to the ArcGIS Online map viewer (as a set of basemap layers), and create a web map.

• Publish a tiled map service, add it to the ArcGIS Online map viewer (as a set of basemap layers), and create another web map.

• Create a side-by-side web app using these two web maps.

• Pan and zoom in one map to see that the other map does the same. Note the difference in their performance.

Resources

ArcGIS for Server Help document site

“An Overview of the Caching Toolset,” http://resources.arcgis.com/en/help/main/10.2/index.html#/An_overview_of_the_Caching_toolset/005400000003000000.

“Automating Cache Creation and Updates with Geoprocessing,” http://resources.arcgis.com/en/help/main/10.2/index.html#//0154000002qs000000.

Data store registration, http://resources.arcgis.com/en/help/main/10.2/index.html#/About_registering_your_data_with_the_server/015400000505000000.

Map caching, http://resources.arcgis.com/en/help/main/10.2/index.html#/What_is_map_caching/01540000048q000000.

Map caching properties, http://resources.arcgis.com/en/help/main/10.2/index.html#/Available_map_cache_properties/015400000414000000.

Esri publications

“Compare Two Web Maps, Side by Side,” www.esri.com/esri-news/arcwatch/0613/compare-two-web-maps-side-by-side.

Esri videos

“Designing and Using Cached Map Services,” by Sterling Quinn. 2012 Esri International User Conference, San Diego, CA, July 23–27. http://video.esri.com/watch/1680/designing-and-using-cached-map-services.

“Map Caching in ArcGIS for Server,” by Sterling Quinn and Tom Brenneman. 2013 Esri International Developer Summit, Palm Springs, CA, March 25–28. http://video.arcgis.com/watch/2322/map-caching-in-arcgis-for-server.

Esri Support website

Esri Knowledge Base. “How To: Configure the Cache Folder to Display a ‘Data Not Available’ Tile for Empty Map Cache Areas or Missing Tiles.” http://support.esri.com/en/knowledgebase/techarticles/detail/36939Part number (type over existing text).

Github

Swipe map storytelling template, https://github.com/Esri/swipe-map-storytelling-template-js.




Chapter 5

Feature services and volunteered geographic information

In this chapter, you will learn a new type of web service called feature services. Map services are read-only—that is, you can ask map services to generate maps and perform queries, but your web clients cannot edit the data behind the map services. Feature services support both read and write functionality. Not only can you visualize a feature service, but you can also update the service’s underlying multiuser geodatabase, including adding, removing, and updating both geometries and attributes. Feature services are especially useful for collecting volunteered geographic information (VGI), sharing editing workflows with web users, and supporting various lines of business.

Learning objectives

• Publish hosted feature services using the ArcGIS Online for Organizations service.

• Define feature templates.

• Create web apps with editing capabilities.

• Understand VGI and its applications.

This chapter in the big picture

[image: images]

ArcGIS offers many ways to build web applications. The thick red line in the figure highlights the technology chapter 5 teaches.

VGI and web editing

VGI is digital spatial data produced voluntarily by citizens rather than formally by individual or institutional data producers. It takes many forms: the places marked on WikiMapia, the georeferenced tweets collected by Twitter, the georeferenced photos uploaded to Flickr, the highway traffic information collected by Waze, and more.

VGI marks a research frontier of significant practical value. With the help of crowdsourcing, in which large numbers of citizens act as sensors, VGI can enhance early warning systems for natural disasters or real-time social event monitoring. The VGI business model is built on the opportunities exemplified in crowdsourcing. Waze, for example, acquired by Google in 2013, collects information about highway traffic, accidents, and police locations that are voluntarily contributed by its mobile users.

From a technical perspective, VGI essentially offers a form of web-based data editing, in which users can add, remove, and update geometries and attributes. The ArcGIS feature services support both VGI and web editing.

[image: images]    Note: Web editing in ArcGIS for Server was designed to support simple feature editing. For more complex editing operations such as topologies and geometric networks, ArcGIS for Desktop is the best option.

Feature services

[image: images]

Read-and-write access.

Feature services support both read and write access.

• Read access: web clients can query and retrieve feature geometries, attributes, and symbology so that features can be drawn on the client side.

• Write access: web clients can edit feature geometries and attributes and save edits to the server database.

Feature services are useful for developing web apps that can collect authoritative data and VGI. For example, using feature services,

• a utility company can have its personnel collect and edit data in the field,

• a city can invite citizens to report emergency and nonemergency incidents,

• a planning department can invite bus riders to propose locations for new bus stops and lines, and

• law enforcement can encourage citizens to report when they may have spotted crime suspects and where they have seen them and even to upload photos and videos of suspects.

Feature template

A feature service typically contains one or more feature templates, which you can define in ArcMap (if used to author the map document) or ArcGIS Online (for hosted feature services).
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The feature template for K–12 schools defines the types of schools that users can add.

A feature template defines the types of data items that users can add to a layer. A dataset that has two layers has two templates, one for each layer. A template serves two main purposes:

• It ensures data integrity. For example, a feature template for a layer that represents schools might allow editors to classify a new feature as an elementary, middle, or high school. In a school feature template, preset these three options so that users can choose only one of these three types of schools. This prevents users from entering invalid values for such an important attribute.

• It makes editing easier for your end users. A feature template can have preset symbol and default values for one or multiple fields. Preset symbols make it easier for users to know what type of feature they are using or adding. With the default attribute values, users do not have to type these values manually, which is particularly convenient for mobile users.

Publish feature services with ArcGIS for Server

When publishing a map service with ArcGIS for Server and activating the Enable feature access option, you automatically get two services, a feature service and a map service of the same name. The procedures to publish a feature service are very similar to those of a dynamic map service (see chapter 3), with only the following differences:

• Feature services require a multiuser database, such as an ArcSDE geodatabase or other databases with geometry support. You will need to do the following:

• Register your database in an ArcGIS for Server data store.

• Grant the ArcGIS Server user account read and write access to the data.

• Optionally, try using versioning in the geodatabase to isolate the data collected from the feature service from your authoritative data. Perform quality assurance/quality control (QA/QC) on the data you have collected before incorporating it into your enterprise data.

• When authoring your map:

• Add only the layers that will be edited, and make sure that they are from a single database.

• Design appropriate feature templates.

• Use simple symbology because the symbols will be drawn on the browser/client side, which do not necessarily support all the symbols that ArcMap supports.

• When publishing your service, in the Service Editor window under Capabilities, select the Feature Access check box.
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Select the Feature Access check box when publishing your service.

Publish feature services with ArcGIS Online for Organizations

You can publish a feature service to ArcGIS Online by using ArcMap or, even easier, by adding a CSV and a shapefile directly to ArcGIS Online. Once you have published your feature service, it uses the multiuser database provided by ArcGIS Online and hosted in the ArcGIS Online cloud.

You cannot publish dynamic map services using ArcGIS Online. However, if needed, you can publish a tiled map service and use it together with your feature service.

Editor tracking and ownership-based editing

Editor tracking refers to feature services that can track who has changed data and when. This information is stored in several attribute fields that are directly in the dataset. Editor tracking can help create more accountability and quality control over the data edited. In addition, it can support ownership-based access control, which allows you to limit access so that only the user who created a certain feature can access it.

If publishing to ArcGIS for Server, you can enable editor tracking for the feature class used in your feature service, and you can enable ownership-based editing with Service Editor. If publishing to ArcGIS Online, you can enable both editor tracking and ownership-based editing on the service’s item details page.

This tutorial

The City of Los Angeles would like to create a web app in which citizens can report nonemergency issues, such as potholes and graffiti, and the responsible city departments can respond appropriately. The web app should allow citizens to describe the issue and report the location, as well as attach photos, videos, or other documents to help city staff better understand the details.

Data: 311Incidents.csv, which contains attribute fields that reflect the kind of data the city would like to collect.

Requirements:

Your web map and app should allow citizens to do the following:

• Report events according to predefined categories of incidents/issues.

• Attach photos, videos, and other types of documents.

• Use on desktops and on smartphones.

System requirements:

• ArcGIS Online for Organizations

• Completion of the previous tutorials required an ArcGIS Online account, or at the very least an ArcGIS Online Public Account. To complete this chapter, you must have an ArcGIS Online for Organizations account, with publisher or administrator privileges.

5.1 Create an ArcGIS Online for Organizations publisher account

If you have a publisher account, skip this section, and go to section 5.2. If your organization has an ArcGIS Online subscription, ask your instructor or ArcGIS Online administrator to create a publisher account for you, and go to section 5.2. Otherwise, create a 60-day free trial account. To do so, follow steps 1 through 5:

1. Start a web browser, navigate to arcgis.com, and click Sign Up Now. Then click Try ArcGIS.
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2. Fill in your name and e-mail address and then click Start Trial.

[image: images]

You will see a page titled Confirmation email sent!

3. Check your e-mail for a message like the one in the screen capture. Click the URL in the e-mail to activate your ArcGIS free trial subscription.

[image: images]

4. On the activation page, fill in the fields, accept the terms and conditions, and click Create My Account.

[image: images]

Having created an ArcGIS Online for Organizations trial account, you have been made the administrator. You will be directed to the Setup Your Organization page. Make sure that your organization name differs from the names of other organizations already registered in ArcGIS Online. Your organization short name should also be unique because it will constitute the first part of the URL for your organizational trial version of ArcGIS Online.

5. On the Setup Your Organization page, fill in the fields. Then click the Save and Continue button [image: images].
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Your trial organization account has been created. As the administrator of a trial organization, you can publish your own feature services.

Optionally, you can invite other users, such as classmates or colleagues, to join your organization. Assign them as administrators or publishers so they can publish feature services without having to create their own ArcGIS trial accounts.

5.2 Prepare your data

You can publish hosted services using a variety of data formats. This tutorial uses CSV, the easiest one to work with.

[image: images]    Note: CSVs can store only point features. To publish a feature service of line or polygon feature types, use the shapefile or geodatabase data format. If you use shapefiles, compress them into a ZIP File, which will contain the .shp, .shx, .dbf, and .prj files, for the geometries, indexes, attributes, and projection information, respectively. If there are multiple shapefiles in the ZIP File, they will all be included in the feature service.

1. In Microsoft Excel, navigate to C:\EsriPress\GTKWebGIS\Chapter5\311Incidents.csv, and study its data fields.
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If you have existing point features to start with, you can put them in the CSV file in the format as illustrated. The incidents already in the sample CSV file are merely place holders, which you will delete once you have created your feature service. Keep them for now, because they serve two purposes:

• They help define attribute field types.

Unlike databases and shapefiles, in which you can explicitly define attribute field types, ArcGIS Online determines the field types in CSV files based on their values. For example, if a field contains the value 10/21/2013, ArcGIS Online will recognize it as a date value.

• They help define attribute domain values.

For the Incident_Type field, the values allowed have been limited to the following: Pothole, Street Sign, Street Light, Manhole Cover, and Dead Animal. (This list serves as an illustration, so it is incomplete). You will use these domain values to create feature templates. With ArcGIS Online, you can define feature templates and add new domain values individually. However, it is easier to first input all the possible values in the CSV file and then create the feature templates all at once.

2. If you made changes, save the CSV data and close Excel.

5.3 Publish a hosted feature service

1. Open a web browser, and navigate to ArcGIS Online (arcgis.com or your organizational ArcGIS Online URL). Sign in with a publisher or administrator account.

2. Click the My Content button on the main menu bar and then click the Add Item button [image: images].
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3. In the Add Item dialog box, perform the following:

• Look for The item is and leave it set as On my computer.

• For File, click Browse and click C:\EsriPress\GTKWebGIS\Chapter5\311Incidents.csv.

• For Title, use the default or specify a new one.

• For Tags, specify some keywords as illustrated. Separate the keywords with commas.

• Make sure the check box next to Publish this file as a feature service remains checked.

If you leave the box unchecked, your data file is added to My Content, yet no feature service will be created. In this case, you can always publish a feature service from this file later if you wish.

• Leave the Locate features using Latitude/Longitude option selected.

• Review the field types and location fields.

• Click Add Item.
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Your CSV file is published as a feature service. An item details page appears once your feature service has been created. Next, define the service properties further.

4. On the feature service item details page, look for the Layers section. Click the 311Incidents arrow and click Enable Attachments.
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This allows your users to attach photos, videos, and other files with the incidents they report. Users can attach multiple files for one incident, and each file can be up to 10 MB.

5. While still on the feature service’s item details page, click the Edit button [image: images].
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6. Go to the editor settings page, scroll down, select the check box for Enable editing and allow editors to: and select Add, update, and delete features.
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This selection is one of three options that you should know:

• Add, update, and delete features: Gives your users the most privileges. They can update and delete incidents that other users have reported. This setting places the highest level of trust in users because it assumes that users will respect each other’s posts and edits.

• Update feature attributes only: Allows users to only enter attribute information but does not allow them to change feature geometries. For example, your service may contain a set of observation towers, which have locations that you do not wish to be changed but with attributes that you encourage users to update.

• Add features only: Allows users to report something new but not to delete or update existing features.

7. Review the Track Edits options and leave them unchecked.
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If you wish to track and restrict user edits, you must require them to log in so that the feature service can track who did what. For tutorial purposes, allow all users to report incidents without logging in so the Track Edits options stay turned off.

8. Save your settings by clicking the Save button [image: images].

9. Go to the item details page, click the Share button [image: images], and share your service with Everyone (public).

This way, your web users can use your feature service without logging in.

The feature service you have published can now collect VGI.

Keep your web map open if you are going directly to the next section.

5.4 Define feature templates

In this section, define feature templates that improve a user’s editing experience.

1. While you are still logged in and on the item details page, under the item thumbnail, click Open and click Add to New Map with full editing control.
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This option allows you to update the feature service.

2. In the map viewer, open the table of contents (TOC) by clicking Details > Show Contents of Map. In the TOC, click the 311Incidents arrow and click Change Symbols.
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3. In the Change Symbols dialog box, use Unique Symbols to show the Incident_Type field.

[image: images]

4. Click the symbol of each incident type, and change it to create a symbol that users can intuitively understand.

[image: images]

For an actual project, you may sometimes need to create custom icons to better match the incident types. For this tutorial, the icons used come from the set of symbols provided in ArcGIS Online.

• Dead Animal: from the Outdoor Creation set

• Manhole Cover: from the Cartography set

• Pothole: from the Transportation set

• Street Light: from the People & Places set

• Street Sign: from the Transportation set

• Graffiti: from the Safety & Health set

5. Click Done Changing Symbols.

6. You see a warning as illustrated, so click Yes and then click Done Changing Symbols again.
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The new symbols appear on the map.

7. In the TOC, click the 311Incidents arrow and click Save Layer.

[image: images]

This saves symbols and the feature template to your feature service and makes them available in all web maps and web apps that use this feature service.

8. Go to the ArcGIS Online map viewer menu bar, and click Edit. The feature template is now in the Add Features panel.

The feature template enables users to click an incident type and then add that type to a web map with just a click, which is convenient for both you and your end users.

[image: images]

If you included all the possible values for the incident type field in your CSV file, your feature template is now complete. If you missed some values, you can add them here. To illustrate this, add a new type of incident, Graffiti.

9. Under the feature templates, click the Manage button so that you can manage the feature template (e.g., add a new incident type).

Only the service owner or an organization administrator can see the Manage button.

10. In the Manage New Features panel, click Add New Type of Feature.
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11. In the Type Properties dialog box, perform the following:

• For Label, specify Graffiti.

• For Attribute: Incident_Type, also specify Graffiti.

You have now defined a new value for the Incident_Type field domain.



• For Symbol, choose an appropriate icon.

• Click Done.
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Each feature type can have multiple categories that further define its default attribute values. For example, the Pothole feature type offers three categories: Large, Medium, and Small. If you would like to use this feature, next to Pothole, click the small arrow and click New Template.

[image: images]

12. Click Save Changes.

This saves the new template to the feature service.

[image: images]

13. Now that the feature service and feature template have been created, remove the sample incidents you imported from the CSV file.

• On the ArcGIS Online map viewer menu bar click Edit.

• Click each of the sample incidents on the map. When pop-up windows appear, click the Delete button to delete each incident.
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14. In the upper-left corner of the page, click the Home button and click My Content.
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15. On the My Content page, look for the feature service, and click it for details.
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16. On the item details page, locate the Layers section, and click the 311Incidents layer.

This opens the Services Directory page of this layer.
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17. On the Services Directory page of the 311Incidents layer, find the Drawing Info section and verify that the Renderer is Unique Value Renderer on the Incident_Type field, the symbols you defined are listed, and the Types section contains all the feature templates you defined.

This confirms that your feature templates have been saved to your feature service. Now your templates will be available in all web maps and web apps and to all clients that use this feature service.

[image: images]

With your feature service published and feature templates defined, you are ready to use the service to create web maps and web apps.

5.5 Create a web map and define editable fields

Define which fields you will allow your users to edit on your web map.

1. Make sure you are logged in, in ArcGIS Online and on the item details page of your feature service. Under the item thumbnail, click Open and click Add to New Map with full editing control.

2. In the map viewer, go to the TOC.

3. Look for the layer 311Incidents. Click the layer arrow and click Configure Pop-up.

4. In the Pop-up Properties panel, click Configure Attributes.

5. In the Configure Attributes window, configure the aliases of the attribute fields and the fields you want to allow users to edit.

• Clear the Display and Edit check boxes for the Long and Lat fields.

When users click on the map to add an incident, they do not need to specify the Long and Lat fields. The coordinates will be automatically captured and saved.



• In the Incident_Status field, clear the Edit check box.

This field is restricted to internal use only—for example, a public works dispatcher who needs to track an incident’s status as open, assigned, or closed. End users can see it, but they cannot change it.



• Specify the aliases for the fields as illustrated.
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6. Click OK to close the Configure Attributes window.

7. Click Save Pop-up.

8. Zoom and pan the map to your intended study area—that is, the city for which you have created the application. For this tutorial, zoom to the City of Los Angeles.

9. Save your web map. On the menu bar, click Save > Save.
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[image: images]    Note: The web map you have just created is for the public. If you wish, you can create a separate web map available only to the city’s internal users. This internal web map should allow internal users to edit the Incident_Status field.

Keep your web map open if you are going directly to the next section.

5.6 Create a web app for VGI collection

1. Continuing from section 5.5, make sure you are logged in with your web map open. On the menu bar, click Share.

2. In the Share dialog box, share your web map with Everyone (public).

3. Click Make a Web Application.

4. In the templates gallery, look for a template that supports editing, such as the Basic Viewer or Edit templates. Once you have made your selection, click Publish > Preview to determine whether the template supports editing.

[image: images]

Here, use the Basic Viewer, but remove some of its functions to make it easier for public users to understand and use.

5. Find the Basic Viewer template, and click Publish > Publish.

6. Fill in the appropriate title, tags, and summary information and then click Save & Publish.

[image: images]

7. Click View Item, which takes you to the item details page of the new web app.

8. On the web app’s item details page, click the Configure App button [image: images].

[image: images]



9. In the configuration mode, clear the check boxes for Legend, Print, Layer List, and Measure.

10. Optionally, add a title and the city’s logo to the banner.

[image: images]

11. Click Save to preview your web app.

12. Go back to the app’s item details page.

You can get there using the browser’s back button.

13. On the item details page, click Share to share your web app with Everyone (public).

14. Click the thumbnail to open your web app.

15. Test your web app by reporting an incident.

16. Switch into edit mode by clicking Editor on the menu bar. Choose a type in the feature template. Click on the map where an incident has occurred, and fill in the attributes. Click Choose File to attach a photo or another type of file.

[image: images]

You now have a web app the city can use to collect data about nonemergency incidents. For an actual project, you can share the app’s URL with the public via social networks or your city’s home page.

[image: images]    Note: Users typically submit VGI at the site of the incident using smartphones. Your web app can be used on smartphone browsers. Your web map can be used in native mobile apps such as Collector for ArcGIS and Explorer for ArcGIS. Find more details about these apps in chapter 9.

[image: images]

Native mobile apps used to collect VGI.

QUESTIONS AND ANSWERS

1. How do feature services and feature layers differ?

Answer: See table 5.1.

Table 5.1 Feature service vs. feature layer







	Feature service
	Feature layer



	It is a service. It can have one or more layers.
	It is one layer in a map.



	The layers in a feature service are all feature layers.
	A feature layer can be a layer from a feature service, a map service, or other types of services.



	Layers can be read and edited by web clients.
	Only a feature layer from a feature service is editable.



	URL ends with “FeatureServer” (e.g., http://.../arcgis/rest/services/..../FeatureServer).
	URL ends with a number (e.g., http://.../arcgis/rest/services/.../FeatureServer/0 or http://.../arcgis/rest/services/.../MapServer/0).




2. Previous chapters introduced you to Map Notes layers. These can be edited, too. How do they differ from feature services?

Answer: A Map Notes layer is only editable by its owner, but a feature service can be editable by anyone who has the permission to do so.

A Map Notes layer is stored in the web map in which it was created, so it cannot be added to other web maps. Anyone with whom you share your web map can view it, but only the owner can edit it. If you edited the data but are not the owner, you will need to save a new copy of the web map.

In contrast, a feature service can be edited by anyone to whom the owner has granted permission. A feature service can be used in many web maps. Edits are saved to the feature service itself, rather than to the web maps.

3. What kinds of editing can you perform with lines and polygons?

Answer: ArcGIS API for JavaScript and ArcGIS Online templates come with an editor toolbar or widget. The editor toolbar provides flexible capabilities for editing lines and polygons, including defining shapes with mouse clicks or by freehand, moving/rotating/scaling shapes, adding/deleting/moving vertices, and even feature snapping.

[image: images]

4. It is interesting to see that you can use feature services to attach photos and other documents. Where are the attachments stored?

Answer: Attachments are stored in a table of the database underlying your feature service. A feature can have zero to many attachments; thus, it can have zero to many corresponding records in the table.

5. The data collected by a hosted feature service is stored in the ArcGIS Online cloud. Can I export the data to my own computer?

Answer: You can export the data collected in a CSV or a shapefile if

• you own the feature service,

• you are an administrator for your ArcGIS Online organization, or

• the service owner or administrator has configured the service to allow others to export the data.

To export the data, perform the following:

• Log on to your ArcGIS Online for Organizations account.

• Go to the item details page of your feature service. If you are the owner, look for it in the My Contents list. If you are not, search for the feature service using keywords instead.

• Click the drop-down arrow next to a feature layer and click Export to Shapefile or Export to CSV file.

[image: images]

ASSIGNMENTS

Choose one of the following two assignments. The second assignment is larger and requires more time.

Assignment 5A: Create a web app that allows citizens to report wanted suspects.

Law enforcement typically asks citizens to use a phone to report wanted suspects. The police department in your city, however, would like to enhance the workflow. It would like to build a web GIS app that citizens can use to report places where they might have seen four highly dangerous suspects and upload photos and videos that might include images of them.

Data: No data is provided. You can create a CSV file with the following fields:

• Suspect

• Description

• Long

• Lat

• Date_Saw_Suspect

• Report_Date

• Reported_By

• User_Contact

• Status

Requirements:

• Your feature service should have feature templates.

• It should allow citizens to upload photos and videos of suspects.

• The Status field should be read-only to users.

• Your web app or web map can be used on smartphones.

What to submit: E-mail your instructor with the subject line Web GIS Assignment 5A: Your name, and include the following:

• The URL of your feature service REST endpoint

• The URLs of your web map and web app

[image: images] Tips:

• Use the four suspect names or numbers (e.g., Suspect #1) as the domain values.

• In an actual project, use the photos or pictures of the suspects as their symbols. Here, simply use a different icon (head and shoulders icon preferred) for each suspect.

Assignment 5B: Create a web app to collect public comments on regional plans.

The US National Environmental Policy Act (NEPA), passed in 1969, encourages public participation in government land-use planning. It requires government agencies to make planning maps accessible to the public. It also demands that they collect public comments during a specified time period. Currently, public comments are typically collected during public hearings, which requires citizens to be physically present at the hearings.

The US Bureau of Land Management (BLM) in your state would like to build a web app to better engage citizens in regional planning and ease the process of collecting public comments.

Data: No data is provided. Collect and make up your own data.

• You must have a regional plan layer in which each polygon displays its planned usage for the piece of land, along with a URL that links to a more detailed plan.

• Three layers will be necessary to store public comments: a point type, a line type, and a polygon type. Each of them should contain the following attribute fields:

› Comments

› Comment_Date

› Comment_By

› User_Contact

› Status

Requirements: Your app should allow citizens to do the following:

• See the maps of a regional plan.

• Click a parcel of land (shaped, perhaps, as a polygon) and see information about its planned usage and links to further details.

• Submit georeferenced comments—that is, draw a point, line, or polygon on the map and provide comments about the site.

• Attach documents to comments.

The Status field should be read-only for end users.

What to submit: E-mail your instructor with the subject line Web GIS Assignment 5B: Your name, and include the following:

• The URL of your feature service REST endpoint

• The URLs to your web map and web app



[image: images] Tips:

• Publish a map service of the regional plan data layer.

• Publish a feature service of the three public comment layers.

• Add the map service layer and the three public comment feature layers to a web map.

• Define appropriate pop-up windows.

• Create a web app using this web map.

Resources

ArcGIS for Server Help document site

“Tutorial: Performing Web Editing Using Data from an Enterprise Geodatabase,” http://resources.arcgis.com/en/help/main/10.2/index.html#//0154000005mm000000.

“Tutorial: Performing Web Editing Using Replicated Data from an Enterprise Geodatabase,” http://resources.arcgis.com/en/help/main/10.2/index.html#/Tutorial_Performing_web_editing_using_replicated_data_from_an_enterprise_geodatabase/0154000005ts000000.

“Tutorial: Performing Web Editing Using Data from a Database,” http://resources.arcgis.com/en/help/main/10.2/index.html#/Tutorial_Performing_web_editing_using_data_from_a_database/015400000628000000.

ArcGIS Online Help document site

Publishing features, http://doc.arcgis.com/en/arcgis-online/share-maps/publish-features.htm.

Managing hosted web layers, http://doc.arcgis.com/en/arcgis-online/share-maps/manage-services.htm.

Managing feature templates, http://doc.arcgis.com/en/arcgis-online/share-maps/manage-feature-templates.htm.

Esri Training website

“Creating a Web Editing Application Using ArcGIS 10.1 for Server,” http://training.esri.com/gateway/index.cfm?fa=catalog.webCourseDetail&courseid=2549.

“Creating Hosted Map Services with ArcGIS Online,” http://training.esri.com/gateway/index.cfm?fa=catalog.webCourseDetail&courseid=2563.

“ArcGIS: Sharing Content on the Web (10.2),” (instructor led, fee required), http://training.esri.com/gateway/index.cfm?fa=catalog.courseDetail&CourseID=50130533_10.x.

Esri videos

“Publish Hosted Feature Layers,” http://video.arcgis.com/watch/1342/publish-hosted-feature-layers.

“Managing Feature Templates,” http://video.arcgis.com/watch/2053/manage-feature-templatesPart number (type over existing text).




Chapter 6

Web AppBuilder for ArcGIS

The Web AppBuilder for ArcGIS application developer technology allows you to build web apps without programming. It provides more configurable functionalities than any of the other ArcGIS Online web app templates. Web AppBuilder comes with a couple of dozen premade widgets, or tools, that provide functions ranging from mapping, table view, charting, querying, and routing to geoprocessing and more. Built on JavaScript and responsive web design technologies, Web AppBuilder for ArcGIS creates cross-platform apps that work for your desktop, tablet, and mobile devices—without plug-ins. Web AppBuilder for ArcGIS acts as a client for ArcGIS for Server, ArcGIS Online, and Portal for ArcGIS and can display 2D and 3D map services.

Learning objectives

• Create web apps using Web AppBuilder.

• Add your own data sources.

• Configure and use various widgets.

• Deploy finished web apps.

[image: images]    Note: Web AppBuilder was in the beta version of testing when this chapter was written. Discrepancies may occur after this product is officially released.

This chapter in the big picture

[image: images]

ArcGIS offers many ways to build web applications. The red oval in the figure highlights the technology chapter 6 teaches.

Key features of Web AppBuilder for ArcGIS

Web AppBuilder for ArcGIS is a web application you can use to create web GIS applications without programming. It is built on HTML5 and ArcGIS API for JavaScript. Its key features include the following:

• Creates web apps with pure HTML and JavaScript so that they do not require any plug-ins.

• Uses responsive web design technologies. Web apps adapt nicely to desktops, tablets, and smartphones and work well on larger or smaller screen sizes.

• Supports both 2D and 3D web apps, making them more intuitive, immersive, and engaging.

• Comes with numerous out-of-the-box widgets for creating powerful web apps with rich functionality.

• Supports the creation of web app templates for ArcGIS Online and Portal for ArcGIS.

• Provides an extensible framework for developers to create custom widgets, themes, and applications.

[image: images]

Web AppBuilder allows users building apps to choose from the available user interface themes, web maps, and widgets, all in a what-you-see-is-what-you-get format.

Core widgets

Web AppBuilder provides functions through widgets. Typically, a widget is a JavaScript component that encapsulates a set of isolated and focused functions with which users can perform a task. Most widgets are not only visually interactive but also connect to server-side resources such as map services from ArcGIS for Server or ArcGIS Online.

Web AppBuilder provides a range of widgets, including map, basemap gallery, navigation, overview map, coordinates, splash screen, legend, layer list, and locate as well as additional widgets listed in table 6.1.

Table 6.1 ArcGIS WebApp Builder widgets







	[image: images]
	Bookmark



	[image: images]
	Draw
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	Print
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	Attribute Table
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	Chart
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	Edit
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	Query
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	Directions
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	Map Compare



	[image: images]
	Geoprocessing



	[image: images]
	Histogram Time Slider



	 
	 




The number of available widgets will grow with future product releases and contributions from the user community.

Using Web AppBuilder for ArcGIS to create web apps

With Web AppBuilder, as you configure your web apps interactively, Web AppBuilder generates and stores the configurations in several JSON (JavaScript Object Notation) files. This way, you do not have to know JSON and the configuration syntax for various widgets and components to be able to use them.

A typical web app consists of basemaps, operational layers, and additional functions or tools. Web AppBuilder facilitates this pattern.

• For operational layers: Use ArcGIS Online or Portal for ArcGIS to author a web map and then reference the web map in Web AppBuilder. Using web maps as a foundation, you can incorporate many types of operational layers, including CSVs, shapefiles, ArcGIS for Server map services and feature services, GeoRSS, KML, WMS (Web Map Service), and others. The pop-up windows you define in your web map will be carried over into Web AppBuilder and your web app.

• For basemaps: Web AppBuilder has a basemap gallery widget, which adds a collection of basemaps to your web app.

• For additional functions or tools: You can configure them using the widgets listed previously. Each of the functional widgets requires certain data sources. For example, the edit widget requires a feature layer from a feature service, the chart widget requires a feature layer from a map service or a feature service, and the geoprocessing widget requires a geoprocessing service.

In addition to the contents and functions of your web app, you can also configure the app’s theme, including its color style and layout.

Extending Web AppBuilder to create custom apps

Web AppBuilder provides developers with a great framework to create new widgets, customize existing widgets, create new themes, and build apps with extended functionality.

A Web AppBuilder for ArcGIS widget constitutes a folder of files. The files can be as simple as a single JavaScript file or as complex as a set of HTML, JavaScript, CSS (Cascading Style Sheet), and other files, as illustrated. You can package and share your widgets with other users for free or for a fee.

[image: images]

A widget typically consists of a group of HTML, JavaScript, CSS, and other files.

This tutorial

An organization would like to provide a web app to display historic earthquakes and hurricanes to the public.

Data: Reuse the map service and web map you created in chapter 3.

Requirements: The web app should do the following:

• Provide pop-up windows for the earthquake and hurricane layers

• Zoom to the entire United States in its initial view

• Provide bookmarks so that users can quickly zoom to predefined areas

• Allow users to print displays as PDFs

• Allow users to chart and compare the selected attributes of selected earthquakes

• Allow users to query for features based on their attributes

• Display appropriate logo, title, subtitle, and links in the banner

System requirements:

• Web AppBuilder for ArcGIS

• An ArcGIS Online organizational or Portal for ArcGIS account

• Optionally, Apache Tomcat (or other Java web application server) if you are not using the hosted version of Web AppBuilder and would like to host Web AppBuilder yourself

• Microsoft Internet Information Services (IIS), for deploying the web app you created

• A web browser

6.1 Access Web AppBuilder

At the time of this writing, Web AppBuilder for ArcGIS was still in beta testing. It will have an integrated edition and a developer’s edition upon its official release. The integrated edition is hosted in ArcGIS Online and Portal for ArcGIS. It does not need additional download or web hosting, and therefore it is easier to get started and is the suggested edition to use with this chapter. The developer’s edition supports custom widget development but requires download and web hosting. The URL to download it and the methods to host it will be changed upon its official release. Please follow your instructor’s directions regarding how to access Web AppBuilder.

6.2 Create a basic web app

In this section, select a theme, a web map, and several simple widgets to build a basic web app.

1. If you are using the developer edition of Web AppBuilder, go to the Web AppBuilder home page (e.g., http://[Machine_Name]:3344/webappbuilder—ask your instructor about the URL), specify the URL to your organization (e.g., http://esripressbooks.maps.arcgis.com) or your Portal for ArcGIS and your user name and password, if you are being prompted to enter such information. Ask your instructor about such information if you do not know it. If you are using the integrated edition, log on to ArcGIS Online or your Portal for ArcGIS, create a web map (e.g., an empty web map—you will have chances to change it later), save it, share it, and then click the Make a Web Application button. In the Share window, click the Web AppBuilder tab; specify your app title, tags, and summary; click the Get Started button; and go to step 3.

2. Click the Create New button, click 2D, specify an app name (for example, Historic earthquakes and hurricanes) and an optional description, and click OK.

[image: images]

In the upper-left corner of the page, there are four tabs: Themes, Map, Widgets, and Attributes. Use these four different aspects to configure your web app.

3. Click the Themes tab and click Foldable Theme, and choose a color and layout you like, as illustrated.

[image: images]

You can play with other themes, too. As you make the changes, look to the right, where you can immediately see how the new setting looks.

4. Click the Map tab and then click the Choose Web Map button.

[image: images]

5. Find the web map you created in the chapter 3 tutorial (under My Content). If you do not have it, a similar web map is provided. To get it, click the Public tab, select the ArcGIS.com option, type Historic Earthquakes and Hurricanes to search for it, select the map from the results, and then click OK.

[image: images]

The selected web map displays on the map canvas.

If your search returns multiple web maps, hover your mouse over each one, and click the information icon to read the details to determine which web map to use.

[image: images]    Note: You cannot add map services directly to the map in Web AppBuilder. To do that, add your map services to an ArcGIS Online or Portal for ArcGIS web map and then reference the web map in Web AppBuilder.

6. To understand the layers on the map, on the toolbar, click the Legend and Layer List buttons to bring up the legend and layer list widgets. Close the widgets when you are done.

[image: images]

7. Under Specify the initial spatial extent of the map when the application starts up, click either Use Current Map View (you may need to pan/zoom the map to get the extent you desire before you select this option) or Use Web Map’s Default Extent.

[image: images]

8. Click the Widgets tab so that you can add additional widgets.

[image: images]

9. Click the Widget 1 button, then click the basemap gallery widget, and click OK.

[image: images]

Notice that the basemap gallery widget has been added to a widget placeholder in your app.

10. Click the current Widget 1 button, click the measurement widget, and click OK.

[image: images]

11. Again, click the current Widget 1 button, click the bookmark widget, and click OK.

[image: images]

12. Configure the bookmark widget. Hover your mouse over the widget icon and then click the pencil icon [image: images].

[image: images]

13. In the Bookmark configuration window, perform the following:

• Click the Click to Add a New Bookmark button.

• Specify the title as Western States.

• Pan/zoom the map to the western states of the United States.

• Optionally, to specify an icon that represents your bookmark, click the Thumbnail button [image: images].

• Click OK to add this bookmark.

[image: images]

14. Repeat step 13 to add another bookmark, such as Southeastern States.

15. Click OK to close the bookmark widget configuration window.

16. Click the Attributes tab, set the title to Historic Earthquakes and Hurricanes, and, in the subtitle, indicate it is designed by you.

17. Click the logo icon, and select the image you would like to use—for example, your organization’s logo.

[image: images]

As an option, click the Add New Link button to add a URL, such as the home page of your organization or project. The new link appears in the banner. Alternatively, you can remove existing links as well.

18. Click Save to save your changes.

[image: images]

You can preview the effects of your configurations on the right side of your web viewer as you create them. This way, you can try new widgets and immediately see how they work, look, and feel. You can even see how the web app will behave on mobile devices.

19. Click Previews.

[image: images]

20. Choose the type of device you wish to preview, or specify its screen resolution. Change the orientation of the device to see how the app will look and the widgets will behave.

[image: images]

21. To view your app in the web browser, click Launch. Test your app to make sure it works.

[image: images]

Now you have created a simple web app without any programing.

6.3 Configure additional widgets

In this section, learn how to enhance your web app by adding the draw, chart, query, and print widgets. (You will learn how to add a geoprocessing widget in chapter 7.)

1. Go to the Web AppBuilder home page, hover the mouse over the app you just created, and click Edit to load your web app. Click the Widgets tab and then click the Set the widgets in this controller link.

These widgets are now displayed on the header toolbar of your web app.

[image: images]

2. Click the Click here to add widget button; click the chart, draw, print, and query widgets; and click OK.

[image: images]

You have now added these widgets to your widget list.

3. If you need to change the order of your widgets, click a widget icon, drag it to the desired position, and drop it there.

[image: images]

These widgets have been added, although some will need additional configuration before they become usable.

4. Hover the mouse over the chart widget, and click the pencil icon to configure the widget.

[image: images]

The chart widget helps you chart multiple layers. Each layer allows multiple charts, and each chart displays one attribute of the selected features.

5. In the chart widget configuration window, click Add a Chart Source.

[image: images]

6. Click Set Source to specify the layer to be charted.

[image: images]

7. Click Select from Current Map, expand the natural_disasters map service, select the Earthquakes layer, and click OK.



[image: images]

8. In the Chart configuration window, perform the following:

• Leave the Label field as LOCATION.

• Under Available Fields, click OTHER_MAG1. Click the Include button, and change the chart title to Magnitudes, leaving the chart type Bar.

• Also under Available Fields, click DEPTH_KM. Click Include, and change the chart title to Depths (km) and the chart type to Column.

• Click the Add Chart Source link.

[image: images]

These settings define two charts, one that displays the magnitude field and the other that displays the depth field. The label field helps to identify an earthquake whenever a user hovers the mouse over a bar or column in the chart. See how this works in steps 10 through 12.

9. Click OK to close the Chart configuration window.

[image: images]

Try this widget to see how it works. This also helps you understand what you have configured.

10. On the toolbar of your app, click the Chart button, select a shape, and draw it on the map to select some earthquakes.

[image: images]

Notice that the chart widget has switched to the Results tab and displays a bar chart that compares the magnitudes of selected earthquakes.

11. Hover the mouse over a bar in the chart. This displays both the location (that is, the Label field) and the magnitude of the selected earthquake in a pop-up window. The map also highlights the earthquake over which your mouse is currently hovering in the chart.

[image: images]

12. On the right side of the chart, click the arrow [image: images]. The second chart you configured appears. The column chart compares the depths of selected earthquakes.

[image: images]

13. Configure the query widget. To configure the widget, hover the mouse over the query widget icon and click the pencil icon.

[image: images]

14. In the query widget configuration window, click Add New.
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15. Click Select from Current Map, expand the natural_disasters map service, click the Earthquakes layer, and click OK.

[image: images]

16. In the query widget configuration window, perform the following:

• Click the Add a set button.

• In the first expression, click OTHER_MAG1 in the first field name drop-down box, click is at least as the operator, type 4 as the default value, leave Value selected, select the Ask for values check box, and change the prompt to Magnitude is at least and the hint to 4.

• In the second expression, click LOCATION and contains, type Alaska as the default value, select the Ask for values check box, and change the prompt to LOCATION contains and the hint to Alaska.

• Under the Query Definition tab, click Add another expression.

• In the new expression, click YEAR and is, type 2000 as the default value, select the Ask for values check box, and change the prompt to YEAR is and the hint to 2000.

[image: images]

Next to the Value option, there are Field and Unique options. The Field option compares the selected field value with another field, and the Unique option provides a drop-down list of the unique values of the field for users to select.

17. Click the Results Setting tab to configure how you would like to see the query results.

• Leave Result Item Title as ${LOCATION}.

• Under the Result Item Contents list, click DEPTH_KM, and set the alias as Depth; click OTHER_MAG1, and set the alias as Magnitude; and click YEAR, and set its alias as Year.

• Optionally, click Set symbol for query results to define how you would like the result to be symbolized.

• Click OK.
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Now try this widget to see how it works. This also helps you understand what the configuration controls.

18. On the application toolbar, click the Query button and click Earthquakes, which has the query you defined.

[image: images]

19. You see the search expression you configured. Leave the values as the default, or change the values, and click Apply.

[image: images]

The selected earthquakes appear highlighted on the map and listed under the Results tab.

20. Click each earthquake in the results list. The map centers on each earthquake, and a pop-up window appears, displaying the attributes you selected when configuring the widget.
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21. Configure the print widget. Hover the mouse over the print widget, and click the pencil icon to configure the print widget.
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22. In the print widget configuration window, perform the following:

• Notice that the service URL points to the printing geoprocessing service hosted in ArcGIS Online or your Portal for ArcGIS.

• Specify the default title and default layout and click OK.
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[image: images]    Note: If your map has layers from an internal ArcGIS Server, you must change the printing service URL. You could change it to a printing service that has access to your internal server. (See the “Questions and Answers” section at the end of this chapter for details.)

23. On your app toolbar, click the print widget to test how it works and then click Print to print the current map view, including any drawings, to a PDF.
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When the printing job is done, click the resultant PDF to examine it.

24. Click Save to save your work.
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Keep Web AppBuilder and your web app open if you are going directly to the next section.

6.4 Deploy your application

Now that you have created your web app, you can deploy it to your production web server. Here, deploy it to IIS.

1. Continuing from section 6.3, at the upper-left corner of the page, click the Web AppBuilder for ArcGIS link.
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2. Look for the app you just created on the Web AppBuilder home page, hover the mouse over it, click the dots button, and, on the context menu, click Download.
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Your app is packaged and downloaded as a ZIP File.

3. Find the downloaded ZIP File. Extract it to a folder under your web root (e.g., C:\inetpub\wwwroot\myapp) or to a virtual directory if you know how to create one.

[image: images]

4. Grant everyone permission to access this website.

5. In Windows Explorer, navigate to C:\inetpub\wwwroot, right-click the myapp folder, and click Properties.
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6. Click the Security tab > the Edit button > the Add button. Under Enter the object names to select, type Everyone, and click Check Names. Close the windows by clicking OK for each one.
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7. Your application URL is http://your_server_name/myapp. Test it in a web browser, and share it with your users.

In this tutorial, you created a web app that uses a set of required functions. The widgets you configured are among the most commonly used, and you can configure other widgets in a similar manner.

QUESTIONS AND ANSWERS

1. My print widget does not work. Instead, an error message appears, saying, “Error. Try again.” Why?

Answer: A common reason for this error message is that your web map contains a map service layer from an internal ArcGIS Server, which is inside your network firewall. The default printing service configured in the print widget comes from ArcGIS Online or Portal for ArcGIS. They often sit outside your network firewall, so they cannot see your internal server. As a result, they cannot ask your map service to generate a map.

To fix this problem, replace the default printing service URL with an internal printing service URL. ArcGIS for Server comes with a built-in printing service, which you can find in the Utilities folder of your ArcGIS for Server Services Directory. Some organizations choose to stop this printing service. You can start yours using ArcGIS Server Manager (navigate to http://your_ArcGIS_Server_name/arcgis/manager and log in with an ArcGIS for Server administrator account).

[image: images]

2. The controlled widgets (i.e., widgets on the toolbar) seem to open only one at a time. Can I open multiple widgets at the same time?

Answer: By default, no. If you customize the web apps you create, yes.

Sometimes, different widgets work on different layers and set the mouse cursor to different modes. Opening widgets simultaneously requires coordination between them. The source code of these web apps was created in JavaScript. Use this to customize the widgets to open at the same time.

ASSIGNMENTS

Assignment 6: Build a web app using Web AppBuilder for ArcGIS.

Data: No data has been provided. Instead, use the map services you published in previous chapters’ tutorials or assignments.

Requirements:

• The operational layers should use the services or layers you published.

• Appropriate pop-up windows should be configured in your layers.

• The initial map extent should zoom to your study area.

• The app should do the following:

› Provide bookmarks that allow users to quickly zoom to predefined areas.

› Let users print their maps as PDFs.

› Enable users to chart selected features with selected attributes.

› Allow users to query for features based on multiple attributes.

› Display the appropriate logo, title, subtitle, and links in the banner.

What to submit: E-mail your instructor with the subject line Web GIS Assignment 6: Your name, and include the following:

• Your web app URL

• Screen captures of your web app, showing it meets the preceding requirements.

Resources

Web AppBuilder for ArcGIS was in beta version at the time this chapter was written. Few public resources are yet available.

Esri videos

“ArcGIS WebApp Builder,” http://video.esri.com/watch/3211/web-app-builder.

“Intro: Web AppBuilder for ArcGIS-JavaScript Apps Made Easy,” http://video.esri.com/watch/3306/intro-arcgis-webapp-builder_dash_javascript-apps-made-easy.

“Customizing and Extending Web AppBuilder for ArcGIS,” http://video.esri.com/watch/3362/customizing-and-extending-web-appbuilder-for-arcgisPart number (type over existing text).


Chapter 7

Spatial analytics online and geoprocessing services

Web GIS does more than just mapping. Whereas map services and feature services are most commonly used, for serving maps, supporting spatial and attribute queries, and collecting data from their web clients, geoprocessing (GP) services can do even more. They expose the powerful analytic capability of GIS to the web. There are numerous GP services provided by ArcGIS Online for Organizations, available in the map viewer or via ArcGIS API for JavaScript. You can publish your own GP services to your ArcGIS Server for use in various web GIS clients.

Learning objectives

• Understand GP services.

• Explore ArcGIS Online analytic capabilities.

• Author and execute GP models.

• Publish GP services.

• Use GP services in Web AppBuilder for ArcGIS.

This chapter in the big picture

[image: images]

ArcGIS offers many ways to build web applications. The thick red line in the figure highlights the technology chapter 7 teaches.

Geoprocessing services

GP services bring analytic functions to the web. Typically, a GP service includes one or more geoprocessing tasks, each of which takes inputs, processes them, and returns meaningful and useful output(s) in the form of features, maps, reports, and files. The range of practical applications seems infinite: from calculating the probable evacuation area after a hazardous chemical spill to predicting the track and strength of a gathering hurricane to summarizing the land cover within a user-defined watershed to simulating a region’s past and predicting its future development.

If you have used geoprocessing in ArcGIS for Desktop, you can think of a GP service as a toolbox and its tasks as tools within that toolbox. The main difference is that when you execute a task in a GP service, it runs on the server computer, using the CPU of the server computer.

Traditionally, the work of geoprocessing was limited to GIS professionals using professional desktop GIS software. This has changed. Now GP services make GP capabilities widely available to a broad spectrum of web clients, who can access GP services through easy-to-use interfaces. This allows nonprofessional GIS users of all kinds—from executives to everyday users—to perform GP operations. You most likely already do. You could consider routing analysis, for example, as a special kind of geoprocessing service. With the increasing availability of getting map directions on the web, everyone can use this GP service, most of us regularly.

Use ArcGIS Online analytic tools

ArcGIS Online for Organizations provides many analytic tools. Some of these use the data in your web map. Others rely on the data provided by ArcGIS Online, such as routing and GeoEnrichment Service, both of which are backed up by the street network and demographic data that ArcGIS Online provides. To use these analysis tools, log in with an ArcGIS Online for Organizations account. Click your layer in a web map and click Perform Analysis in the context menu. Browse the menu to find the analytical tool you need. You can also use these tools via ArcGIS API for JavaScript.
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Perform analysis in the ArcGIS Online map viewer.

[image: images]

ArcGIS Online provides a number of groups of analytical functions.

List of ArcGIS Online GP capabilities

ArcGIS Online provides the following main groups of analytical functions (and the list will continue to grow with upcoming releases).

[image: images]    Note: a subscription account is required to use these functions.

• Summarize Data: calculates the total counts, lengths, areas, and basic descriptive statistics of features and their attributes, within or near the features of another layer.

• Aggregate Points: determines which points fall within each polygon in a polygon layer and calculates the relevant statistics about those points within each polygon.

• Summarize Nearby: Finds and summarizes the features that lie within a specified distance from the features in another layer. The distance can be specified in a straight line or drive time (e.g., 10 minutes).

• Summarize Within: finds the areas (and portions of areas) that overlap between two layers and calculates statistics about the overlap.

• Find Locations: finds areas that meet your criteria, which can be based on both attribute and spatial queries (e.g., within one mile of a river).

• Find Existing Locations: selects existing features that meet your criteria.

• Derive New Locations: creates new features that meet your criteria.

• Data Enrichment: retrieves the detailed demographic data and statistics available for your chosen area(s) and generates a report that compares that area with its county or state.

• Analyze Patterns: identifies, quantifies, and visualizes the spatial patterns in your data.

• Explore Correlations: calculates the correlation between a focus attribute field and up to 10 other numerical attributes.

• Find Hot Spots: creates a map that identifies any statistically significant spatial clustering present in your data.

• Use Proximity: finds areas or features nearby and calculates optimal routes.

• Create Buffers: constructs areas that fall within a given distance from a point, line, or polygon feature.

• Create Drive-Time Areas: produces areas that fall within a specified drive time or drive distance.

• Find Nearest: Locates the nearest features (e.g., schools or hospitals) measured by straight line, driving distance, or driving time. Optionally, it also reports and ranks the distances to the nearby features.

• Plan Routes: takes a set of stops (points) and the number of vehicles available to visit the stops, and the task determines how to efficiently assign the stops to the vehicles and route the vehicles to the stops.

• Manage Data: performs data extraction, generates new field values, and merges features or layers.

• Field Calculator: determines field values based on other fields and a formula.

• Dissolve Boundaries: merges areas that overlap or share a common boundary, and optionally share a common attribute value, to form a single area.

• Extract Data: creates a ZIP File or layer package of data from your layers and an area of interest that you specify.

• Merge Layers: copies features from two layers into a new layer. You can control how the fields from the input layers are joined and copied.

• Overlay Layers: Combines two or more layers into a single layer. Visualize overlay as peering through a stack of maps and creating a single map that contains all the information found in the stack.

Publishing your own GP services

ArcGIS Online currently does not allow you to publish your own GP services. To do that, you will need to use ArcGIS for Server for both publishing and hosting. It takes three steps to accomplish this, as shown in the figure.
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Three steps to using a geoprocessing service.

1. Author your tool or model.

Create a tool or model using ModelBuilder in ArcGIS for Desktop or by scripting (e.g., using the Python programming language). This step involves implementing the workflow logic, specifying the location of the data needed, and defining the input and output parameters. The output parameters define what web clients can receive and end users can get.

2. Run your tool or model.

To ensure your tool or model works as expected, you must run it, which typically is done using ArcGIS for Desktop. A successful run produces a successful result in the ArcMap Results window.

3. Publish the execution plan.

Right-click the result and click Share As > Geoprocessing Service. This opens a step-by-step wizard that defines the service and its task. This task is the same as the tool or model that created the result. For a GP service, a key parameter to choose is the execution mode. Execution mode defines how the web client interacts with the server and gets its results from the executed task. This mode can be either asynchronous or synchronous. Both forms of this execution mode are supported by Web AppBuilder for ArcGIS, ArcGIS API for JavaScript, and other clients.

a. Synchronous: When a service is set as synchronous, the client waits for the task to finish and to get the result. Typically, a synchronous task executes quickly—in five seconds or less.

b. Asynchronous: An asynchronous task typically takes longer to execute, and the client must periodically ask the server if the task has finished and, if it has finished, get the result. A web application using an asynchronous task must have logic implemented to check the status of a task and handle the result once execution is finished.

ModelBuilder

You can use ModelBuilder to create a model that will become a task for your GP service. ModelBuilder comes with ArcGIS for Desktop, and you can use it to create, edit, and manage models. Think of ModelBuilder as a visual programming language. You can create a model by stringing together sequences of geoprocessing tools and connecting them with inputs and outputs. Compared with other ways to build GP tools, such as using Python, It is easier to get started using ModelBuilder. In this tutorial, you will use ModelBuilder.

[image: images]

A model built with ModelBuilder can be used to publish a geoprocessing service.

Python and ArcPy

In addition to ModelBuilder, you can use scripting languages such as Python to create a geoprocessing workflow that can become a task for your GP service. Python is a free, powerful, cross-platform, and open-source scripting language, which is included in a typical ArcGIS for Desktop and ArcGIS for Server installation. It is often used to automate workflows so that you do not have to perform them manually—for example, automatically converting one thousand shapefiles into geodatabase feature classes instead of doing each conversion manually. As an interpreted language, Python does not need to be compiled. You can write it using any text editor (such as Notepad) or more sophisticated development environments. You can run a Python script inside ArcGIS or as stand-alone.

ArcGIS extends Python by providing ArcPy, a module that facilitates data analysis, data conversion, data management, and map automation. This module offers users ease and convenience in using Python by offering such features as code completion (in which, for example, users can type a keyword plus a dot to get a pop-up list of properties and methods supported by that keyword) and reference documentation for each function, module, and class.
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A script such as written here in Python can be used to publish a geoprocessing service.

This tutorial

A company is going to build a new factory in the US state of Alabama. Create a web GIS app that will help the company’s executives select possible sites for the new factory based on the following criteria:

• The new factory should be close to the areas in which the executives are interested.

• This factory will use a lot of water, so it should be close to rivers.

• The products of this factory require railroad transportation, so the factory should be close to railroads.

Data: You are provided with the following:

• A file geodatabase containing the following three feature classes:

• Main rivers in Alabama

• Selected railroads in Alabama

• An empty point feature class

• A map document named Site_Selection.mxd, which can display the rivers and railroads layers

• A toolbox named Planning.tbx, which contains a Select_Sites tool

Requirements: Your web app should allow the executives to specify the following parameters:

• A point to indicate a location of interest

• A distance that delimits the factory’s distance from the location of interest

• A distance that defines how close the factory should be to rivers

• A distance that defines how close the factory should be to railroads The application should determine and highlight the areas that are

• close to the location of interest, and

• within the specified distances to rivers and railroads.

System requirements:

• ArcGIS for Desktop: for designing your GP model

• ArcGIS for Server: for publishing and hosting your GP service

• ArcGIS Online subscription account: for accessing Web AppBuilder for ArcGIS to create your web app

7.1 Design a geoprocessing model

This book does not focus on designing geoprocessing tools, so it does not discuss many details. Instead, the tutorial is sped up by starting with a mostly completed model.

1. Start ArcMap, navigate to the folder connection C:\EsriPress\GTKWebGIS, and browse to the Chapter7 folder.

If you do not have the folder connection, refer to chapter 3, section 3.2. There is a file geodatabase, a map document, and a toolbox in the chapter 7 folder.
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2. Open the Site_Selection.mxd. The Railroads and Rivers layers appear on the map.

[image: images]

3. Expand the Planning.tbx file, right-click the Select_Sites model, and click Edit.

[image: images]

4. Review the model elements.

The model does the following:

• Buffer1 generates a buffer around the location that users click (to be further configured).

• Clip1 selects rivers that lie within a specified distance from the point of interest.

• Clip2 selects railroads that lie within a specified distance from the point of interest.

• Buffer2 generates a buffer around selected railroads.

• Buffer3 generates a buffer around selected rivers.

• Intersect3 intersects the two preceding buffers and finds common areas between them.

• Dissolve merges the adjacent little polygons into bigger polygons.
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The model is not yet complete. To complete it, first define the input parameters for Buffer1.

5. Right-click Buffer1 and click Make Variable > From Parameter > Distance [value or field].

This allows users to specify the buffer distance surrounding the location of interest.
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6. Right-click Buffer1 and click Make Variable > From Parameter > Input Features.

This allows users to specify the location of interest.
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7. On the toolbar, click the Auto Layout button [image: images] to rearrange the model elements layout.

[image: images]

8. Right-click the Input Features element and click Properties.
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9. Go to the Input_Location_Of_Interest Properties dialog box. Click the Data Type tab, and set Select data type as Feature Set. For Import schema and symbology from, navigate to point_lyr in Lab_Data.gdb and then click OK.

This ensures that users can specify only a point feature type, rather than a line or polygon type, for the location of interest.
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10. Right-click the Input Features variable, click Rename, specify it as Input_Location_Of_Interest, and then click OK.

This makes the model parameter name meaningful so that GP service users can easily understand what it is. It is also good practice to keep the parameter names plain without special characters so that the developers using your GP service can reference these parameters easily.
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11. Right-click the Distance [value or field] variable, click Rename, specify it as Input_DistanceOfInterest, and then click OK.
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12. Right-click the Input_Location_Of_Interest variable and click Model Parameter.

The letter P will appear to the upper right of this variable. This indicates that the variable is a model parameter.
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13. Right-click the Input_DistanceOfInterest variable and click Model Parameter.
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14. Double-click the Input_DistanceOfInterest variable. Set its default value at 60 Kilometers and then click OK.
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15. Right-click Output_PossibleSites, and set it as a model parameter.

This becomes the model output.
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16. Right-click Output_PossibleSites and click Add To Display.

This adds the model result to ArcMap so that the result is displayed on your map.
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Your model is now completed and validated, with all the elements color shaded. The blue round elements are inputs to the model. Yellow rectangular elements are tools. Green round elements are derived data that is output from the model.
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17. On the model toolbar, click the Save button to save your model. Close the ModelBuilder window.

7.2 Run the model

You will publish your service from the result, not from the model itself. Therefore, before you publish, you must first run the model. This step also helps you confirm whether your model works as expected.

1. On the ArcMap main menu bar, click Geoprocessing > Geoprocessing Options.
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2. In the Geoprocessing Options dialog box, select the check box for Overwrite the outputs of geoprocessing operations and click OK.
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This option enables you to run your model many times without having to specify a different output feature class for each run.

3. Click Geoprocessing > Environments.
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4. Click Workspace to expand it. For Current Workspace, navigate to C:\EsriPress\GTKWebGIS\Chapter7 and click Lab_Data.gdb. Set the same for Scratch Workspace and click OK.
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The Scratch workspace is where ModelBuilder writes intermediate datasets—datasets that are of no use once a model runs.

5. In the Catalog window, double-click the Select_Sites model to run it.
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6. Specify the inputs:

• Next to the point symbol, click Input_Location_Of_Interest, and click a location on the map that is close to rivers and railroads; otherwise, you might get an empty output.

• Leave the rest of the parameters at the default values.

• Click OK to run the model.
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7. Once the model has successfully completed its run, if the dialog box does not close automatically, close it manually.
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The model results have been added to ArcMap.

8. Examine the results in ArcMap. Keep in mind that these sites sit close to the location you clicked on the map, and close to rivers and railroads.
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7.3 Publish the results as a geoprocessing service

1. On the ArcMap main menu bar, click Geoprocessing > Results.
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2. In the Results window, expand Current Session and expand the Select_Sites tool result.
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Here you find information about the inputs, environments, and messages generated when you ran the model.

3. In the Results window, right-click the Select_Sites tool and click Share As > Geoprocessing Service.
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4. In the Share as Service dialog box, perform the following:

• Select Publish a service and click Next.

• From the Choose a connection drop-down list, click the connection to your ArcGIS Server, specify a service name (e.g., Planning), and click Next.

• Select Use existing folder, click your folder name, and click Continue.

In a classroom setting where many students share one ArcGIS Server, make sure the string combination of your folder name and service name is unique.
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5. In the Service Editor window, click the Parameters tab, and set Execution Mode as Synchronous because this task will not take long to run.
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Also notice under the Asynchronous option, there is the View results with a map service option. This option returns a GP task result as an image (e.g., a .jpeg file). The returned map’s symbology, labeling, transparency, and other properties are the same as the output layer in your current ArcMap session.

You will want to use a result map service on several occasions, including:

• When your GP task generates too many features for your web clients to draw efficiently

• When the result of your task is raster images

6. Click the Select_Sites tab to specify the properties of the input and output parameters as follows:

• Click Input_DistanceToRailroad, and set its description as Enter the distance to railroads.

• Click Input_DistanceToRivers, and set its description as Enter the distance to rivers.

• Click Input_DistanceOfInterest, and set its description as Enter the distance of rivers and railroads to the location of interest.

• Click Input_Location_Of_Interest, and set its description as Enter the location of interest.

• Click Output_PossibleSites, and set its description as Resulting sites meeting the criteria.

[image: images]

7. Click the Item Description tab to define the service metadata as follows:

• For Summary, type Planning for the new factory.

• For Tags, type site selection, Getting to Know Web GIS.

• For Description, type the following: This service provides a tool to select those sites that are close to the area users are interested in, close to rivers, and close to railroads.
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8. On the toolbar of the Service Editor window, click the Analyze button [image: images].

Your Prepare window should look like the following figure.
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• There are no error messages.

• You may get two high-severity warnings: “Data source is not registered with the server” and “Data will be copied to the server.” You saw this in chapter 3. Ignore them or set up a data store (refer to chapter 4).

9. Click the Publish button [image: images]. If a prompt asks you to copy the data to the server, click OK. When a message window announces that your service is published, click OK.

7.4 Explore your geoprocessing service in the Services Directory

ArcGIS Services Directory can help verify whether your GP service is published and working correctly. It can also help developers using your GP service understand and test it.

1. Start a web browser and navigate to the Services Directory in ArcGIS for Server.

The URL is something like: http://your_server_name/arcgis/rest/services or http://your_server_name:6080/arcgis/rest/services.

2. On the home page in the Services Directory, click your folder, if you specified one when publishing the service.

3. Find the geoprocessing service you just published and click it.

[image: images]    Note: the GPServer notation indicates that your service is a geoprocessing service.
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4. You can see the Select_Sites task in this geoprocessing service. Click it.
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This opens the REST page of this task.

5. Observe the task description and the input and output parameters that you specified while publishing your service. Write down the REST page URL.
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The REST URL of the GP task is:



You will need this URL when executing this GP task in section 7.5.

6. Notice that Supported Operations include Execute Task, which indicates this is a synchronous task.

For an asynchronous task, the supported operation would be Submit Task instead.

7. Click Execute Task.

This opens the Execute Task page.

8. For Input_Location_Of_Interest, find "features": [], and between the brackets, copy or type the following:

{"geometry":

{"x":-9642522.728027394, "y":3959878.099522273, "spatialReference":

{"wkid":102100}}}.
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This specifies a point in JSON (JavaScript Object Notation) format. You will learn more about JSON in chapter 8.

9. For the rest of the input parameters, leave the default values as they are. Then click the Execute Task (POST) button.

This is a synchronous task, so you can simply wait for the service to finish.

10. Once the task is completed, the result comes back as something similar to the screen capture.
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The resultant feature set is in JSON format, which your web clients can use to display on maps. There are no error messages or warnings. This confirms that your geoprocessing service has been created successfully and is running properly.

7.5 Use your GP service in Web AppBuilder for ArcGIS

This section does not get into the details of Web AppBuilder for ArcGIS. Refer to chapter 6 for details about Web AppBuilder.

1. If you are using the developer edition of Web AppBuilder, start a web browser, and navigate to your Web AppBuilder for ArcGIS home page. If you are using the integrated edition, log on to ArcGIS Online or your Portal for ArcGIS, create a web map (e.g., an empty web map—you will have chances to change it later), save it, share it, and then click the Make a Web Application button. In the Share window, click the Web AppBuilder tab; specify your app title, tags, and summary; click the Get Started button; and go to step 3.

2. Click Create New to create a new app and click 2D. Specify an app name (for example, New Factory Site Selection), and for Summary, add a description. Then click OK.
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3. Click the Map tab and then the Choose Web Map button.
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4. A web map showing the railways and rivers of Alabama has been created for this tutorial. To use this web map, click the Public tab, select ArcGIS.com, and type Rivers and Railways Getting to Know Web GIS to search for it. Select the web map from the results and then click OK.
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The map zooms to Alabama and displays the state’s rivers and railways. This web map shows the rivers and railways that the GP service will use.

5. Click the Widgets tab and then click the Set the widgets in this controller link.
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6. Click the Click here to add widget button, click the geoprocessing widget, and click OK.
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7. Hover the mouse over the geoprocessing widget, and click the pencil icon [image: images] to configure this widget.
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8. In the geoprocessing widget configuration window, perform the following:

• Set the widget name as Site Selection.

• For Task URL, click the Set button to type or paste the task URL that you wrote down in step 5 of section 7.4. Click Validate and click OK.
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Note that the input and output parameters have been detected and listed.

• Click the Output parameter and change Label and Tooltip to Possible Sites.

• Change the output display renderer to use A Single Symbol. Then choose the polygon fill color and outline color.

• As an option, click each of the Input parameters to change their labels and tooltips to make the names meaningful to users and easier to read.

• Click OK to close the widget configuration window.
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Your widget is now configured. You can use this widget in your web app.

9. On the toolbar, click the Site Selection button. Set the values for the input parameters or use the default values. Under Location of Interest, click the point icon. Click a location close to rivers and railroads on the map to specify your area of interest and then click Execute.
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The request is submitted to the server. After a few moments, the resulting set of possible sites for the new factory is returned and displayed on the map.
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10. Click the Save button to save your web app configuration.

11. You can optionally deploy the web app to a web server (as you did in chapter 6).

In this tutorial, you finished a model in a toolbox, published it as a GP service, explored it in ArcGIS Services Directory, and used it in a web app. With this app, executives and other nonprofessional users can explore different scenarios and, in the case of this tutorial, select the best site for a new factory.

QUESTIONS AND ANSWERS

1. ModelBuilder or Python: Which one should I use to author my model or tool?

Answer: The answer varies depending on what you wish to accomplish and what your current skill sets are.

Use ModelBuilder if you are new to both and need to get the work done quickly.

• ModelBuilder is much easier and quicker to learn than Python.

• It excels at visually and intuitively depicting the workflow for most tasks that you want to accomplish.

• Even if you prefer to learn Python, ModelBuilder can be a better place to start. It can export some models to Python scripts, so the skeleton of the script is already written for you.

If you already know Python or have more time to learn it, use Python.

• Python is a scripting language. You can accomplish more complex workflows and exert more fine-grained control. For example, simple text manipulation is difficult using ModelBuilder, whereas Python makes the task much easier.

• With additional libraries or modules, Python can better integrate with other software tools, such as Microsoft Excel, statistical Package R, or procedures in an RDBMS (relational database management system).

• In addition to using your tool to create a GP service, you may also want to run your Python script outside ArcMap or schedule it to run at a certain time.

2. How do I publish a GP service that combines multiple tasks?

Answer: Here are the steps:

• Run each of the tools or models that you want to include in the service.

• Publish the result of the first model or tool.

• While you are in Service Editor, click the Add Result button, and choose another result to add to the service. Each result then becomes a task in your service.

3. Can one task produce multiple outputs?

Answer: Yes.

• If you are using ModelBuilder, just right-click the final outputs or intermediate outputs, and set them as parameters.

• If you are using Python, use arcpy.SetParameter(index, value) or arcpy.SetParameterAsText(index, value). You can define the data type of each output parameter in the tool properties window.

ASSIGNMENTS

Assignment 7: Create a Web App to Clip, Zip, and Ship GIS data

A survey and mapping bureau would like to improve its data sharing workflow. Instead of extracting and copying data manually to serve its customers, the bureau wants to automate the workflow with a web app.

Data: The data is located at C:\EsriPress\GTKWebGIS\Chapter7\Assignment_Data. It contains the following:

• data.gdb, which has the earthquake and hurricane layers that your users can download

• natural_disasters.mxd, which display these data layers

• ExtractData.tbx, which contains ExtractData, a to-be-completed model for data clip/zip/ship

Requirements: This web app should allow its users to serve themselves. They should be able to select the layers they need, draw the area they are interested in, select the data projection and format they want, and have the data clipped and zipped for them to download.

[image: images] Tips:

• Open natural_disasters.mxd in ArcMap.

• Edit the ExtractData model, and set Layers to Clip, Feature Format, Area of Interest, and Output_zip File as model parameters.

• Run the ExtractData model, and publish the result of the model as a GP service.

• Examine your GP service task in ArcGIS Services Directory.

• Create a web app using Web AppBuilder for ArcGIS:

• Use the web app you created in the chapter 6 tutorial. This web app displays the earthquake and hurricane layers so that users can see where the earthquakes and hurricanes are.

• Add the geoprocessing widget, and configure it to point to the ExtractData task in your GP service.

[image: images]    Note: This assignment is similar to the ArcGIS Server Clip and Ship Geoprocessing Service example in ArcGIS Help, where you can find some helpful instructions (http://resources.arcgis.com/en/help/main/10.2/index.html#/Clip_and_ship/005700000073000000).

What to submit: E-mail your instructor with the subject line Web GIS Assignment 7: Your name, and include the following:

• The URL to your GP task

• The URL to your web app

Resources

ArcGIS for Server Help document site

“A Quick Tour of the Geoprocessing Service Examples,” http://resources.arcgis.com/en/help/main/10.2/index.html#/A_quick_tour_of_the_geoprocessing_service_examples/005700000088000000.

“Geoprocessing Service Example: Clip and Ship,” http://resources.arcgis.com/en/help/main/10.2/index.html#/Clip_and_ship/005700000073000000.

“Geoprocessing Service Example: Watershed,” http://resources.arcgis.com/en/help/main/10.2/index.html#/Watershed/00570000006t000000.

“Tutorial: Publishing Additional Services for Printing,” http://resources.arcgis.com/en/help/main/10.2/index.html#/Publishing_additional_services_for_printing/00570000009s000000.

“Overview of the Network Analyst Geoprocessing Service Examples,” http://resources.arcgis.com/en/help/main/10.2/index.html#/Network_Analyst_Overview/00570000009r000000.

“Tutorial: Creating Tools with ModelBuilder,” http://resources.arcgis.com/en/help/main/10.2/index.html#/What_is_ModelBuilder/002w00000001000000.

“Authoring Geoprocessing Tasks with ModelBuilder,” http://resources.arcgis.com/en/help/main/10.2/index.html#//00570000007s000000.

“Authoring geoprocessing tasks with Python scripts,” http://resources.arcgis.com/en/help/main/10.2/index.html#/Authoring_geoprocessing_tasks_with_Python_scripts/00570000007r000000.

Esri Training website

“Gain Geographic Insight with ArcGIS Online Analysis Tools,” http://training.esri.com/gateway/index.cfm?fa=catalog.webCourseDetail&courseid=2717.

“Python for Everyone,” http://training.esri.com/gateway/index.cfm?fa=catalog.webCourseDetail&courseid=2520.

“Introduction to Geoprocessing Scripts Using Python,” http://training.esri.com/gateway/index.cfm?fa=catalog.courseDetail&CourseID=50131064_10.x.

“Sharing Analysis Workflows on the Web Using Geoprocessing Services,” http://training.esri.com/gateway/index.cfm?fa=catalog.webCourseDetail&courseid=2507.

Esri videos

“ArcGIS Online with Jack Dangermond & Lauren Bennett,” http://video.esri.com/watch/2515/arcgis-online-with-jack-dangermond-_and_-lauren-bennett.

“What Is Spatial Analysis and Geoprocessing?” http://video.esri.com/watch/2993/what-is-spatial-analysis-and-geoprocessing_question_.

“Building Geoprocessing Tools with Python,” http://video.esri.com/watch/2936/building-geoprocessing-tools-with-python.

“Geoprocessing with ArcGIS for Server,” http://video.esri.com/watch/2737/geoprocessing-with-arcgis-for-server.

“Creating Tools in a Python Toolbox,” http://video.esri.com/watch/2330/creating-tools-in-a-python-toolboxPart number (type over existing text).




Chapter 8

Getting started with ArcGIS API for JavaScript

You have learned how to create web applications using ArcGIS Online templates and Web AppBuilder for ArcGIS. These ready-to-use web apps provide a lot of rich functionality, but they may not meet all your project requirements. In such cases, you will need to program your own applications or customize your existing web apps. ArcGIS API for JavaScript provides libraries for you to develop web GIS apps. This chapter gets you started using the JavaScript API, so you will know how to adapt JavaScript samples, add Dojo widgets (or dijits), and debug JavaScript.

Learning objectives

• Understand the basics of ArcGIS API for JavaScript.

• Get started with JavaScript debugging and HTTP traffic monitoring.

• Adapt JavaScript samples.

• Incorporate dijits.

This chapter in the big picture

[image: images]

ArcGIS offers many ways to build web applications. The red oval in the figure highlights the technology chapter 8 teaches.

Why JavaScript?

JavaScript is the most widely used programming language in the world today. Almost all web pages now include some JavaScript code. JavaScript interacts with the server to utilize its capabilities and interacts with end users to make web pages dynamic and interactive.

Unlike web services, which run on the server side, JavaScript typically runs on the browser side. All web browsers support it. This makes JavaScript more popular than plug-in technologies such as Adobe Flash and Microsoft Silverlight.

JavaScript’s cross-platform capabilities outdo native desktop apps and mobile apps. Developed correctly, a single JavaScript web app can run on both desktop browsers and mobile browsers. This proves much less time consuming and less costly than writing multiple native apps to support multiple platforms.

With JavaScript, it is easy to get started. You do not need a professional integrated development environment (IDE). No need to compile a JavaScript program, either. Just write it using any clear text editor and then load it into a web browser and run it.

HTML and CSS

For JavaScript, you also need to know basic Hypertext Markup Language (HTML) and Cascading Style Sheet (CSS). JavaScript works in conjunction with them to build web apps.

• HTML is a markup language used to package your content.

• CSS is a formatting language used to style content.

• JavaScript creates dynamic and interactive features for your web pages.

It is important to have some basic knowledge of HTML and CSS when programming with JavaScript. HTML, CSS, and JavaScript are the foundation of ArcGIS API for JavaScript. Many students do not have this foundation and thus find it difficult to learn the JavaScript API.

If you lack knowledge of HTML, CSS, or JavaScript, you can get a quick education at this tutorial website, http://www.w3schools.com.

ArcGIS API for JavaScript

The JavaScript API is built on top of JavaScript, CSS, and HTML, including the new features of HTML5. The JavaScript API runs on the client side. Its capabilities fall into two main categories:

• Interacting with GIS servers and thus providing mapping, query, statistics, geoprocessing, editing, and other GIS functions

• Presenting the responses of GIS servers to end users and interacting with them

When writing a web app using the JavaScript API, you generally follow four steps illustrated in the following chart.
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Four steps to using the JavaScript API. The <div> tag defines a division or section in an HTML document.

ArcGIS API for JavaScript hosts libraries in the cloud. You do not have to download or install it manually. Simply reference the libraries using the <script> and <link> tags, with URLs pointing to the API. Organizations that require more secure access (e.g., where no external Internet connection is allowed) have the option to download and host the API on their local network.

As a developer, you will use the API website extensively. The URL is http://links.esri.com/javascript. On this site, you can find the API references, instructions, and samples.

[image: images]

The Help document site for ArcGIS API for JavaScript.

ArcGIS API for JavaScript builds on top of Dojo, a JavaScript framework, or toolkit, that helps reduce development efforts and enhance cross-browser capability. If you have experience with another JavaScript framework, such as jQuery, you can use it with the API, too.

ArcGIS REST API

The JavaScript API relies on the ArcGIS REST (Representational State Transfer) API. In previous chapters, you learned how to publish various web services using ArcGIS for Server, ArcGIS Online, and Portal for ArcGIS. These services and ArcGIS web maps expose their capabilities via the ArcGIS REST API. ArcGIS Web APIs and Runtime SDKs, including the JavaScript API, call the server via the REST API. Indeed, in terms of server-side capabilities, the JavaScript API can deliver only what the REST API can.
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ArcGIS for JavaScript relies on the ArcGIS REST API to interact with
ArcGIS for Server, ArcGIS Online, and Portal for ArcGIS.

With the ArcGIS REST API, all resources and operations are exposed through a hierarchy of endpoints or URLs. The REST endpoint of a map service is typically in the format of http://<machine_name>/arcgis/rest/services/<folder_name>/<service_name> (e.g., http://sampleserver6.arcgisonline.com/arcgis/rest/services/Wildfire/MapServer).

The endpoint for the first layer in this map service appends a layer number, starting with 0 for the first layer (e.g., http://sampleserver6.arcgisonline.com/arcgis/rest/services/Wildfire/MapServer/0).

These REST URLs are what you use in JavaScript and mobile SDKs to call the map service to generate a map or the layer to do a query. As you learned in chapters 3, 4, 5, and 7, ArcGIS Services Directory is a good place to explore the ArcGIS REST API. For example, a map service supports the export operation. If you click the Export Map link on the Services Directory page of the map service, you get a URL such as this: http://sampleserver6.arcgisonline.com/arcgis/rest/services/Wildfire/MapServer/export?bbox=-1.2639220509974683E7,4510010.034310617,-1.1305717842969349E7,4980969.309562501.

If you append &f=json to the preceding URL to generate a map, the new URL would be http://sampleserver6.arcgisonline.com/arcgis/rest/services/Wildfire/MapServer/export?bbox=-1.2639220509974683E7,4510010.034310617,-1.1305717842969349E7,4980969.309562501&f=json. This would be the URL that the JavaScript API would send to ArcGIS for Server to request the map service to generate a map. The response in JSON format would resemble the following screen capture.
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Response to a map request in JSON format.

The response is not easy to read because it is meant for the JavaScript API to parse and present. If you want the JSON response to be more readable, you can use the pretty JSON format—that is, use f=pjson instead of f=json in the request URL. You will find the response much easier to read, as in the following screen capture.



{

"href":

"http://sampleserver6.arcgisonline.com/arcgis/rest/directories/arcgisoutput/Wildfire_MapServer/_ags_map095bd65ee0494867b2edfd0a18f1a6aa.png",

"width": 400,

"height": 400,

"extent": {

"xmin": -12639220.509974683,

"ymin": 4078738.3384338925,

"xmax": -11305717.842969349,

"ymax": 54122 41.0054392265,

"spatialReference": {

"wkid": 102100,

"latestWkid": 3857

}

},

"scale": 12600000

}

Response to a map request in pretty JSON format is much easier to read.

Main classes and their properties, methods, and events

ArcGIS API for JavaScript provides many classes. The most commonly used are as follows:

• Map: this is the main container to hold various map and data layers.

• Layers, including many subclasses:

• Dynamic map service layer

• Image service layer

• Tiled map service layer

• KML/WMS/WMTS (Web Map Tile Service) layers

• Graphics layer

• Feature layer, a kind of graphics layer

• Stream layer, a kind of feature layer

• Symbols, for rendering or displaying graphics, including feature layers:

• Point symbols, such as SimpleMarkerSymbol and PictureMarkerSymbol

• Line symbols, such as SimpleLineSymbol and CartographicLineSymbol

• Polygon symbols, such as SimpleFillSymbol and PictureMarkerSymbol

• Text symbols

• Tasks, such as QueryTask, FindTask, IdentifyTask, PrintTask, and RouteTask. These tasks allow you to perform attribute or spatial searches on individual or all layers in a map service, print a group of layers and graphics, find optimal routes, and more.

Each class has the following:

• Properties you can get or set (e.g., a map has a width and a height).

• Methods you can use with the class or have the class perform (e.g., addLayer and addLayers to a map).

• Events that you can monitor, such as when something is ready, started, completed, moved, displayed, or an error. You may trigger some functions in response to these events (e.g., a map can fire a click event when being clicked and fire a layer-add-result event whenever a layer or an array of layers has been added).

Play with the samples in the sandbox

If you want a quick and easy way to learn ArcGIS API for JavaScript, play with the samples. Most samples at the API website have an “Explore in the sandbox” link. Click the link, modify the sample source code in a text box in your web browser, and run your code right in the browser, without ever installing your own web server.
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You can learn and play with the code samples directly in your browser.

In general, when adapting a sample, follow these three steps, as illustrated in the following figure. First, replace the web service or layer URL(s). Second, replace the attribute field names with those of the new service(s) or layer(s). The third step, replacing the related symbols, often involves feature layers and graphics. For example, a sample app highlights some lines using a line symbol. If you want this sample to work with a point layer, match the feature type by changing the line symbol to a point symbol.
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Three general steps to adapting a JavaScript sample.

Whenever you work with a web app development project, it is often more cost effective to start with a sample from the API website, an ArcGIS Online or Portal for ArcGIS template, an application at Esri GitHub (https://github.com/Esri), or the Web AppBuilder for ArcGIS Framework.

Incorporating dijits or widgets

A dijit, a JavaScript widget built using Dojo, is a self-contained piece of visual functionality that you can easily incorporate into your JavaScript apps. The JavaScript API provides a range of dijits, as illustrated in the following figure.
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ArcGIS API for JavaScript provides many kinds of dijits, including legend, attribute inspector, gauge, geocoder, InfoWindow, editor, and directions dijits.

Generally, there are four steps to adding a dijit to your web app, as illustrated in the following figure.
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Four steps to adding a dijit to your web app.

Choose the right layer types

When adding data to your app, you have to choose what type of layer to use.

Some data sources are easy to decide. For example, you may need to use a tiled map service layer for a tiled map service or a WMTS layer for a WMTS layer source.

However, other sources can make decisions trickier. Often you must choose between a dynamic service layer and feature layer approach. A dynamic map service can be displayed as a dynamic map service layer. Its individual layers can be displayed as feature layers. Refer to the section in chapter 3, “Dynamic map service layers versus feature layers,” to compare.

IDE and debugging

Inevitably, you will make typos or other errors while writing programs. JavaScript IDEs such as Aptana and Microsoft Visual Studio can address this situation and thus ease your programming experience by providing syntax highlighting and IntelliSense. IntelliSense, a context-aware code completion feature, helps reduce misspellings, typos, and other common mistakes.

As a developer, you will often need to use debugging tools. Otherwise, it can be frustrating to identify even a little typo. Firefox with Firebug add-on, Google Chrome, Microsoft Internet Explorer 10, and Safari all provide developer tools. They can

• display JavaScript errors that come up at runtime in the consoles,

• inspect HTML elements and modify their styles and layout in real-time,

• pause the execution of your code at the breakpoints you set so that you can examine the variable values and the status of the document object model (DOM), and

• monitor network activities so that you can analyze the network usage and improve the performance of your code.

This tutorial

This tutorial displays an earthquake layer in the map service that you published in chapter 3.

In the process of developing your first app with programming, you learn how to explore and modify JavaScript samples in the ArcGIS API for JavaScript sandbox, deploy your web app to your web server, debug JavaScript, and enhance samples and incorporate dijits.

Data: Use the earthquake layer of the natural disaster map service you published in chapter 3.

Requirements: Your web app should do the following:

• Display the earthquake layer, along with a legend dijit.

• When the user’s mouse hovers over an earthquake, highlight the earthquake, display its attributes in a pop-up window, and use the gauge dijit to display the earthquake magnitude relative to the maximum magnitude event recorded.

• Allow users to select earthquakes with magnitudes greater than a user-specified value, highlight the selected earthquakes, and display a short summary of them.

System requirements:

• A web browser: Chrome, to learn debugging.

• A web server: sections 8.3, 8.4, and 8.5 assume that you use a computer running Windows and have IIS (Internet information services) installed.

• Type http://localhost on your computer to see if you have IIS installed. If not, install it.

• If you are using a Mac or Linux operating system, use Tomcat or Glass Fish as your web application server.

• Notepad++: For editing JavaScript code. Download it at http://www.notepad-plus-plus.org. Notepad++ is easy to use. This way, the book does not introduce the overhead of learning a professional IDE for this chapter.

• ArcGIS Online or Portal for ArcGIS: for serving the basemap.

• ArcGIS for Server: for serving the natural disaster map service.

8.1 Build your first app

This section is available online at the “Build your first application” page of the ArcGIS API for JavaScript website (http://bit.ly/1k7OC29, short for https://developers.arcgis.com/javascript/jstutorials/intro_firstmap_amd.html). Be sure to read this page and run this app in the sandbox (http://bit.ly/1ilMdPE, short for http://developers.arcgis.com/javascript/sandbox/sandbox.html?sample=map_create_amd).

While reading this page, notice that this simple app exemplifies the four steps mentioned under the section “ArcGIS API for JavaScript” earlier in the chapter: reference the API library and styles; define the HTML div to hold the map and other dijits; load the required modules; and code the functions.

8.2 Adapt a sample

In this section, display the earthquake layer of your map service, which is one requirement of this tutorial.

Start with a sample, and adapt it by following the three steps mentioned earlier in this chapter: replace the web service or layer URL(s), the attribute field name(s), and the related symbol(s).

[image: images]    Notes:

• These steps involve a lot of typing. To avoid typos, refer to the source code at C:\EsriPress\GTKWebGIS\Chapter8\fl_hover.html, or simply copy the piece of source code you need as you work on the following steps.

• Keep in mind that indentation does not matter in JavaScript. However, best practice is to indent in order to make your code easier to read.

• If you do not see a change you have made, clear the browser cache, or configure your browser to always read the latest version of your program. The workflow is different depending on your browser. See the “Questions and Answers” section at the end of this chapter.

• Use Ctrl+F to search for certain words in your code when the instructions ask you to find a specific item or word.

1. Find the Feature layer hover sample on the ArcGIS API for JavaScript website (http://links.esri.com/javascript) by clicking Samples > Query and Select > Feature layer hover, or simply click http://bit.ly/1kdV1W5 (short for https://developers.arcgis.com/en/javascript/jssamples/fl_hover.html).
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2. Click the Explore in the sandbox link, play with the application, and review the code.

This application displays a basemap and a feature layer of all the counties in South Carolina, listens to the mouse-over event, and displays a pop-up window in response. The pop-up content is defined using an HTML string that contains the attribute values. For example, ${NAME} is replaced by the value of the NAME attribute for the county over which the mouse cursor hovers.

[image: images]

3. Change the map center to –110, 40; zoom level to 3, as illustrated; and then click the Run button.

map = new Map("mapDiv", {

basemap: "streets",

center: [-110, 40],

zoom: 3,

slider: false

});
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Notice the map extent now covers the continental United States, which covers all the earthquakes in the layer you will be using.

4. In the source code, find and replace the South Carolinian counties layer URL (http://sampleserver1.arcgisonline.com/ArcGIS/rest/services/Demographics/ESRI_Census_USA/MapServer/3) with the URL of your earthquake layer.

The earthquake layer is in the natural disaster map service you published in chapter 3.

If yours is not available, you can also use the layer at http://esrimapbook.esri.com/arcgis/rest/services/GTKWebGIS/natural_disasters/MapServer/0.

5. Change the attribute fields from

outFields: ["NAME", "POP2000", "POP2007", "POP00_SQMI", "POP07_SQMI"]

to

outFields: ["LOCATION", "OTHER_MAG1", "DEPTH_KM", "EQ_DATE"]

or

outFields: ["*"]

It is best practice to list only those fields you will need. Using "*" will pull all the attribute fields.

6. Remove the following lines in the source code:



southCarolinaCounties.setDefinitionExpression("STATE_NAME = 'South Carolina'");

var symbol = new SimpleFillSymbol (

SimpleFillSymbol.STYLE_SOLID,

new SimpleLineSymbol(

SimpleLineSymbol.STYLE_SOLID,

new Color ([255, 255, 255, 0.35]),

1

),

new Color ([125, 125, 125, 0.35])

);

southCarolinaCounties.setRenderer (new
SimpleRenderer (symbol));

These lines define a query to retrieve only the counties in South Carolina and a new symbol to overwrite the symbol of the map service. They do not apply to the earthquake layer, so they should be removed from the code, as illustrated in the screen capture.
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7. Click the Run button. The earthquakes are displayed.
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[image: images]    Note: your symbology for the earthquake layer may be different from the screen captures here and in steps 8 through 14.

8. Hover the mouse over an earthquake. A pop-up window appears. Note that the pop-up content displays incorrect names and empty values that need to be corrected.

See the pop-up content defined in the sample illustrated in the screen capture. Strings such as 2000 Population are attribute field aliases. Others like ${NAME} represent actual attribute field values. You will need to change the attribute names to those of the earthquake layer.



var t = "<b>${NAME}</b><hr><b>2000 Population:

</b>${POP2000:NumberFormat}<br>"

+ "<b>2000 Population per Sq. Mi.:

</b>${POP00_SQMI:NumberFormat)<br>"

+ "<b>2007 Population:

</b>${POP2007:NumberFormat}<br>"

+ "<b>2007 Population per Sq. Mi.:

</b>${POP07_SQMI:NumberFormat}";

9. Replace the lines of source code illustrated in step 8 with the lines that follow. Click the Run button and hover the mouse over an earthquake to see that the pop-up window has been corrected.



var t = "<b>${LOCATION}</b><hr><b>Magnitude:

</b>${OTHER MAGl}<br>"

+ "<b>Depth (KM): </b>${DEPTH_KM) <br>"

+ "<b> Date: </b>${EQ_DATE: DateFormat}";
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[image: images]    Notes:

• The attribute names are case sensitive. No space(s) should lie between an attribute name and the surrounding brackets ({ }).

• ${EQ_DATE: DateFormat} converts the date field into a readable format.

• You can find the attribute names on the layer page in ArcGIS Services Directory and then copy and paste them into your code.

Alternatively, use the following lines to define the pop-up content. It will display all the attribute fields.

var t = "${*}";

10. Hover the mouse over an earthquake, and note that it is not highlighted. This is because the highlighting symbol defined in the sample is SimpleFillSymbol, which works for polygons but not for points. To highlight the earthquakes, you must use a point symbol, such as SimpleMarkerSymbol.

Consult the API reference (https://developers.arcgis.com/javascript/jsapi/simplemarkersymbol-amd.html) to learn how to use the SimpleMarkerSymbol. As you can tell from the reference, the symbol can have an optional outline, which is defined by a line symbol. Therefore, you need to load the esri/symbols/SimpleMarkerSymbol and esri/symbols/SimpleLineSymbol modules, as shown in a sample on the reference page.

11. The SimpleLineSymbol is already in the require and function arguments. For a point symbol, simply change SimpleFillSymbol to SimpleMarkerSymbol.



require([

"esri/map", "esri/layers/FeatureLayer",

"esri/Symbols/SimpleMarkerSymbol ",

"esri/symbols/simpleLineSymbol",

"esri/renderers/SimpleRenderer", "esri/graphic",

"esri/lang",

"dojo/_base/Color", "dojo/number", "dojo/dom-style",

"dijit/TooltipDialog", "dijit/popup",

"dojo/domReady!"

], function(

Map, FeatureLayer,

SimpleMarkerSymbol, SimpleLineSymbol,

SimpleRenderer, Graphic, esriLang,

Color, number, domStyle,

TooltipDialog, dijitPopup

12. Find the following lines of script:



var highlightSymbol = new SimpleFillSymbol (

SimpleFillSymbol.STYLE_SOLID,

new SimpleLineSymbol(

SimpleLineSymbol.STYLE_SOLID,

new Color ([255, 0, 0]), 3

),

new color ([125, 125, 125, 0, 0.35])

);

13. Replace them with the following lines of script:



var highlightBorder = new

SimpleLineSymbol(SimpleLineSymbol.STYLE_SOLID,

new color ([255, 0, 0]), 1);

var highlightSymbol = new

SimpleMarkerSymbol (SimpleMarkerSymbol.STYLE_CIRCLE, 15,

highlightBorder,

new Color ([0, 255, 0, 0.5]));

These lines first define a simple symbol of a red solid line. They then define a simple marker symbol, using this line as the border, and the marker symbol is filled with green color, with 50% transparency.

14. Click the Run button. Hover the mouse over an earthquake. This time, you should see the earthquake highlighted with a new symbol.
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The label at the top, “Hover over a county in South Carolina to get more information,” is not appropriate for earthquakes. Correct it in step 15.

15. Find Hover over a county in South Carolina to get more information in the HTML. Replace it with Hover over an earthquake to get more information and click the Run button.

You should see the corrected label.
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In this step, you adapted a sample by changing the layer’s URL, attribute names, and symbols.

If you run into any errors, you can get the source code at C:\EsrIPress\GTKWebGIS\Chapter8\fl_hover.html, or copy the source code you need from it. You will learn how to debug your JavaScript in section 8.4.

8.3 Deploy your app to your web server

Although the sandbox editor is easy to start with, it has some limitations. It is not easy to debug. It is difficult to develop a large application with multiple files. Most important, you cannot expect your end users to use this interface; you will need to deploy your code to a web server.

This section assumes you have a computer running Windows with IIS installed. If you use Mac or another operating system, you can use Tomcat, Glass Fish, or another web application server. However, you will need to modify the file paths and URLs in this section according to your computer’s configuration.

1. Make a web folder by creating a subfolder named JS under C:\inetpub\wwwroot.

Alternatively, you can configure a virtual web directory.
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You will be adding files to this folder and editing them. Thus, make sure you have the Modify permission for this folder and all its files in step 2.

2. In Windows Explorer, navigate to C:\inetpub\wwwroot. Right-click the JS folder and click Properties. Click the Security tab and then Users under Group or user names. Click the Edit button, click Full control, and then click OK. Click OK again to close the Permissions and Properties windows.
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Next, permit everyone to access this website.

3. In Windows Explorer, navigate to C:\inetpub\wwwroot. Right-click the JS folder and click Properties. Click the Security tab and then the Edit button. Click the Add button, and under Enter the object names to select, type Everyone. Click the Check Names button and then click the OK buttons to close the windows.
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4. Go to the ArcGIS API for JavaScript Sandbox window where you left off at the end of section 8.2. Click the Download button to download the JavaScript code.
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If you already closed the window from section 8.2, you can get a copy of the source code at C:\EsrIPress\GTKWebGIS\Chapter8\fl_hover.html.

5. Copy the downloaded file or C:\EsriPress\GTKWebGIS\Chapter8\fl_hover.html to C:\inetpub\wwwroot\JS.
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Make sure you keep the file extension as .html.

6. Start a web browser. Go to http://localhost/js/fl_hover.html.
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7. Replace the generic name localhost with your computer’s name, if you know it. Make sure that your web app works like the screen capture in step 6. If so, this means your web app has deployed to your web server.

If you do not see your web app loaded, this may be because you do not have IIS installed or the IIS server is not on. Check with your instructor or search the web to find out how to install IIS and how to start the IIS service, which is listed as World Web Publishing Service in your Windows Services list.

A JavaScript web app often has many files and folders. You can deploy them much like you did in this section. Simply extract or copy the files and folders to the target web folder on your web server.

8.4 Debug JavaScript, monitor HTTP traffic, and inspect elements

In this section, you will make some errors intentionally to illustrate how to debug JavaScript, monitor HTTP requests to and responses from your GIS server, and inspect HTML elements. These are useful skills that can save you a lot of frustration and greatly increase your production.

This application does not display South Carolina’s counties anymore, so the variable southCarolinaCounties no longer applies. Although it is okay to leave the variable name unchanged, we advise you to rename it as something more appropriate, such as operationalLayer.

The variable southCarolinaCounties appears three times in the code. Instead of replacing all three at once, replace them one by one so that you can use this process to learn JavaScript debugging.

1. In Notepad++ or another editor, navigate to C:\inetpub\wwwroot\JS\fl_hover.html. Find the first southCarolinaCounties variable and change it to operationalLayer. Save your program.

[image: images]

If you do not have Notepad++, download it from http://notepad-plus-plus.org and install it.

2. Start Chrome, navigate to http://localhost/js/fl_hover.html, and press the F12 key to open the Developer Tools interface.

Alternatively, you can open the Developer Tools by clicking the Options button and clicking Tools > Developer Tools.

[image: images]

3. Click the Console button to see an error message, along with the line that contains the error. Click the line that has the error.

The source code appears with the error line annotated.

[image: images]

4. In Notepad++, locate the line with the error, as indicated by the browser console (line 60 in this example). Change southCarolinaCounties to operationalLayer. Save your program.

[image: images]

5. Reload http://localhost/js/fl_hover.html in your web browser, and view the error message in the console.

[image: images]

You can see that the previous error was fixed. The new error is on a different line—line 86 in this example.

6. Repeat steps 4 and 5 to fix all the errors associated with the southCarolinaCounties variable name.

Next, learn how to set up breakpoints.

7. In the Chrome Developer Tools window, click the Sources tab and the Sources button, expand your server and web folder, click the fl_hover.html file, and then click the left arrow button on the menu bar to close the left panel.

[image: images]

8. Scroll down the file contents, and find the var operationalLayer = ... line. Click the line number on the left to set up a breakpoint. Similarly, set up another breakpoint on the line map.addLayer(operationalLayer);.

[image: images]

A blue arrow indicates a breakpoint on the line.

9. Reload the fl_hover.html page in Chrome. In the Developer Tools window, you can see that the code stops execution at the first breakpoint.

[image: images]

10. Go to the next breakpoint by pressing the F8 key or the F10 key.

[image: images]

F8 goes to the next breakpoint, whereas F10 goes line by line.

11. Review the variable values while at the second breakpoint. This helps you understand the status of your program.

12. In the Watch Expressions window, click the Plus button, and type a specific variable name (e.g., operationalLayer.url).

[image: images]

Notice its value, on the left of the screen, is the earthquake layer URL. You can use this to validate whether your variables have the correct values.

13. Press F8 to continue. This should finish the execution of the code if you do not have additional breakpoints.

14. In the Sources window of the Developer Tools, remove the breakpoints by clicking the two blue arrows.

[image: images]

Next, observe the HTTP traffic in your web browser.

15. Still in the Developer Tools window, click the Network button and then the All button. Reload the fl_hover.html page if you do not see any contents listed.

Observe the HTTP traffic, including the JavaScript and CSS files now downloaded, as well as the map tiles and feature data requested and downloaded. For each request, hover the mouse over the color button in the Timeline column. You can see the time spent in sending the request, waiting, and then receiving the response.

[image: images]

16. Click the XHR button. This displays only those dynamic requests sent using XMLHttpRequest. These requests include those sent to the map service.

• Find the query URL in the list, and click it to see the HTTP request URL.

• Click the Response tab to see the response in JSON format.

[image: images]

17. Right-click the query URL and click Open link in new tab.

[image: images]

Observe the URL and the response.

[image: images]

This is the communication between your JavaScript and ArcGIS for Server.

18. Change f=json in the URL to f=html and press Enter.

[image: images]

This instructs the ArcGIS Server to return its response in HTML format, which is easier to understand. You should recognize that this is actually a page in ArcGIS Services Directory. The where value is 1=1, which is true for all records. As a consequence, this request gets all the features in the earthquake layer. Understand that this is for the Snapshot mode of feature layers.

If you have a failed query, this page will help you debug it. You can experiment with the where clause, check the result, and find the correct where expression to use in your JavaScript.

Next, learn how to inspect HTML elements and experiment with CSS. Often you will need to position and style an HTML element or overwrite the styles an element inherited. With the Inspect function, you can find out where the styles of an element are defined and how to change or overwrite them.

19. In the Chrome Developer Tools window, click the Inspect button [image: images] and then click the Hover over an earthquake to get more information. label.
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You can then see the style definition of this element on the right side of the Developer Tools window. It indicates the element id is info, and its styles are defined in fl_hover.html, line 21.

20. Experiment with the styles as follows:

• Click the background style definition, and change the color to #00BBBB. You see the background become dark green on the page. Alternatively, you can click the color choice button to choose a color interactively.

• Click the box-shadow style definition, and change the color to #001111. You see the box shadow become darker green.

• Click the left style, change it to right, and change the value to 2em. You see the caption block shifted to the right side of the page, at a distance of about two times the current font size away from the right margin of the page. An em is a scalable unit that is equal to the current font size.
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21. Once you are happy with the styles you have experimented with, edit fl_hover.html to make these changes.

[image: images]

22. Save your changes, and reload fl_hover.html in your web browser to see the new styles.

In this section, you modified the source code slightly to illustrate how to debug JavaScript, track HTTP traffic, and inspect HTML elements. You will find these skills helpful when you develop JavaScript applications.

8.5 Add dijits to your web app

In this section, you add a legend dijit and a gauge dijit by following the four steps mentioned under the section “Incorporating dijits or widgets” earlier in the chapter: add a div, require the module, define the properties, and start it up.

[image: images]    Note: These steps involve a lot of typing. To avoid typos, refer to the source code at C:\EsriPress\GTKWebGIS\Chapter8\add_dijits_key.html, or simply copy the piece of source code you need from it when you work on the following steps.

1. Copy C:\EsriPress\GTKWebGIS\Chapter8\add_dijits.html to C:\inetpub\wwwroot\js\. Open it with Notepad++.

The file add_dijits.html is the same source code you got at the end of section 8.4.

2. In the Body section of the source code, add the lines shown in bold in the screen capture. This creates a division, or div, named leftDiv, which will be used to hold the dijits.



<body class="tundra">

<div id="leftDiv">



</div>

<div id="mapDiv">

<div id="info">

Hover over an earthquake to get more information.

</div>

</div>

</body>



3. In Notepad++, scroll up to the Styles section, and use the lines shown in bold in the screen capture to replace the existing #mapDiv style definition and to add the style definition for leftDiv.



#leftDiv {

width:280px;

height:100%;

float:left;

}

#mapDiv {

position: relative;

margin-left: 280px;

height:100%;

}

These lines define leftDiv as 280 pixels wide and place it toward the left side of the page. And mapDiv starts at 280 pixels from the left margin and occupies the rest of the width of the page.

4. Click the Save button in Notepad++. In a web browser, load the page http://localhost/js/add_dijits.html.

Note the 280-pixel-wide vertical space at the left of the map. This is where you will place the legend and the gauge dijits.

[image: images]

5. Add the two lines shown in bold in the screen capture to the HTML body, inside leftDiv.



<div id="leftDiv">

<div id="legendDiv">

</div>

</div>

This creates a legendDiv element inside the leftDiv. You can place and hold the legend dijit in legendDiv.

6. Refer to the legend API reference (http://developers.arcgis.com/en/javascript/jsapi/legend-amd.html) to learn how the module needs to be loaded and how to create a legend dijit.

7. Add the module and argument shown in bold in the screen capture to the require function to load the legend dijit module and provide a reference to the module.



require([

"esri/map", "esri/layers/FeatureLayer",

"esri/dijit/Legend",

"esri/symbols/SimpleMarkerSymbol",

"esri/symbols/SimpleLineSymbol",

"esri/renderers/SimpleRenderer", "esri/graphic",

"esri/lang",

"dojo/_base/Color", "dojo/number", "dojo/dom-style",

"dijit/TooltipDialog", "dijit/popup",

"dojo/domReady ! "

], function(

Map, FeatureLayer, Legend,



8. Find the following line:

map.addLayer(operationalLayer);

and replace it with the following line:

map.addLayers([operationalLayer]);

This needs to be done because the legend dijit depends on the layers in the map and thus should be created after the layers have been added to the map. The new code will fire the layers-add-result event, which can be caught and the legend can be initialized at this time.

9. Add the following lines shown in bold in the screen capture above the map.addLayers . . . line:



map.on("layers-add-result", function (evt) {

 var legend = new Legend({

    map: map,

    layerInfos:

[{layer:operationalLayer, title: 'Earthquakes'}]

} , "legendDiv");

   legend.startup();

});



map.addLayers([operationalLayer]);

These lines define an event listener. The event listener listens to the layers-add-result event, which is fired when the layers have been added to the map. Once it catches this event, it will execute the function enclosed in the brackets. The function creates a new legend object in legendDiv, defines legend properties such as associated map and layers, and then starts it up.

10. Click the Save button in Notepad++. In a web browser, load the page http://localhost/js/add_dijits.html.
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The legend appears. If you see errors, use the debugging skills learned in section 8.4 to fix them.

Next, add a gauge dijit.

11. Add the two lines shown in bold in the screen capture to the leftDiv. This creates a gaugeDiv element inside the leftDiv to hold the gauge dijit.



<div id="leftDiv">

<div id="legendDiv">

</div>

<div id="gaugeDiv">

</div>

</div>

12. Refer to the gauge API reference (http://developers.arcgis.com/en/javascript/jsapi/gauge-amd.html) to learn about the module it requires and how to create a gauge dijit.

13. Add the module and argument shown in bold in the screen capture to the require function to load the gauge dijit module and provide a reference to the module.



require ([

"esri/map", "esri/layers/FeatureLayer",

"esri/dijit/Legend",

"esri/dijit/Gauge",

"esri/symbols/SimpleMarkerSymbol",

"esri/symbols/SimpleLineSymbol" ,

"esri/renderers/SimpleRenderer", "esri/graphic",

"esri/lang",

"dojo/_base/Color", "dojo/number", "dojo/dom-style",

"dijit/TooltipDialog", "dijit/popup",

"dojo/domReady!"

], function(

Map, FeatureLayer, Legend, Gauge,

Similar to the legend dijit, the gauge dijit should be created after the layers are added to the map—that is, when the layers-add-result event is fired.

14. Add the following lines shown in bold in the screen capture after the legend.startup(); line.



legend.startup();



var gaugeParams = {

"caption": "Earthquake Magnitude",

"color": "#CC00CC",

"dataField": "OTHER_MAG1",// gauge value

"numberFormat": {"places" : 1},

"dataLabelField": "LOCATION",

"layer": operationalLayer,

"maxDataValue": 9.5,// gauge max value

}

var gauge = new esri.dijit.Gauge(gaugeParams, "gaugeDiv");

gauge.startup();

});

These new lines first define the gauge properties. The property names are self-explanatory. One property to note is dataField. It defines which attribute field will be used for the gauge value. Also note that the maxDataValue is 9.5, which is the largest-magnitude earthquake ever recorded.

15. Click the Save button of Notepad++. In Chrome, navigate to http://localhost/js/add_dijits.html. Hover the mouse over an earthquake. You can see its magnitude displayed in the gauge.

[image: images]

You have added the dijits. Go one step further to customize the style of the gauge dijit. You may have noticed that the data label, New Mexico in the screen capture, is left aligned. Change it to center aligned using the Inspect technique you learned in section 8.4.

16. Press F12 to open the Developer Tools window, and click the Inspect button.

[image: images]

Click the data label.

[image: images]

17. Notice the style class name of the data label is gaugeContainer. Its style is inherited from esri.css.

[image: images]

Notice esri.css is an external file that cannot be changed. You need to define an additional style in your code for the gaugeContainer class to overwrite the style defined in esri.css.

18. In Notepad++, add the following lines to the Styles section. These lines define a center-aligned text style for the gaugeContainer style class.



.gaugeContainer {

text-align:center;

}

</style>

19. Save your changes in Notepad++. Reload the page in your web browser. Hover the mouse over an earthquake on the map. Notice the gauge data label (e.g., New Mexico in the screen capture) is now center aligned.

[image: images]

In this section, you added two dijits to the application and modified the style of the gauge dijit.

[image: images]    Note: if you ran into errors in the preceding steps, refer to C:\EsriPress\GTKWebGIS\Chapter8\add_dijits_key.html, or debug your program using the debugging skill you learned in section 8.4.

8.6 Select features from a feature layer

In this section, select earthquakes with magnitudes greater than a value that users will specify and then highlight them on your map.

[image: images]    Note: These steps involve a lot of typing. To avoid typos, refer to the source code (C:\EsriPress\GTKWebGIS\Chapter8\select_fl_key.html), or simply copy the piece of source code you need from it as you work on the following steps.

1. Copy C:\EsriPress\GTKWebGIS\Chapter8\select_fl.html to C:\inetpub\wwwroot\js\. Then open it with Notepad++.

This is the same source code you got at the end of section 8.5, in step 19.

2. In the body section of the source code, add the lines shown in bold in the screen capture.

<div id="leftDiv">

<div id="inputDiv">

  Select earthquakes with magnitude greater than:

  <input type="text" id="inputValue" value="5">

  <input id="execute" type="button" value="Go">

</div>

<div id="resultDiv">

</div>

<div id="legendDiv">

</div>

<div id="gaugeDiv">

</div>

</div>

The new code adds two divs inside the leftDiv element:

• The inputDiv element has a text field where users can specify an earthquake magnitude. It also has an Execute button.

• The resultDiv element will be used to hold the selection result.

3. In Notepad++, scroll up to the Styles section. Add the following code shown in bold in the screen capture to the section. The new code defines the height of resultDiv as 200 pixels.

.gaugeContainer {

text-align:center;

}

#resultDiv {

height:200px;

}

There are a few ways you can query or search, including FindTask and QueryTask. With the earthquake layer already on the browser side, you can query the earthquakes using the selectFeatures method of the FeatureLayer class.

4. Save your changes, and load http://localhost/js/select_fl.html in Chrome or another web browser.
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5. Navigate to the FeatureLayer API reference (https://developers.arcgis.com/en/javascript/jsapi/featurelayer-amd.html), find the selectFeatures method, and study it.

Notice this method selects features from a feature layer. This layer highlights the current selection if a selection symbol has been defined. This method has four parameters:

selectFeatures(query,selectionMethod?,callback?,errback?)

The parameters are as follows:

• A query expression, which requires the esri/tasks/query module.

• A selection method, which can be SELECTION_NEW, SELECTION_ADD, or SELECTION_SUBTRACT.

• A callback function, which is called whenever the selection has been completed and returned. This function typically involves processing the results—for example, looping through the returned features to do some post statistics, charting, or tabular display.

• An errback function, which is called when the selection fails. This is optional. However, it can help you handle errors more gracefully—for example, by giving users meaningful explanations or asking them to try the application later.

6. Add the modules and arguments shown in bold in the screen capture to the require function. This loads the query module and the dojo dom and on modules and provides references to these modules.

reqiure([

 "esri/map", "esri/layers/FeatureLayer",

"esri/dijit/Legend", "esri/dijit/Gauge",

"esri/symbols/SimpleMarkerSymbol",

"esri/symbols/SimpleLineSymbol",

"esri/renderers/SimpleRenderer", "esri/graphic",

"esri/lang",

"esri/tasks/query", "dojo/dom", "dojo/on",

"dojo/_base/Color", "dojo/number", "dojo/domstyle",

"dijit/TooltipDialog", "dijit/popup",

"dojo/domReady!"

], function(

Map, FeatureLayer, Legend, Gauge,

SimpleMarkerSymbol, SimpleLineSymbol,

SimpleRenderer, Graphic, esriLang,

Query, dom, on,

Color, number, domStyle,

TooltipDialog, dijitPopup

) {

The dom module is used to select HTML elements. The on module is used for event handling.

7. Add the following code shown in bold in the screen capture to the end of the script section, above the code "});".



operationalLayer.setSelectionSymbol (highlightSymbol);

on (dom.byId("execute"), "click", execute);

function execute() {

var query = new Query();

query.where="OTHER_MAG1>" +

      dom.byId("inputValue").value;

operationalLayer.selectFeatures(query,

operationalLayer.SELECTION_NEW, processResult);

}

function processResult(features) {

dom.byId("resultDiv").innerHTML = "Earthquakes

found: " + features.length;

}

});

</script>

These lines first set the highlighting symbol of the feature layer and then define an event listener (i.e., when the Execute button is clicked, call the execute function).

The execute function creates a new query and sets its where clause with a magnitude attribute that is greater than the inputValue users specify. It then calls the selectFeatures method to perform a new selection. When the selection is completed, the code calls the processResult function.

The processResult function takes in the returned features and displays the total number of features found in the resultDiv element.

8. Save your changes, and load the page http://localhost/js/select_fl.html to your web browser. Specify a magnitude (e.g., 5) in the text box and click Go.

The selected earthquakes appear highlighted on the map. The total matching earthquakes number 109, as displayed in the resultDiv.
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[image: images]    Note: if you run into errors in the preceding steps, refer to C:\EsriPress\GTKWebGIS\Chapter8\select_fl_key.html, or debug your program using the debugging skill you learned in section 8.4.

You have fulfilled the requirements of this tutorial. In the process, you learned the general steps taken to create a JavaScript application using ArcGIS API for JavaScript, as well as the steps to adapt a sample and add dijits. You also learned how to debug JavaScript, monitor HTTP traffic, and inspect HTML elements.

QUESTIONS AND ANSWERS

1. I submitted my assignment URL (http://localhost/WebGIS/app.html) to the instructor. However, my instructor said he could not see my homework. Why?

Answer: Localhost is relative. It points to the computer that the user is currently using. Therefore, whenever you go to this URL on your computer, it points to your computer. If the instructor used this URL on his or her computer, then it points to his or her computer, which does not have your homework deployed. So he or she would not be able to access your homework.

Therefore, whenever submitting your homework, be sure to use the correct host name instead of localhost.

2. In my web browser, I use file:///C:/inetpub/wwwroot/JS/fl_hover.html instead of http://... URL to load my page. Is this okay?

Answer: No.

The file:/// location works only when you use it on your own computer. If you send this location to other people, the file:/// location will point to their computers. Naturally, they will not be able to see your web page.

Additionally, if you use file:///, your web page may not work correctly. Some HTTP requests may fail.

3. I changed my JavaScript and refreshed the page in my web browser. However, I cannot see the latest changes in the browser. What is wrong? How do I fix it?

Answer: Browser caching is causing the problem.

Browsers often cache a version of the web pages you visit and use this cached version to speed up their performance. However, this can result in a situation in which browsers use an outdated version of an updated page.

To avoid this problem, create the following settings:

• For Firefox, type about:config, find browser.cache.check_doc_frequency, and set its value to 1, which means “Check for a new version every time a page is loaded.”

• For Chrome, click the options button > Tools > Developer tools > the Settings button in the lower-right corner. Then under General settings, select the Disable cache check box.

• For Internet Explorer, click Tools > Internet Options > the General tab > Settings under Browsing history > Temporary Internet Files tab > and select Every time I visit the web page under Check for newer versions of stored pages.

4. Some of the sections in this chapter require IIS as the web server. How do I know whether I have IIS installed? If it is not installed, how do I install it?

Answer: To verify whether your computer has IIS installed, simply start a web browser and type http://localhost or http://your_computer_name. Typically, a web page appears, which means that IIS has been installed.

There are plenty of Help documents that explain how to install IIS. Here are some:

http://www.iis.net/learn/install/installing-iis-7/installing-iis-on-windows-vista-and-windows-7 or http://www.windows.microsoft.com/en-US/windows-8/internet-information-services-iis-8-0.

5. A layer in my map service has more than one thousand hurricanes. In my JavaScript, I added this layer as a feature layer to my map. However, when I view this web app, not all the hurricanes are displayed. Why? How do I fix this problem?

Answer: As discussed in previous chapters, browsers draw the feature layers. Web browsers cannot draw an unlimited number of features. To avoid overloading users’ web browsers, ArcGIS for Server sets a default limit, which allows it to return up to one thousand features per request. This explains why you can see up to only one thousand hurricanes.

There are several options to fix this problem:

• Use the dynamic map service layer approach. In this approach, the server draws the map, so it is not subject to the one-thousand-feature limitation.

• Increase the feature return limit, for example, to two thousand or more. But this may overload the web browsers of your end users. However, now you will see up to two thousand hurricanes (and even that may not include all the hurricanes in your layer).

• Use the on-demand mode of the feature layer, and couple it with the correct scale dependency. This way, ArcGIS for Server will return only those hurricanes within the current map extent. To ensure that there are no more than one thousand hurricanes in any map view, set the correct scale dependency.

ASSIGNMENTS

Assignment 8A: Map and query hurricanes.

This assignment is similar to the tutorial of this chapter.

Data: Use the hurricane layer of the natural disaster map service you published in chapter 3, or you can use this one provided by Esri Press: http://esrimapbook.esri.com/arcgis/rest/services/GTKWebGIS/natural_disasters/MapServer/1.

Requirements: Your web app should do the following:

• Display the hurricane layer, along with a legend dijit.

• Whenever users hover the mouse over a hurricane, the app should

› highlight the hurricane,

› display its attributes in a pop-up window, and

› use a gauge dijit to display the hurricane wind speed relative to the maximum hurricane wind speed on record, which is 210 mph.

• Allow users to specify wind speed and then select those hurricane paths with wind speed faster than that specified speed.

• Highlight the matching hurricane paths.

• Display the total number of matching segments.

What to submit: E-mail your instructor with the subject line Web GIS Assignment 8A: Your name, and include the following:

• The URL of your web application. In the URL, use your host name instead of localhost or file:///.

• The source code in a ZIP File.

• Screen captures showing your web app is working.

[image: images] Tips:

• Start with the source code you saved at the end of the tutorial, in step 8 of section 8.6, or use C:\EsriPress\GTKWebGIS\Chapter8\select_fl_key.html.

• Replace the earthquake layer URL with the hurricane layer URL.

• Replace the attribute fields with the hurricanes’ fields.

• For the info window content, replace the earthquake attribute names with the hurricane attribute names, such as those shown in the following code.



var t="<b>${Name}</b><hr><b>Wind Speed: </b>${wmo_wind}<br>"

+ "<b>Pressure: </b>${wmo_pres}<br>"

+ "<b>Date: </b>${H_DATE:DateFormat}";



• For the gauge properties, set the caption as Wind Speed, dataField as wmo_wind, dataLabelField as Name, layer as operationalLayer, and maxDataValue as 210.

• Hurricanes are depicted as lines, so highlightSymbol needs to be a line symbol.

• Remove the existing highlightSymbol, which is a SimpleMarkerSymbol. Rename highlightBorder as highlightSymbol. Make the line wider for emphasis, such as shown in the following code.

var highlightSymbol = new

SimpleLineSymbol(SimpleLineSymbol.STYLE_SOLID,

new Color ([255,0,0]), 3);

var highlightSymbol = new

SimpleMarkerSymbol(SimpleMarkerSymbol.STYLE_CIRCLE, 15,

highlightBorder,

new Color ([0, 255, 0, 0.5]));

• For the selection, perform the following:

• Change the label “Select earthquakes with magnitude greater than” to Select hurricane paths with wind faster than.

• Change the default value 5 to a larger value, such as 100.

• Use the wmo_wind field in the query.where clause, such as the following: query.where="wmo_wind >" + dom.byId("inputValue").value;

• In the processResult function, change the message “Earthquakes found” to Daily hurricane paths found.

• The hurricane layer has more than one thousand lines (each line represents one day’s path for a hurricane). Notice that not all hurricane paths are displayed. See the “Questions and Answers” section at the end of this chapter for explanations. To fix this, use the on-demand mode, and set the layer’s minScale to 1:10,000,000.

[image: images]    Note: You will need to zoom in to see the hurricanes.

var operationalLayer = new FeatureLayer("your hurricanes layer URL", {

 mode: FeatureLayer.MODE_ONDEMAND,

 outFields: ["*"]

 });

operationalLayer.minScale = 10000000;



• Change the initial map center and zoom level to better cover the hurricanes.

map = new Map("mapDiv", {

basemap: "streets",

Center: [-82 , 30 ] ,

zoom: 6,

slider: false

});

Assignment 8B: Adapt a JavaScript web app sample.

Data: Find one sample in any of the following ArcGIS API for JavaScript sample groups:

• Pop-up and info windows

• Query and Select

• Vector Feature Layers

Requirements: Replace the map service(s) or layer(s) used in the sample with the service(s)/layer(s) from http://sampleserver6.arcgisonline.com/arcgis/rest/services.

What to submit: E-mail your instructor with the subject line Web GIS Assignment 8B: Your name, and include the following:

• The URL of your web application. In the URL, use your host name instead of localhost or file:///.

• The source code in a ZIP File.

• Screen captures showing your web app is working.

Resources

ArcGIS API for JavaScript website

“Build Your First Application,” https://developers.arcgis.com/en/javascript/jstutorials/intro_firstmap.html.

“Build a Web Map Using ArcGIS.com,” https://developers.arcgis.com/en/javascript/jstutorials/intro_agstemplate_amd.html.

“Working with Dojo,” https://developers.arcgis.com/en/javascript/jshelp/inside_dojo.html.

“Feature Layer Overview,” https://developers.arcgis.com/en/javascript/jshelp/inside_feature_layers.html.

“Working with Info Windows,” https://developers.arcgis.com/en/javascript/jshelp/intro_infowindow.html.

“Pop-up Overview,” https://developers.arcgis.com/en/javascript/jshelp/intro_agspopup.html.

Esri GitHub

100-lines-or-less-js, https://github.com/Esri/100-lines-or-less-js.

quickstart-map-js, https://github.com/Esri/quickstart-map-jsPart number (type over existing text).

Esri Training website
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Chapter 9

Mobile GIS

The proliferation of smartphones and tablets, combined with a fundamental human need for convenience, has brought about a rapid development of GIS technology on mobile devices, making it an important arena for developers. Those who wish to understand mobile GIS should study it in the context of web GIS because the former is becoming an important type of client for the latter. To that end, this chapter introduces three options for building mobile GIS—browser based, native-app based, and hybrid based—and discusses the pros and cons of each. The tutorial sections illustrate the use of the Collector for ArcGIS mobile app for collecting data; ArcGIS API for JavaScript for developing browser-based apps; and ArcGIS Runtime SDK for Android for developing native app-based apps.

Learning objectives

• Understand the options for mobile app development.

• Use the Collector for ArcGIS mobile app to collect field data.

• Create browser-based web apps using the JavaScript API.

• Create mobile native apps using the Runtime Android SDK.

This chapter in the big picture

[image: images]

ArcGIS offers many ways to build web applications. The red ovals in the figure highlight the technologies chapter 9 teaches.

Mobile GIS applications

Mobile GIS has certain advantages over traditional desktop GIS, including:

• Mobility: mobile devices are not hindered by wire or cable, and thus can extend GIS to areas where wiring is infeasible or costly and users most need GIS.

• Location awareness: GPS, Wi-Fi networks, and other technologies can be used to pinpoint the current location of a mobile device.

• Large volume of users: mobile devices are creating a pervasive platform for GIS.

• Versatile means of communication: integrating with voice, short message, photo, video, e-mail, and many social networking apps, mobile devices can facilitate collaboration and communication among professionals and consumers.

• Near real-time information: The live connection of mobile networks greatly enhances the temporal dimension of GIS. This gives mobile GIS the potential ability to monitor the spatial and temporal aspects of the world around us.

Organizations need mobile GIS to complete such tasks as field mapping and data query, field inspection and inventory of assets, tracking assets and field crews, field surveys, and incident reporting. Mobile GIS can replace existing paper-based workflows, which are prone to errors that arise from a work process in which people have to interpret written information and enter data manually. Mobile GIS can replace paper forms, reduce costs, and improve the accuracy of your data.

Mobile GIS is often related to popular applications and frontiers including location-based services (LBS), social networking, and augmented reality (AR). LBS refers to information services that integrate the location of a mobile device to provide added value to the user. AR combines information from the database, especially from the web, with information from the human senses.

Development strategies

Choosing a mobile development strategy depends on many factors: the development team’s skill set, the application’s required functionality, the targeted platform(s), and the funding available. There are three approaches to mobile application development:

• Browser-based approach: This path builds applications using HTML, JavaScript, and CSS. Users operate these apps via a mobile web browser. This strategy potentially reaches all mobile platforms.

• Native-based approach: Native apps must be downloaded and installed on a user’s mobile device. For example, apps that you download from the App Store, Google Play, and the Windows Store are native apps. This approach thus requires native development skills, such as Objective C for iOS and Java for Android.

• Hybrid-based approach: This approach integrates native components and HTML/JavaScript/CSS to build native applications. There are many different ways to achieve this. The simplest way embeds a web control into a native app to load HTML and JavaScript contents. More advanced methods include the use of frameworks (e.g., Adobe PhoneGap or Appcelerator Titanium Studio) to allow richer integration with the native platform.

[image: images]

ArcGIS provides a suite of web APIs and runtime SDKs, which interact with ArcGIS for Server, ArcGIS Online, and Portal for ArcGIS via the REST API.

ArcGIS offers APIs that work for each of these approaches. ArcGIS API for JavaScript can support both browser-based and hybrid-based approaches, while ArcGIS Runtime SDKs for Mobile (iOS, Android, and Windows Phone) support the native-based approach. Each of these APIs ultimately offer similar core functionalities that include editing, layers, graphics, and geometry, as well as accessing ArcGIS Online web maps and ArcGIS for Server web services and a variety of tasks such as query, identify, locator, and geoprocessing.

[image: images]    Note: Because ArcGIS Web APIs, Runtime SDKs for Mobile, and Runtime SDKs for Desktop share similar concepts, understanding one helps you to learn another. For example, you can often refer to samples from ArcGIS Runtime SDK for Java for Desktop when developing Android apps using Java.

Browser-based apps and ArcGIS API for JavaScript

Browser-based mobile apps essentially are websites accessed by mobile browsers.

• Advantages:

• Multiple platform support that allows one app to reach the broadest audience of mobile users.

• Often cheaper and quicker to develop than native apps.

• Agile in fixing problems. Updates to the website can be made easily and quickly as opposed to having to go through venues such as the App Store.

• Disadvantages:

• User experience is not as good as with native apps.

• Cannot access all the device’s hardware and software, such as the address book and notifications.

The browser-based approach often depends on responsive web design (RWD) technologies. RWD aims at crafting sites to provide the optimal viewing experience across a wide range of devices, from mobile phones to desktop computer monitors. A site designed with RWD adapts the layout to the viewing environment by using fluid, proportion-based grids; flexible images; and CSS3 media queries.

For the mobile platform, ArcGIS API for JavaScript provides a compact build, containing only the essential parts of the API and not desktop-focused widgets and layouts. This can reduce the initial loading time and increase the performance of your application.

Native-based apps and ArcGIS Runtime SDKs for Mobile

Native apps are binary executable programs installed on a device.

• Advantages:

• Typically have better performance than the browser-based approach

• Deep-level access to device hardware and other resources

• Disadvantages:

• Low portability: code written for one mobile operating system cannot be reused for another mobile operating system.

• Expensive to develop: to build apps for multiple platforms, a development team would need to learn multiple programming languages, use multiple software development kits, and manage several code bases.

For this approach, ArcGIS provides Runtime SDKs for iOS, Android, and Windows Phone, which support you in building your own native mobile GIS apps. ArcGIS also provides ready-to-use native apps, including the following:

• Collector for ArcGIS. With it, you can

• collect and update information in the field, including attaching photos and videos;

• complete intelligent data entry forms specific to your data;

• easily access and use your maps and those created for you;

• find places and get directions; and

• periodically log your current location.

• Explorer for ArcGIS. With it, you can

• search, explore, and discover web maps;

• display web maps;

• search for places and features in web maps;

• share maps with other Explorer for ArcGIS users;

• sketch on the map to highlight important aspects of your data; and

• tell stories and brief stakeholders via map presentations.

Hybrid

A hybrid app essentially comprises an HTML/JavaScript application wrapped in a native shell and is distributed as a native app. With hybrid apps, a web developer can leverage their existing skill set and tap into a limited subset of a device’s native hardware.

This approach offers the advantages of both browser- and native-based apps. You can create hybrid apps through frameworks such as Adobe PhoneGap, Sencha Touch, and Appcelerator Titanium Studio. For example, the Adobe PhoneGap Build system enables developers to upload their assets (HTML5, CSS, JavaScript) to the Adobe cloud; then, using the latest PhoneGap SDK, they can have their apps compiled into the native apps of targeted platforms.

The JavaScript API can be used to build hybrid applications. The same knowledge required to build your apps using the browser-based approach can be applied to the hybrid approach.

This tutorial

This tutorial teaches four different but related technologies.

• Section 9.1 has you create an ArcGIS Online or Portal for ArcGIS web map to use in sections 9.2 and 9.3.

• Sections 9.2 and 9.3 both teach Collector for ArcGIS.

• Section 9.4 explores the browser-based approach with the JavaScript API.

• Sections 9.5, 9.6, and 9.7 get you started with the Runtime Android SDK. These three sections are optional. They require a lot of system setup and a good understanding of Java.

System requirements:

• For sections 9.1, 9.2, and 9.3:

• ArcGIS Online for Organizations or Portal for ArcGIS. You will need to have a publisher account or an administrator account.

• Collector for ArcGIS on iOS or Android.

• Section 9.4:

• A web browser and a smart mobile device.

• Sections 9.5, 9.6, and 9.7:

• JDK (Java Development Kit) 7. Download at http://www.oracle.com/technetwork/java/javase/downloads/jdk7-downloads-1880260.html.

• ADT (Android Developer Tools, based on Eclipse). Download Eclipse and ADT bundle for Windows at https://developer.android.com/sdk/index.html.

• Android API levels you would like to support. To install them in Eclipse, go to Window > Android SDK Manager, and click the Android API levels you want to support. Eclipse will then download and install these packages.

• Optionally, an Android-based device. (You may need to download and install the drivers for this device on your computer. If you do not have a physical device, you can configure your ADT to run on a virtual device.)

• ArcGIS Runtime SDK for Android. Installation instructions are provided in section 9.5.

[image: images]    Notes:

• Here, you are learning ArcGIS Runtime SDK for Android rather than for iOS. Developing an iOS app requires you to register as an iOS developer (which is not free), use a Mac OS computer (which is less common than Windows-based computers), and understand Objective C (which has a much higher learning curve than other programming languages such as Java). It is much easier to start by taking the Android path.

• Installing and configuring ADT and various other components can be challenging. For a classroom setting, instructors should install them for their students.

9.1 Prepare your web map (optional)

This section is optional. It illustrates how to create a web map that Collector for ArcGIS can use. This section resembles the tutorial in chapter 5, except that it creates a feature service with not only the point type but also line and polygon types. To speed up lab time, instructors can create the web map in advance for students to use. If you have any questions, refer to chapter 5.

If you skip this section, choose some existing public web maps to use in sections 9.2 and 9.3.

1. Open your browser and navigate to ArcGIS Online (arcgis.com).

2. Log in using your ArcGIS Online for Organizations publisher or administrator account.

3. Add the C:\EsriPress\GTKWebGIS\Chapter9\Incidents.zip file to your content and publish it as a feature service.

This ZIP File has three shapefiles: Incidents_Point, Incidents_Line, and Incidents_Polygon. The feature service created in this step contains these three layers.

4. On the item details page of the feature service, click the arrow [image: images] next to each layer and then click Enable Attachments.

5. Still on the item details page, click Edit. Select the check box for Enable editing and allow editors to: Add, update, and delete features. Save the edit.

6. On the item details page, click Open > Add layer to new map with editing enabled.

[image: images]

7. In the map viewer, click Configure Pop-up for each of the three layers. Then set the field aliases and display properties, as illustrated in the screen capture.

[image: images]

8. In the map viewer, click Change symbols for each of the three layers. Use Unique Symbols to show Incident_T, the incident type field. Customize the symbols further by using icons for the point layer (refer to chapter 5). Click Done Changing Symbols and then Save Layer.

9. Save the web map as Non-Emergency Incidents, fill in the form, and click Save Map.

10. Click Share and share your service with everyone, your organization, or certain groups.

9.2 Collect points using Collector for ArcGIS

This section requires the Collector for ArcGIS (iOS) mobile app. To install it on your smartphone or tablet (iOS or Android), go to the App Store or Google Play, search for Collector for ArcGIS, and install it. The instructions for this section use iPhone, but they apply to Android as well, although you may see slight differences.

1. On your smartphone or tablet, tap the Collector app to start Collector for ArcGIS.

[image: images]

2. Log in with your ArcGIS Online for Organizations or Portal for ArcGIS account.

[image: images]    Note: If you skipped section 9.1 or do not have an ArcGIS Online for Organizations account, tap Try it and select a different web map (e.g., the Recreation web map) in step 3.

3. Locate the My Maps list. Find the Non-Emergency Incidents web map created in section 9.1.

4. Tap the icon to start it.

[image: images]

5. Familiarize yourself with the functions of the buttons.

[image: images]

6. Tap the Collect a new feature [image: images] button to create a new incident. In the Collect a new feature panel, tap Pothole to choose this type of feature.

[image: images]

7. In the attribute panel, specify the attributes.

You can set the values as illustrated in the screen capture or make up your own.

[image: images]

8. Tap the Map button [image: images] to see the location of this incident.

[image: images]

Notice the incident location is set as your current location. This is convenient if you are at the place of the incident. Also, notice the icon with a number [image: images]. This number indicates the resolution at this moment. This is also indicated by the outer circle of the icon [image: images]. If you are outside with a GPS receiver enabled, the level of resolution may be only a few meters. If you are indoors, the margin of error can be much higher and the resolution lower.

9. Optionally, if you want to manually specify a location other than using the GPS location, just tap the desired location on the map.

You see a red dot, which marks the location of the incident. To place the incident more precisely, tap and hold to get a magnifier and use that to more precisely place the incident.

[image: images]

10. On the toolbar, tap the Add Attachment icon [image: images] to attach a photo or video to the incident.

[image: images]

11. Tap Add > Take Photo or Video, and take a photo or video.

[image: images]

12. If you are happy with the picture, tap Use it; otherwise, retake the picture. Tap Add if you want to attach more photos or videos to this incident. Tap Done to use the photo(s).
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13. Tap Submit on the toolbar to save the incident.

[image: images]

Messages indicate that the data is being saved. On the map, the new incident you created appears with the correct symbol.
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14. To review an existing incident, tap it. The basic incident information is displayed. Tap the upward arrow [image: images] and more options appear, including Edit, Delete, Zoom to, Show details, and Directions to here.
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15. Tap Show details to view the attributes collected for this incident. Tap any of the attributes to change its value. To see a large photo, tap its thumbnail.

[image: images]

16. Tap Map to return to the map mode, where you can collect more incidents.

Remain in map mode if you are going directly to the next section.

9.3 Stream lines and polygons using Collector

Collect lines and polygons either manually or automatically using the streaming mode (for example, collect vertices while walking or driving).

1. While you are in the map mode, tap the Collect a new feature button to create a new incident. Choose a line feature type, such as the Street to Resurface incident type.

[image: images]

2. Specify the attribute values.

[image: images]



3. Tap the Map icon to switch to the map mode.

4. To add a line manually, tap on the map to enter the nodes and vertices.

[image: images]

You can also collect lines or polygons by streaming your GPS location. Before doing so, be aware of the related settings.

5. Tap the Settings button [image: images] to review the Collect Settings panel, including Required Accuracy and Streaming Interval. Change the values as needed and then tap Save. Otherwise, tap Cancel.

• Required Accuracy sets the accuracy of data that must be obtained for the GPS to add a point.

• Streaming Interval sets how often a point is added to the feature that you are creating. The smaller the time interval, the more detailed the shape.

[image: images]

6. To add a line using GPS streaming, tap the Stream button and take your phone while walking or driving along the line formation (e.g., street or road) where you wish to collect data.

[image: images]

The GPS locations of your phone are collected and drawn on the map.

7. In the same way that you do for points, tap the Add Attachment icon to attach photos or videos relevant to the line incident.

8. Tap Submit on the toolbar to save the line incident.

Collecting a polygon feature is similar to collecting a line feature.

9. Tap the Collect a new feature icon and choose a polygon feature type (e.g., the Garbage Pile incident type).
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10. Specify the attribute values.
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11. Tap Map to switch to the map mode.

12. To add a polygon manually, tap on the map to add its vertices.
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13. To add a polygon using GPS streaming, tap the Stream button, and take your phone while walking or driving along the polygon lines you wish to collect.

[image: images]

14. Attach photos and videos to this incident if needed.

15. Tap Submit on the toolbar to save the incident.

You are now familiar with Collector and are able to collect point, line, and polygon features. Because your edits were saved back to the server that holds all the incident data, you are sharing your incident with everyone who uses this web map or feature service. Go to your web map to see the data you collected.

You can export the data collected into CSVs and shapefiles from ArcGIS Online if you are the owner of the feature service or if the owner has allowed others to export the data.

9.4 Explore JavaScript API mobile samples

You were introduced how to modify JavaScript API samples in chapter 8. This section briefly shows how to explore the browser-based mobile GIS app without getting into the details of the JavaScript API.

1. Start a web browser and navigate to the ArcGIS API for JavaScript website (https://developers.arcgis.com/javascript). Click Tutorials > Mobile-specific application.

Or, go to the URL directly, http://developers.arcgis.com/javascript/jstutorials/mobile_dev.html.

[image: images]

2. Read the page. This provides a good, concise tutorial for creating mobile-friendly web apps using responsive, mobile-specific layout widgets.

[image: images]    Notes:

• This app uses a compact build of the JavaScript API, such as
<script>src="http://js.arcgis.com/4.0compact/"></script>.

• It has some metatags to ensure a mobile-friendly web application.

• The dojox.mobile utility package specifically handles various differences among devices.

• The map resize() and reposition() methods are useful for updating the size and position of the map upon resizing and orientation changes.

Next, try this tutorial app on your mobile device.

3. On your mobile device, navigate to the JavaScript API tutorial page cited in steps 1 and 2. Scroll down to the bottom of the page, and tap the link in the sentence, You can view this application on your mobile device or WebKit browser (Chrome or Safari) here, or go to the page directly, http://developers.arcgis.com/javascript/samples/mobile_template.

This page has two divs, mapView and aboutView, each a dojox.mobile.View. The two views switch as you click the buttons. This is a common way to handle the About window and pop-up windows. The screens are so small that the About window and pop-up windows usually take up the whole screen.

4. Explore more mobile samples on your mobile device. You can get there as illustrated in the screen capture or go to this URL directly, https://developers.arcgis.com/javascript/jssamples/#mobile. View the source code.

[image: images]

These apps demonstrate how to use HTML5 to access smartphone hardware such as the location service (using GPS, Wi-Fi, and other technologies), gyroscope, compass, camera, and camera roll and how to detect events such as DeviceOrientationEvent and DeviceMotionEvent.

Tasks such as displaying basemaps, adding operational layers, and querying are similar to the ones you studied in the JavaScript API chapter. Follow the same steps you learned in chapter 8 to adapt these samples and incorporate widgets.

9.5 Install the ArcGIS for Android Eclipse plug-in

[image: images]    Notes:

• This section and the next two are optional.

• This section assumes you have JDK and ADT installed. See “System requirements” at the beginning of this chapter for details.

1. On your computer, open a web browser and navigate to https://developers.arcgis.com/android/. Download ArcGIS Runtime SDK for Android. Sign in when asked to.

[image: images]    Note: to speed up the download and install process in a classroom setting, it is best for the instructor to download it before class and ask all the students to use the local copy.

2. Extract the SDK to a folder (e.g., C:\Program Files).
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The files are extracted to a subfolder (e.g., arcgis-android-sdk-v10.2).

3. Start Eclipse.

4. On the Eclipse menu bar, click Help > Install New Software.
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5. Click Add.
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6. In the Add Repository dialog box, perform the following:

• For Name, enter ArcGIS Android Local update site.

• Click Archive.

• Browse to the arcgis-android-eclipse-plugin.jar file extracted in step 2. It lies in a subfolder such as arcgis-android-sdk-v10.2/tools/eclipse-plugin.

• Click OK.
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7. In the Available Software dialog box, select the check box for ArcGIS for Android to expand it. Select both ArcGIS for Android Core and ArcGIS for Android Doc and Samples. Click Next.
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8. In the Install Details panel, click Next.
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9. Accept the license agreement and click Finish.
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10. When your installation is complete, restart Eclipse.

9.6 Getting started with ArcGIS Runtime SDK for Android

This section assumes that you have installed Runtime Android SDK for the Android API levels you would like to support and that you have configured Run Configurations in either a virtual or physical device. Refer to “System requirements” earlier in this chapter for details.

This section reviews the HelloWorld sample that comes with the Runtime Android SDK. The aim is to help you understand the basics of using ArcGIS Runtime SDK to build native apps.

1. In Eclipse, click File > Import.
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2. Click Existing Android Code Into Workspace.
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3. In the Import Projects dialog box, for Root Directory, browse to samples\Maps\HelloWorld under the ArcGIS Android SDK folder you extracted in step 2 of section 9.5, and select the check box for Copy projects into workspace. Then click Finish.

[image: images]

4. Right-click the HelloWorld project and click ArcGIS Tools > Convert to ArcGIS Android Project.

This updates necessary library files that may be missing while you import the project.

[image: images]

5. On the main menu bar, click Project > Clean. Selecting Build Automatically rebuilds your app.

[image: images]

6. In the Package Explorer panel, click res > layout. Then double-click main.xml to open the layout XML file in graphic layout mode. Click the main.xml tab to examine the raw XML.

[image: images]

There are two tags in main.xml:

• The first, Android LinearLayout, arranges its child views in a single column or row.

• The second, Esri MapView, defines its ID, size, and initial extent.

• For the ID (id), the at sign (@) at the beginning of the string indicates the ID string for a resource. The plus sign (+) means that this is a new resource name.

• For the initial extent (initExtent), the four numbers are at the left, bottom, right, and top boundaries, respectively.

7. Still in the Package Explorer panel, click src > com.esri.arcgis.android.samples.helloworld, and double-click HelloWorld.java to open the Java source file in the Java Editor. In front of the first line of the import, click the Plus icon [image: images] to expand all the import statements.
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An import statement is a way of adding functionality to a program. The following two lines bring in the MapView class and the ArcGISTiledMapServiceLayer class from the Runtime Android SDK:

import com.esri.android.map.MapView

import com.esri.android.map.ags.ArcGISTiledMapServiceLayer

• The following two lines declare two variables and their class types:

MapView mMapView = null

ArcGISTiledMapServiceLayer tileLayer

• The following line creates an example of the MapView class with its properties defined in main.xml, including the initial map extent:

mMapView = (MapView)findViewById(R.id.map)

• The following lines of code create an example of the ArcGISTiledMapServiceLayer class using the URL of the tiled map service and adding the layer to the map view:

tileLayer = new

ArcGISTiledMapServiceLayer(tiled_map_service_url);
mMapView.addLayer(tileLayer)

8. Double-click AndroidManifest.xml. Click the HelloWorld Manifest tab to examine the raw XML.

[image: images]

Every Android application must have an AndroidManifest.xml file (located at the root folder of every Android project in Eclipse) as part of the Android package (APK) file, which is used to distribute and install applications onto an Android device. Note the following permissions are granted in XML:

• android.permission.INTERNET allows your app to open network sockets so the app can communicate with ArcGIS for Server.

• android.permission.WRITE_EXTERNAL_STORAGE allows your app to write data to the external storage medium, such as a secure digital (SD) card. This is vital for optimizing the performance of your app.

• android.permission.ACCESS_FINE_LOCATION allows your app to access the GPS data on your device.

Also, take note of minSdkVersion="10". This indicates that your app is compatible with SDK version 10, which corresponds to Android 2.3.3 and above. The Android system prevents your users from installing this app if the system’s API level is below this version.

9. With the Java code open, on the toolbar click the Run button to execute the app.

Alternatively, you can right-click the HelloWorld project in the Project Explorer panel and click Run As > Android Application.
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In the process, Eclipse creates the HelloWorld.apk, updates it onto a device or emulator, installs it, and runs it.

10. Depending on your Run Configuration settings, you can see this app run in an emulator or a physical device. If you run it in an emulator and the Home screen is locked, unlock the Home screen to continue executing.

Touch screen is not supported in the emulator mode. To zoom in, double-click on the map.
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Running the app in an emulator.
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Running the app on an Android device.

9.7 Adapt a Runtime Android SDK sample

In this section, slightly modify the HelloWorld sample to further illustrate the basics of using the Runtime Android SDK for native app development.

ArcGIS Web APIs and Runtime SDKs share many similar concepts. They all have features such as tiled map service layers, dynamic map service layers, and feature service layers. In this section, add a dynamic map service layer on top of the basemap.

1. Go to the ArcGIS Runtime SDK for Android website (http://developers.arcgis.com/android). Click API Reference and type dynamic in the Search text box. Some matches appear. Click com.esri.android.map.ags.ArcGISDynamicMapServiceLayer.

[image: images]

2. Read the document for this class. Find the package that needs to be imported.

[image: images]

You can often copy the sample code to your program and make use of it.

3. Add the third line that follows in the code to HelloWorld.java below the other two lines.

import com.esri.android.map.MapView;

import com.esri.android.map.ags.ArcGISTiledMapServiceLayer;

import com.esri.android.map.ags.ArcGISDynamicMap ServiceLayer;

This imports the ArcGISDynamicMapServiceLayer package. This is equivalent to what you did in chapter 8, when you used the require function to load the specific JavaScript API modules into your JavaScript code.

4. Add the third line that follows in the code to HelloWorld.java below the other two lines to declare the variable mLayer as an ArcGISDynamicMapServiceLayer type.

MapView mMapView = null;

ArcGISTiledMapServiceLayer tileLayer;

ArcGISDynamicMapServiceLayer mLayer;

5. Add the three following lines of code to HelloWorld.java to create an ArcGISDynamicMapServiceLayer object with the URL and add the layer to the map view.

mMapView.addLayer(tileLayer);

mLayer = new ArcGISDynamicMapServiceLayer

(“http://esripressbooks.maps.arcgis.com/arcgis/rest

/services/GTKWebGIS/natural_disasters_time/MapServer”);

mMapView.addLayer(mLayer);

If there are errors in your code, an error icon will appear along each line that contains errors. Hover the mouse over the error icon to see the error details. You can also find the errors listed under the Problems tab.

6. With the Java code open, click the Run button to execute the updated app.

Alternatively, you can right-click the HelloWorld project in the Project Explorer panel and click Run As > Android Application.

7. Depending upon your Run Configuration settings, the app runs in an emulator or a mobile device.
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Running the app in an emulator.
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Running the app on an Android device.

In this section, you performed slight modification of an existing sample. The purpose is to get you started. There are certainly many differences between ArcGIS Runtime SDK for Android and ArcGIS API for JavaScript. However, the basic concepts are similar, including the tiled map service layer and dynamic service layer illustrated in this section.

QUESTIONS AND ANSWERS

1. I created a browser-based mobile app and deployed it to the IIS on my computer. However, I cannot go to this URL on my smartphone.

Answer: Most likely, your phone cannot see your computer.

Your computer may be connected to your home or organization’s internal network, while your phone may be using the cellular network. If so, it cannot access your internal network.

2. The field where I will collect data does not have a reliable Internet connection. Do ArcGIS Runtime SDKs for Mobile support offline maps and offline editing?

Answer: Yes.

You can provide offline maps to users so they can be productive when their network connectivity is poor or nonexistent. To create offline maps, create geodatabases and tile caches and then build layers from those. See the page http://bit.ly/1qP7Qge (short for https://developers.arcgis.com/android/guide/create-an-offline-map.htm).

With offline capabilities, you can do the following:

• View basemaps (also called tiled layers) created from tile caches.

• Edit operational data (also called feature data and vector data). This includes querying and editing the location, shape, attributes, related tables, and attachments of features.

• Sync edits when online again (upload edits and/or get only the updated features that others have edited) if your data is service based.

• Perform extremely fast searches for locations (geocode and reverse geocode) and routes.

3. ArcGIS API for JavaScript samples often provide limited functionality. Is there a mobile-friendly JavaScript viewer that supports more functionality?

Answer: Yes.

A good one is Web AppBuilder for ArcGIS (see chapter 6). Using it, you can choose your web map and add a range of widgets. The web app responds to a variety of mobile screen sizes and works on mobile devices.

ASSIGNMENTS

Assignment 9B applies only when you have learned sections 9.5, 9.6, and 9.7, which are optional.

Assignment 9A: Collect point, line, and polygon data using Collector for ArcGIS.

Data:

• Create or find an ArcGIS Online web map that supports data collection.

Requirements:

• Go to the field (i.e., out of your classroom or office).

• Use Collector to collect point, line, and polygon data for the nonemergency incident web map or other web maps.

• Put your name in an attribute value.

• Use GPS streaming to collect lines and polygons.

• Attach photos or videos to the features you collected.

What to submit: E-mail your instructor with the subject line Web GIS Assignment 9A: Your name, and include the following:

• One or two screen captures of your phone to show you were collecting data using GPS streaming

• A screen capture of your web map in a desktop browser to show that you saved the data you collected to the server

Assignment 9B: Develop a native mobile app by modifying an ArcGIS Runtime SDK for Android sample.

Data: Use this map service, http://services.arcgisonline.com/arcgis/rest/services/Demographics/USA_Median_Household_Income/MapServer.

Requirements:

• The app should display a map of US median household incomes.

• The app should allow users to click a button to find and highlight those counties with median household income greater than $100K.

[image: images] Tips:

• Start with the Analysis/QueryTask sample app.

• Change the targetServerURL to http://services.arcgisonline.com/arcgis/rest/services/Demographics/USA_Median_Household_Income/MapServer.

• Make sure the following line points to the county layer:
String targetLayer = targetServerURL.concat("/3");

• Modify the following line. Make sure you have the correct query expression.
String[] queryParams = {targetLayer, "AVGHHSZ_CY>3.5"};

• Modify the following line. Use the correct query and your name as the text on the button.
queryButton.setText("Average Household > 3.5");

What to submit: E-mail your instructor with the subject line Web GIS Assignment 9B: Your name, and include the following:

• The source code of AttributeQuery.java

• A screen capture of your emulator, your phone, or tablet showing the query results

Resources

ArcGIS API for JavaScript

ArcGIS API for JavaScript mobile app samples, https://developers.arcgis.com/javascript/jssamples/#mobile.

“Mobile Specific Application Tutorial,” https://developers.arcgis.com/javascript/jstutorials/mobile_dev.html.

ArcGIS Runtime SDK for Android

“Tutorial: Add a Map to Your App,” http://developers.arcgis.com/android/guide/hello-world.htm.

“Tutorial: Use ArcGIS Basemaps,” http://developers.arcgis.com/android/guide/mapping-and-visualization-tools.htm.

API reference, http://developers.arcgis.com/android/api-reference.

“Forum: ArcGIS Runtime SDK for Android,” http://forums.arcgis.com/forums/139-ArcGIS-Runtime-SDK-for-Android.

ArcGIS Runtime SDK for iOS

Help Document website, http://developers.arcgis.com/ios.

ArcGIS Runtime SDK for Windows Phone

Help Document website, http://resources.arcgis.com/en/communities/windows-phone-sdk.

Esri blogs

“Development Strategies for Targeting Android, iOS, and Windows Phone,” http://blogs.esri.com/esri/arcgis/2014/01/23/development-strategies-for-targeting-android-ios-and-windows-phone.

“Choosing a Mobile Development Strategy,” http://blogs.esri.com/esri/arcgis/2013/03/19/choosing-a-mobile-development-strategy-2.

Esri Training website

“Smartphone GIS: Capturing Data with Collector for ArcGIS,” http://training.esri.com/gateway/index.cfm?fa=catalog.webCourseDetail&courseid=2653.

“Introduction to the ArcGIS Runtime SDK for iOS,” http://training.esri.com/gateway/index.cfm?fa=catalog.webCourseDetail&courseid=2609.

“Getting Started with the ArcGIS Runtime SDK for Android,” http://training.esri.com/gateway/index.cfm?fa=catalog.webCourseDetail&courseid=2671.

Esri videos

“Strategies for Building Mobile Apps Using ArcGIS Web APIs,” http://video.esri.com/watch/2971/strategies-for-building-mobile-apps-using-arcgis-web-apis.

“Collector for ArcGIS: An Introduction,” http://video.esri.com/watch/2695/collector-for-arcgis-an-introduction.

“Android: Developing Applications,” http://video.esri.com/watch/2635/android-_dash_-developing-applications.

“Developing Applications for the iOS Platform,” http://video.esri.com/watch/2774/developing-applications-for-the-ios-platform.

“Windows Phone: Developing Applications,” http://video.esri.com/watch/2996/windows-phone-_dash_-developing-applicationsPart number (type over existing text).




Chapter 10

3D web apps

We live in a 3D world. It makes sense, then, that people would find it easier to understand and explain the world using 3D models. Maps, for example, can articulate so much more by appearing in 3D, and do it easier than in 2D. With this in mind, chapter 10 shows how to create 3D web maps using Esri CityEngine software. You will learn how to create 3D models manually, and do so more efficiently, using 2D GIS data and procedural rules. You will also learn how to publish your 3D models to ArcGIS Online and then view them using web browsers. Although it is not possible to describe the full range of capabilities that a sophisticated desktop product such as CityEngine offers in a single chapter, this chapter covers the basic, essential skills you will need to start creating 3D web maps.

Learning objectives

• Create 3D models using 2D GIS data with procedural rules.

• Create 3D models manually.

• Publish 3D models to ArcGIS Online.

• Use CityEngine web viewer.

This chapter in the big picture

[image: images]

ArcGIS offers many ways to build web applications. The thick red line in the figure highlights the technology chapter 10 teaches.

[image: images]    Note: The ArcGIS suite of 3D GIS technologies is evolving rapidly. The upcoming 3D scene services will greatly enhance and enrich the available approaches to creating 3D web map applications.

3D GIS

Typically, viewers can interpret 3D maps more intuitively than 2D maps. Such advantages give 3D GIS wider applicability to fields such as urban planning, architectural design, defense simulation, and even filmmaking. First of all, 3D GIS enables designers to build flexible scenarios quickly and cost effectively, which allows designers to make as many scenarios and add as many modifications as they see fit. And you can use 3D GIS for more than visualization. It offers powerful analytical functions, too, such as visibility or viewshed analysis, sunlight and shadow analysis, and vertical zoning violation detection. Imagine how this affects something such as building design: 3D GIS empowers the designer to see during the design stage where a proposed building will block views, cast shadows, and reflect heat. The more realistic virtual 3D visualization becomes with the help of 3D GIS, the more likely designers will be able to avoid costly mistakes in the building phase.

Moreover, the ability to share 3D GIS online puts the power and flexibility of 3D GIS in the hands of a broader audience. This will allow the public to interact more closely with decision makers in the work of public planning: to observe and analyze the effects of different planning scenarios, compare building proposals and analyze them from every angle, comment on designs, and generally help to improve the quality of design for the sake of the greater community.

This chapter focuses on CityEngine. However, other ArcGIS products—ArcGIS Pro, ArcScene, and ArcGlobe—have 3D GIS capabilities, too. Moreover, the ArcGIS suite of 3D GIS technologies continues to evolve rapidly.

[image: images]    Note: With the upcoming release of 3D scene services, you can create your 3D data and models in ArcGIS Pro, publish them to ArcGIS Online or Portal for ArcGIS as a hosted scene service, and then use them in web maps, web apps based on ArcGIS API for JavaScript apps, and native apps based on ArcGIS Runtime SDKs for Mobile.

CityEngine

CityEngine is a stand-alone desktop software application that helps users design, plan, and model urban environments in 3D. CityEngine allows users to quickly generate 3D cities, either manually or through procedural rules, and to efficiently model virtual 3D urban environments for both simulation purposes and entertainment.

It works well with ArcGIS for Desktop and ArcGIS Online. The GIS data you create in ArcMap can be imported to CityEngine to create 3D models. The 3D models it generates can be exported to ArcGIS data management and analysis packages. The 3D models in CityEngine can also be exported to 3D editing software such as Maya or 3ds Max, geo-visualization tools such as Google Earth, game engines such as Unity or Unreal, and more.

Create 3D models with CityEngine

You can also create 3D models using procedural or rule-based modeling. This is more cost effective than the alternative manual approach. A simple formula to exemplify it is:

Procedural Modeling = Geometry + Attributes + Rules.

Procedural modeling uses rules (procedures) instead of labor-intensive manual modeling to construct 3D geometries and textures. One procedural rule can generate many 3D models. For example, a rule can make use of feature geometry—such as a building footprint or attribute information, including the number of floors, roof type, and wall material type—to generate 3D models that accurately represent the properties of each feature. The more attributes you utilize, the more accurate your generated model will be.

CityEngine web viewer

Once created, CityEngine 3D scenes can be exported and uploaded to ArcGIS Online.

CityEngine provides users with a web viewer that allows them to view 3D web scenes in web browsers without the need of plug-ins. This viewer supports layer views, dynamic shadows, bookmarks, attribute search, and identify. It also provides a swipe tool that allows a side-by-side view of two visible layers, as in the case of a two-design scenario.

This tutorial

This tutorial consists of online tutorials in each section. Each tutorial provides tutorial data to download and online videos to watch.

10.1 Build essential skills

For this section, use the following online resources:

“Tutorial 1: Essential Skills,” http://resources.arcgis.com/en/help/cityengine/10.2/index.html#//02w10000000q000000.

Online video, http://video.arcgis.com/watch/1767/tutorial-1-essential-skills.

10.2 Explore basic polygonal modeling

For this section, use the following online resources:

“Tutorial 14a: Basic Polygonal Modeling,” http://resources.arcgis.com/en/help/cityengine/10.2/index.html#/Tutorial_14a_Basic_polygonal_modeling/02w10000000p000000.

Online video, http://video.arcgis.com/watch/1782/tutorial-14a-basic-polygonal-modeling.

10.3 Publish web scenes

For this section, use the following online resources:

“Tutorial 15: Publish Web Scenes,” http://resources.arcgis.com/en/help/cityengine/10.2/index.html#//02w100000012000000.

Video, http://video.arcgis.com/watch/1785/tutorial-15-publishing-web-scenes.

QUESTIONS AND ANSWERS

1. I designed my 3D models using ArcScene. Can I export my ArcScene document to a 3D web scene?

Answer: Yes.

The ArcScene application can be used to create realistic-looking 3D scenes. With ArcGIS 10.2 and newer versions, you can use a new geoprocessing tool (Export To 3D Web Scene) to export your ArcScene documents to 3D web scenes. See “Exporting ArcScene Documents to 3D Web Scene” in the resources section for more details.

2. When a web scene is viewed in the current CityEngine web viewer, it has to be fully downloaded before users can see it. The initial download is often large and can take time. Will this be improved?

Answer: Yes.

The upcoming release of ArcGIS 3D scene services will have the ability to show information as it streams in.

3. Can I create my own 3D map apps using ArcGIS API for JavaScript and ArcGIS Runtime SDKs for Mobile?

Answer: Yes.

The upcoming ArcGIS 3D scene services will have REST APIs, APIs for JavaScript, and various mobile SDKs. For example, you can build 3D applications using the skills similar to what you learned in chapters 8 and 9.

ASSIGNMENTS

Assignment 10: Create a 3D web map application to show a building or several buildings.

[image: images] Tips:

• You can start with the CityEngine project created in the tutorial in section 10.2.

• Manually design a building or several buildings.

• Then follow what you learned in the tutorial in section 10.3 to publish your scene online.

What to submit: E-mail your instructor with the subject line Web GIS Assignment 10: Your name, and include the following:

• The URL of your 3D web app

• A screen capture of your CityEngine web viewer showing your 3D web scenes

Resources

Esri CityEngine

Product website, http://resources.arcgis.com/en/communities/city-engine.

Esri CityEngine tutorials, http://resources.arcgis.com/en/help/EsriCityEngine/10.2/index.html#/Introduction_to_the_Esri_CityEngine_tutorials/02w100000016000000.

“Exporting ArcScene Documents to 3D Web Scene,” http://downloads.esri.com/support/whitepapers/ao_/J10223_Exporting_ArcScene_Docs_to_3D_Web_Scene.pdf.

Esri Training website

“Creating Smart 3D City Models with Esri CityEngine,” http://training.esri.com/gateway/index.cfm?fa=catalog.webCourseDetail&courseid=2673.

“Practicing Geodesign Using ArcGIS,” http://training.esri.com/gateway/index.cfm?fa=catalog.courseDetail&CourseID=50131337_10.x.

Esri videos

Esri CityEngine Tutorials (1–15), http://video.arcgis.com/watch/1767/tutorial-1-essential-skills.

“Esri CityEngine: An Introduction,” http://video.esri.com/watch/2694/Esri CityEngine-an-introduction.

“3D Viewing with Esri CityEngine,” http://video.esri.com/watch/2445/3d-viewing-with-Esri CityEngine.

“Esri CityEngine Highlights,” http://video.esri.com/watch/2248/esri-Esri CityEngine-highlights.
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